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Introduction to 
Decision Modeling  1 
 

1.1 MODELS TO AID DECISION MAKING 
Decision: irrevocable allocation of resources 

Model: abstract representation of reality 

What makes decision difficult? 

 Complexity 

  many factors to consider; relationships among factors 

 Uncertainty 

 Conflicting Objectives 

How does modeling help? 

 Complexity   Model; consider each factor separately; 

     consider relationships explicitly; 

     avoid being overwhelmed 

 Uncertainty   Sensitivity Analysis and Probability 

 Conflicting Objectives  consider each objective; 

     consider tradeoffs explicitly 

Goals of modeling: recommended solution, insight, clarity of action 
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Figure 1.1 Overall Model-Building Flowchart 

 

 

Components of a Decision Model 
Controllable input variables 

 "What you can do," decision variables, alternatives 

Uncontrollable input variables 

 "What you know and don't know," uncertainties, constraints 

Relationships 

 how inputs are related to output, usually with intermediate variables, structure 

Intermediate variables 

 useful for linking inputs to output 

Output variable 

 "What you want," performance measure, overall satisfaction 

Math Model 

Operations 
on Model 

Model Results 

Real World Model 

Difficult 
Problem 

Implementation 

Abstraction 
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Influence chart 

 Rectangle for controllable inputs 

 Rounded rectangle or oval for other variables 

Figure 1.2 Generic Influence Chart 
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Factor (Input) 
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Intermediate 
Variables 

Performance 
Measure (Output) 

... 

... ... 
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1.2 BASIC WHAT-IF MODEL 

Influence Diagram Representation 

Figure 1.3 Typical Influence Diagram 

 

Figure 1.4 Typical Spreadsheet Model 
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Figure 1.5 Formulas for Typical Spreadsheet Model 

 

Figure 1.6 Defined Names for Typical Spreadsheet Model 

 

Decision Tree Representation 

Figure 1.7 Decision Fan and Event Fan 
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Figure 1.8 Conceptual Decision Tree 

 

Consequence Table Representation 

Figure 1.9 Professor's Summer Decision 

  Conflicting Objectives   

Alternatives Cash Flow Hassle-Free Happy Deans Professional Fame 

Develop Software $2700 Yes Maybe Maybe 

Teach MBAs $4300 No Yes No 

Vacation $0 Yes No No 
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Using SensIt  2 
 

SensIt is a sensitivity analysis add-in for Microsoft Excel 97 (and later versions of Excel) 
for Windows and Macintosh. It was written by Mike Middleton of the University of San 
Francisco and Jim Smith of Duke University. 

2.1 HOW TO INSTALL SENSIT 
Here are three ways to install SensIt: 

(1) Start Excel, and use Excel’s File | Open command to open the SensIt.xla file from 
floppy or hard drive. 

(2) Copy the SensIt.xla file to the Excel | Library subdirectory of your hard drive. Start 
Excel, and use Excel’s Tools | Add-Ins command to load and unload SensIt as needed. 

(3) Copy the SensIt.xla file to the Excel | Startup subdirectory of your hard drive, in 
which case the file will be opened every time you start Excel. 

All of SensIt’s functionality, including its built-in help, is a part of the SensIt.xla file. 
There is no separate setup file or help file. 

2.2 HOW TO UNINSTALL OR DELETE SENSIT 
(A) First, use your file manager to locate SensIt.xla, and delete the file from your hard 
drive. 

(B1) If SensIt is listed under Excel's add-in manager and the box is checked, when you 
start Excel you'll see "Cannot find ..." Click OK. Choose Tools | Add-Ins, uncheck the 
box for SensIt; you'll see "Cannot find ... Delete from list?" Click Yes. 

(B2) If SensIt is listed under Excel's add-in manager and the box is not checked, 
start Excel and choose Tools | Add-Ins. Check the box for SensIt; you'll see 
"Cannot find ... Delete from list?" Click Yes. 
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2.3 SENSIT OVERVIEW 
To run SensIt, start Excel and open the SensIt.xla file. Alternatively, install SensIt using 
one of the methods described above. SensIt adds a Sensitivity Analysis command to the 
Tools menu. The Sensitivity Analysis command has four subcommands: Plot, Spider, 
Tornado, and Help. 

Before using the SensIt options, you must have a spreadsheet model with one or more 
inputs and an output. All three SensIt options make it easy for you to see how sensitive 
the output is to changes in the inputs. 

Use SensIt’s Plot option to see how your model’s output depends on changes in a single 
input variable. 

Use SensIt’s Spider option to see how your model’s output depends on the same 
percentage changes for each of the model’s input variables. 

Use SensIt’s Tornado option to see how your model’s output depends on ranges you 
specify for each of the model’s input variables. 

2.4 EXAMPLE PROBLEM 

Figure 2.1 Model Display 

1
2
3
4
5
6
7
8
9

10
11
12
13
14
15
16
17
18
19
20

A B C
Spreadsheet Model For Eagle Airlines

Input Variables Input Cells
Charter Price/Hour $325
Ticket Price/Hour $100
Hours Flown 800
Capacity of Scheduled Flights 50%
Proportion of Chartered Flights 0.5
Operating Cost/Hour $245
Insurance $20,000

Intermediate Calculations
Total Revenue $230,000
Total Cost $216,000

Performance Measure
Annual Profit $14,000

Adapted from Bob Clemen's textbook,
Making Hard Decisions, 2nd ed., Duxbury (1996).  
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Figure 2.2 Model Formulas 

11
12
13
14
15
16
17
18

A B

Intermediate Calculations
Total Revenue =(B8*B6*B4)+((1-B8)*B6*B5*B7*5)
Total Cost =(B6*B9)+B10

Performance Measure
Annual Profit =B13-B14

 

2.5 PLOT 
Use SensIt’s Plot option to see how your model’s output depends on changes in a single 
input variable. 

Plot Input Variable 
Plot Input Variable’s Cells: Option: In the Label edit box, type a cell reference, or point 
to the cell containing a text label and click. Required: In the Cell edit box, type a cell 
reference, or point to the cell containing a numeric value that’s an input to your model. 

Plot Output Variable 
Plot Output Variable’s Cells: Option: In the Label edit box, type a cell reference, or point 
to the cell containing a text label and click. Required: In the Cell edit box, type a cell 
reference, or point to the cell containing a formula that’s the output of your model. 

Plot Input Values 
Plot Input Values: Type numbers in the Start, Step, and Stop edit boxes to specify values 
to be used in the input variable’s cell. Cell references are not allowed. 

Send Output To: Select the destination for the output table and chart. If you send output 
to This Worksheet, enter a Cell reference for the top left corner of the output. Output 
options are not available on the Macintosh; output is always sent to a new worksheet. 

Click OK: SensIt Plot uses the Start, Step, and Stop values to prepare a table of values. 
Each value is copied to the input variable cell, the worksheet is recalculated, and the 
value of the output variable cell is copied to the table. (You could do this manually using 
the Edit | Fill | Series and Data | Table commands.) SensIt Plot uses the input and output 
values to prepare an XY (Scatter) chart; optionally, the text in the label cells you 
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identified are used as the chart’s axis labels. (You could do this manually using the 
ChartWizard.) 

Figure 2.3 SensIt Plot Dialog Box 

 

Figure 2.4 SensIt Plot Numerical and Chart Output 
Sensitivity Analysis ...

Input Output
Capacity of Scheduled Flights Annual Profit

40% -$6,000
42% -$2,000
44% $2,000
46% $6,000
48% $10,000
50% $14,000
52% $18,000
54% $22,000
56% $26,000
58% $30,000
60% $34,000

SensIt  -  Sensitivity Analysis  -  Plot

-$10,000

$0

$10,000

$20,000

$30,000
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Capacity of Scheduled Flights

A
nn

ua
l P
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2.6 SPIDER 
Use SensIt’s Spider option to see how your model’s output depends on the same 
percentage changes for each of the model’s input variables. Before using Spider, arrange 
your model input cells in adjacent cells in a single column, arrange corresponding labels 
in adjacent cells in a single column, and be sure your model’s input cells contain base 
case values. 

For example, if your model has five inputs, the names of the five inputs could be text in 
A1:A5. The input cells of your model could be numbers in B1:B5; when you change a 
number in one of these cells, the output of your model changes; enter base case values in 
the input cells B1:B5 before using Spider. 

Spider Input Variables 
Spider Input Variables’ Ranges: Labels edit box: Type a range reference, or point to the 
range (click and drag) containing text labels. Cells edit box: Type a range reference, or 
point to the range containing numeric values that are inputs to your model. Each range 
must be adjacent cells in a single column. 

Spider Output Variable 
Spider Output Variable’s Cells: Label edit box: Type a cell reference, or point to the cell 
containing a text label and click. Cell edit box: Type a cell reference, or point to the cell 
containing a formula that’s the output of your model. 

Spider Input Changes 
Spider Input Changes (%): Type numbers in the Start (%), Step (%), and Stop (%) edit 
boxes to define the percents that will be multiplied times the current value in each input 
variable’s cell. Cell references are not allowed. 

Send Output To: Select the destination for the output table and chart. If you send output 
to This Worksheet, enter a Cell reference for the top left corner of the output. Output 
options are not available on the Macintosh; output is always sent to a new worksheet. 

Click OK: SensIt Spider uses the Start (%), Step (%), and Stop (%) values and the 
original (base case) numeric value in each input variable cell to prepare a table of 
percentage change input values. For each input variable, all other input values are set at 
their base case values, each percentage change input value is copied to the input variable 
cell, the worksheet is recalculated, and the value of the output variable cell is copied to 
the table. The output variable values are also expressed as percentage change of the base 
case output value. SensIt Spider prepares two XY (Scatter) charts; the horizontal axis is 
percentage change of input variables; the vertical axis is model output value on one chart 
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and percentage change of model output value on the other; the input variables’ labels are 
used for chart legends. 

Figure 2.5 SensIt Spider Dialog Box 
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Figure 2.6 SensIt Spider Numerical Output 

1
2
3
4
5
6
7
8
9

10
11
12
13
14
15
16
17
18
19
20

A B C D E F
Input Variables Values

80% 90% 100% 110% 120%
Charter Price/Hour $260 $293 $325 $358 $390
Ticket Price/Hour $80 $90 $100 $110 $120
Hours Flown 640 720 800 880 960
Capacity of Scheduled Flights 40% 45% 50% 55% 60%
Proportion of Chartered Flights 0.4 0.45 0.5 0.55 0.6
Operating Cost/Hour $196 $221 $245 $270 $294
Insurance $16,000 $18,000 $20,000 $22,000 $24,000

Output Variable Values (Annual Profit)
80% 90% 100% 110% 120%

Charter Price/Hour -$12,000 $1,000 $14,000 $27,000 $40,000
Ticket Price/Hour -$6,000 $4,000 $14,000 $24,000 $34,000
Hours Flown $7,200 $10,600 $14,000 $17,400 $20,800
Scheduled Capacity -$6,000 $4,000 $14,000 $24,000 $34,000
Chartered Proportion $8,000 $11,000 $14,000 $17,000 $20,000
Operating Cost/Hour $53,200 $33,600 $14,000 -$5,600 -$25,200
Insurance $18,000 $16,000 $14,000 $12,000 $10,000  

Figure 2.7 SensIt Spider Chart Output 
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Figure 2.8 SensIt Spider Chart Output After Formatting 

Sensit  -  Sensitivity Analysis  -  Spider

-$30,000

-$20,000

-$10,000

$0

$10,000

$20,000

$30,000

$40,000

$50,000

$60,000

75% 80% 85% 90% 95% 100% 105% 110% 115% 120% 125%

% Change in Input Value

A
nn

ua
l P

ro
fit

 V
al

ue

Charter Price/Hour

Ticket Price/Hour

Hours Flow n

Scheduled Capacity

Chartered Proportion

Operating Cost/Hour

Insurance

 

2.7 TORNADO 
Use SensIt’s Tornado option to see how your model’s output depends on ranges you 
specify for each of the model’s input variables. Before using Tornado, arrange your 
model input cells in adjacent cells in a single column, arrange corresponding labels in 
adjacent cells in a single column, and arrange Low, Base, and High input values for each 
input variable in three separate columns. Alternatively, the three columns containing 
input values can be worst case, likely case, and best case. 

For example, if your model has five inputs, the names of the five inputs could be text in 
A1:A5. The input cells of your model could be numbers in B1:B5; when you change a 
number in one of these cells, the output of your model changes. The Low input values 
could be numbers in D1:D5, chosen as the minimum possible value you think each input 
variable could be. The Base input values could be numbers in E1:E5, chosen as the most 
likely value for each input; you might also have these same numbers in B1:B5 as current 
inputs to your model. The High input values could be numbers in F1:F5, chosen as the 
maximum possible value you think each input variable could be.  

Tornado Input Variables 
Tornado Input Variables’ Ranges: Labels edit box: Type a range reference, or point to the 
range (click and drag) containing text labels. Cells edit box: Type a range reference, or 
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point to the range containing numeric values that are inputs to your model. Each range 
must be adjacent cells in a single column. 

Tornado Output Variable 
Tornado Output Variable’s Cells: Label edit box: Type a cell reference, or point to the 
cell containing a text label and click. Cell edit box: Type a cell reference, or point to the 
cell containing a formula that’s the output of your model. 

Tornado Input Values 
Tornado Input Values’ Ranges: In the Low, Base, and High edit boxes, type a range 
reference, or point to the range (click and drag) containing numeric values for each of 
your model’s inputs. 

Send Output To: Select the destination for the output table and chart. If you send output 
to This Worksheet, enter a Cell reference for the top left corner of the output. Output 
options are not available on the Macintosh; output is always sent to a new worksheet. 

Click OK: For each input variable, SensIt Tornado sets all other input values at their Base 
case values, copies the Low input value to the input variable cell, recalculates the 
worksheet, and copies the value of the output variable cell to the table; the steps are 
repeated using each High input value. For each input variable, SensIt Tornado computes 
the range of the output variable values, sorts the table from largest range down to smallest 
range, and prepares a bar chart. 

Figure 2.9 Example with Lower and Upper Bounds 

1
2
3
4
5
6
7
8
9

10
11
12
13
14
15
16
17
18
19
20

A B C D E F
Spreadsheet Model For Eagle Airlines

Input Variables Input Cells Lower Bound Base Value Upper Bound
Charter Price/Hour $325 $300 $325 $350
Ticket Price/Hour $100 $95 $100 $108
Hours Flown 800 500 800 1000
Capacity of Scheduled Flights 50% 40% 50% 60%
Proportion of Chartered Flights 0.5 0.45 0.5 0.7
Operating Cost/Hour $245 $230 $245 $260
Insurance $20,000 $18,000 $20,000 $25,000

Intermediate Calculations
Total Revenue $230,000
Total Cost $216,000

Performance Measure
Annual Profit $14,000

Adapted from Bob Clemen's textbook,
Making Hard Decisions, 2nd ed., Duxbury (1996).  
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Figure 2.10 SensIt Tornado Dialog Box 

 

Figure 2.11 SensIt Tornado Numerical and Chart Output 
1
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30
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32
33

A B C D E F G H I J K
Tornado Analysis ...

Input Values Output Values (Annual Profit) Percent
Input Variable Low Base High Low Base High Swing Variance
Capacity of Scheduled Flights 40% 50% 60% -$6,000 $14,000 $34,000 $40,000 46.1%
Operating Cost/Hour $230 $245 $260 $26,000 $14,000 $2,000 $24,000 16.6%
Hours Flown 500 800 1000 $1,250 $14,000 $22,500 $21,250 13.0%
Charter Price/Hour $300 $325 $350 $4,000 $14,000 $24,000 $20,000 11.5%
Proportion of Chartered Flights 0.45 0.5 0.7 $11,000 $14,000 $26,000 $15,000 6.5%
Ticket Price/Hour $95 $100 $108 $9,000 $14,000 $22,000 $13,000 4.9%
Insurance $18,000 $20,000 $25,000 $16,000 $14,000 $9,000 $7,000 1.4%

SensIt  -  Sensitivity Analysis  -  Tornado
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2.8 TORNADO TIPS 
When defining the high and low cases for each variable, it is important to be consistent so 
that the "high" cases are all equally high and the "low" cases are equally low. For 
example, you might take all of the base case values to be estimates of the mean of the 
input variable, take low cases to be values such there is a 1-in-10 chance of the variable 
being below this amount, and take the high cases to be values such that there is a 1-in-10 
chance of the variable being above this amount. Alternatively, you may specify low and 
high values that are the absolute lowest and highest possible values. 

When you click OK, SensIt sets all of the input variables to their base-case values and 
records the output value. Then SensIt goes through each of the input variables one at a 
time, plugs the low-case value into the input cell, and records the value in the output cell. 
It then repeats the process for the high case. For each substitution, all input values are 
kept at their base-case values except for the single input value that is setn at it low or high 
value. SensIt then produces a spreadsheet that lists the numerical results as shown in 
columns F, G, and H above. 

In the worksheet, the variables are sorted by their "swing" -- the absolute value of the 
difference between the output values in the low and high cases. "Swing" serves as a 
rough measure of the impact of each input variable. The rows of numerical output are 
sorted from highest swing at the top down to lowest swing at the bottom. Then SensIt 
creates a bar chart of the sorted data. 

"Percent variance" is a standardized measure of impact: it squares each swing, sums them 
up to get a "Total Variance", and reports the percentage of the "total variance" attributed 
to each input variable. 

In general, you should focus your modeling efforts on those variables with the greatest 
impact on the value measure. 

If your model has input variables that are discrete or categorical, you should create 
multiple tornado charts using different base case values of that input variable. For 
example, if your model has an input variable "Government Regulation" that has possible 
values 0 (zero) or 1, the low and high values will be 0 and 1, but you should run one 
tornado chart with base case = 0 and another tornado chart with base case = 1. 
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2.9 EAGLE AIRLINES PROBLEM 

Figure 2.12 Eagle Model Display 

1
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14
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16
17
18
19
20

A B C D E F
Spreadsheet Model For Eagle Airlines

Variable Input Cells Lower Bound Base Value Upper Bound
Hours Flown 800 500 800 1000

Charter Price/Hour $325 $300 $325 $350
Ticket Price/Hour $100 $95 $100 $108

Capacity of Scheduled Flights 50% 40% 50% 60%
Proportion Of Chartered Flights 0.5 0.45 0.5 0.7

Operating Cost/Hour $245 $230 $245 $260
Insurance $20,000 $18,000 $20,000 $25,000

Proportion Financed 0.4 0.3 0.4 0.5
Interest Rate 11.5% 10.5% 11.5% 13.0%

Purchase Price $87,500 $85,000 $87,500 $90,000

Total Revenue $230,000
Total Cost $220,025

Annual Profit $9,975

Adapted from Bob Clemen's textbook, Making Hard Decisions  

Figure 2.13 Eagle Model Formulas 

14
15
16
17
18
19

A B C D E F

Total Revenue =(B8*B4*B5)+((1-B8)*B4*B6*B7*5)
Total Cost =(B4*B9)+B10+(B13*B11*B12)

Annual Profit =B15-B16
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Figure 2.14 Worst Case and Best Case Inputs Determined by Solver 
Variable Worst Case Base Case Best Case

Hours Flown 1000 800 1000
Charter Price/Hour $300 $325 $350
Ticket Price/Hour $95 $100 $108

Capacity of Scheduled Flights 40% 50% 60%
Proportion Of Chartered Flights 0.45 0.5 0.7

Operating Cost/Hour $260 $245 $230
Insurance $25,000 $20,000 $18,000

Proportion Financed 0.5 0.4 0.3
Interest Rate 13.0% 11.5% 10.5%

Purchase Price $90,000 $87,500 $85,000

Total Revenue $239,500 $230,000 $342,200
Total Cost $290,850 $220,025 $250,678

Annual Profit -$51,350 $9,975 $91,523  

2.10 SEVEN-VARIABLE NON-SENSIT SPIDER CHART 

Figure 2.15 Extremes Associated With Tornado-Like Inputs 
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Monte Carlo Simulation 
Using RiskSim  3 
 

3.1 INTRODUCTION 
 

Figure 3.1 Conceptual Simulation as a Sample of Tree Endpoints 
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Figure 3.2 Probability Distributions for Sampling Tree Endpoints 

 

Figure 3.3 Conceptual Simulation as Influence Chart with Repeated What-Ifs 
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3.2 USING RISKSIM FUNCTIONS 
RiskSim is a Monte Carlo Simulation add-in for Microsoft Excel 97 (and later versions of 
Excel) for Windows and Macintosh.  

RiskSim provides random number generator functions as inputs for your model, 
automates Monte Carlo simulation, and creates charts. Your spreadsheet model may 
include various uncontrollable uncertainties as input assumptions (e.g., demand for a new 
product, uncertain variable cost of production, competitor reaction), and you can use 
simulation to determine the uncertainty associated with the model's output (e.g., annual 
profit). RiskSim automates the simulation by trying hundreds of what-ifs consistent with 
your assessment of the uncertainties. 

To use RiskSim, you 

(1) create a spreadsheet model 

(2) optionally use SensIt to identify critical inputs 

(3) enter one of RiskSim's nine random number generator functions in each input cell of your model 

(4) choose Tools | Risk Simulation from Excel's menu 

(5) specify the model output cell and the number of what-if trials 

(6) interpret RiskSim's histogram and cumulative distribution charts. 

RiskSim facilitates Monte Carlo simulation by providing: 
 Nine random number generator functions 
 Ability to set the seed for random number generation 
 Automatic repeated sampling for simulation 

 Frequency distribution of simulation results 

 Histogram and cumulative distribution charts 

3.3 USING RISKSIM FUNCTIONS 
RiskSim adds nine random number generator functions to Excel. You can use these 
functions as inputs to your model by typing in a worksheet cell or by using the Function 
Wizard. From the Insert menu choose Function, or click the Function Wizard button. 
RiskSim's functions are listed in a User Defined category. The nine functions are: 

 RANDBINOMIAL(trials,probability_s) 

 RANDCUMULATIVE(value_cumulative_table) 

 RANDDISCRETE(value_discrete_table) 
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 RANDEXPONENTIAL(lambda) 

 RANDINTEGER(bottom,top) 

 RANDNORMAL(mean,standard_dev) 

 RANDPOISSON(mean) 

 RANDTRIANGULAR(minimum,most_likely,maximum) 

 RANDUNIFORM(minimum,maximum) 

RiskSim's RAND... functions include extensive error checking of arguments. After 
verifying that the functions are working properly, you may want to substitute RiskSim's 
FAST... functions which have minimal error checking and therefore run faster. From the 
Edit menu choose Replace; in the Replace dialog box, type =RAND in the "Find What" 
edit box, type =FAST in the "Replace with" edit box, and click the Replace All button. 

3.4 EXCEL ERROR MESSAGE 
When you insert a RiskSim random number generator function in a worksheet cell, the 
function is linked to RiskSim.xla. When you save the workbook, Excel saves the 
complete path to the function in RiskSim.xla. When you open the workbook, Excel looks 
for RiskSim.xla using the saved path. If Excel cannot find RiskSim.xla at the saved path 
location (e.g., if you deleted RiskSim.xla or if you opened the workbook on another 
computer where RiskSim.xla isn't located at the same path), Excel displays a dialog box: 
"This document contains links. Re-establish links?" Click No. The workbook will be 
opened, but any cell containing a reference to a RiskSim function will display the #REF!, 
#NAME?, or other error code. To fix the links, be sure that RiskSim.xla is open (e.g., File 
| Open | RiskSim.xla), choose Edit | Links | Change Source, and locate the RiskSim.xla 
file that is open. 

3.5 MONTE CARLO SIMULATION 
After specifying random number generator functions as inputs to your model, from the 
Tools choose Risk Simulation | One Output. 
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Figure 3.4 RiskSim Dialog Box 

 

Optionally, select the "Output Label Cell" edit box, and point or type a reference to a cell 
containing the name of the model output (for example, a cell whose contents is the text 
label "Net Profit").  

Select the "Output Formula Cell" edit box, and point to a single cell on your worksheet or 
type a cell reference. The output cell of your model must contain a formula that depends, 
usually indirectly, on the model inputs determined by the random number generator 
functions.  

Select the "Random Number Seed" edit box, and type a number between zero and one. (If 
you want to change the seed without performing a simulation, enter zero in the "Number 
of iterations" edit box.) 

Select the "Number Of Trials" edit box, and type an integer value (for example, 100 or 
500). This value, sometimes called the sample size or number of iterations, specifies the 
number of times the worksheet will be recalculated to determine output values of your 
model. 

3.6 RANDOM NUMBER SEED 
The "Random Number Seed" edit box on the RiskSim dialog box allows you to set the 
seed for RiskSim's random number generator functions. These functions depend on 
RiskSim's own uniform random number function that is completely independent of 
Excel's built-in RAND(). 

Random numbers generated by the computer are actually pseudo-random. The numbers 
appear to be random, and they pass various statistical tests for randomness. But they are 
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actually calculated by an algorithm where each random number depends on the previous 
random number. Such an algorithm generates a repeatable sequence. The seed specifies 
where the algorithm starts in the sequence. 

A Monte Carlo simulation model usually has uncontrollable inputs (uncertain quantities 
using random number generator functions), controllable inputs (decision variables that 
have fixed values for a particular set of simulation iterations), and an output variable (a 
performance measure or operating characteristic of the system). 

For example, a simple queuing system model may have an uncertain arrival pattern, a 
controllable number of servers, and total cost (waiting time plus server cost) as output. To 
evaluate a different number of servers, you would specify the same seed before 
generating the uncertain arrivals. Then the variation in total cost should depend on the 
different number of servers, not on the particular sequence of random numbers that 
generates the arrivals. 

3.7 ONE-OUTPUT EXAMPLE 
In this example the decision maker has described his subjective uncertainty using normal, 
triangular, and discrete probability distributions. 

Figure 3.5 One-Output Example Model Display 
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5
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7
8
9

A B C D E F G H
Software Decision Analysis

Unit Price $29 Price is controllable and constant.
Units Sold 739 Normal Mean = 700, StDev = 100
Unit Variable Cost $8.05 Triangular Min = $6, Mode = $8, Max = $11
Fixed Costs $12,000 Discrete Value Probability

$10,000 0.25
Net Cash Flow $3,485 $12,000 0.50

$15,000 0.25  

Figure 3.6 One-Output Example Model Formulas 

1
2
3
4
5
6
7
8

A B
Software Decision Analysis

Unit Price $29
Units Sold =INT(RANDNORMAL(700,100))
Unit Variable Cost =RANDTRIANGULAR(6,8,11)
Fixed Costs =RANDDISCRETE(E7:F9)

Net Cash Flow =B4*(B3-B5)-B6  
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Figure 3.7 RiskSim Dialog Box for One-Output Example 

 

3.8 RISKSIM OUTPUT FOR ONE-OUTPUT EXAMPLE 
When you click the Simulate button, RiskSim creates a new worksheet in your Excel 
workbook named "RiskSim Summary 1." A summary of your inputs and the output is 
shown in cells L1:R9 with the accompanying histogram and cumulative distribution 
charts. 
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Figure 3.8 RiskSim Summary Output for One-Output Example 

1
2
3
4
5
6
7
8
9

10
11
12
13
14
15
16
17
18
19
20
21
22
23
24
25
26
27
28
29
30
31
32
33
34
35
36
37
38
39
40
41
42
43
44
45
46
47

L M N O P Q R
RiskSim - One Output - Summary Mean $2,454
Date (current date) St. Dev. $2,794
Time (current time) Mean St. Error $125
Workbook risksamp.xls Minimum -$5,455
Worksheet Simulation First Quartile $536
Output Cell $B$8 Median $2,458
Output Label Net Cash Flow Third Quartile $4,416
Seed 0.5 Maximum $10,236
Trials 500 Skewness 0.0028
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The histogram is based on the frequency distribution in columns I:J. The cumulative 
distribution is based on the sorted output values in column C and the cumulative 
probabilities in column D. 

Figure 3.9 RiskSim Numerical Output for One-Output Example 
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28

A B C D E F G H I J
Trial Net Cash Flow Sorted Cumulative Percent Percentile Upper Limit Frequency

1 $1,653 -$5,455 0.0010 0% -$5,455 -$6,000 0
2 $2,804 -$4,267 0.0030 5% -$1,996 -$4,000 3
3 $2,280 -$4,185 0.0050 10% -$1,132 -$2,000 22
4 $761 -$3,898 0.0070 15% -$637 $0 72
5 -$1,817 -$3,675 0.0090 20% $77 $2,000 122
6 -$692 -$3,582 0.0110 25% $536 $4,000 128
7 $623 -$3,569 0.0130 30% $923 $6,000 105
8 $5,575 -$3,562 0.0150 35% $1,331 $8,000 38
9 $1,389 -$3,547 0.0170 40% $1,823 $10,000 9

10 $445 -$3,275 0.0190 45% $2,063 $12,000 1
11 $2,573 -$3,207 0.0210 50% $2,458 0
12 $5,055 -$3,137 0.0230 55% $2,756
13 $1,430 -$3,135 0.0250 60% $3,138
14 $4,529 -$3,063 0.0270 65% $3,644
15 $701 -$3,036 0.0290 70% $4,104
16 -$903 -$3,008 0.0310 75% $4,416
17 $3,900 -$2,968 0.0330 80% $4,867
18 $7,282 -$2,950 0.0350 85% $5,412
19 $9,901 -$2,774 0.0370 90% $5,897
20 $285 -$2,649 0.0390 95% $7,109
21 $3,833 -$2,485 0.0410 100% $10,236
22 $4,369 -$2,370 0.0430
23 $1,991 -$2,319 0.0450
24 -$11 -$2,219 0.0470
25 $1,100 -$2,195 0.0490
26 -$1,100 -$1,986 0.0510
27 -$5,455 -$1,969 0.0530  

 

The cumulative probabilities start at 1/(2*N), where N is the number of trials, and 
increase by 1/N. The rationale is that the lowest ranked output value of the sampled 
values is an estimate of the population's values in the range from 0 to 1/N, and the lowest 
ranked value is associated with the median of that range. 

Column B contains the original sampled output values. 

Columns F:G show percentiles based on Excel's PERCENTILE worksheet function. 
Refer to Excel's online help for the interpolation method used by the PERCENTILE 
function. 

The summary measures in columns Q:R are also based on Excel worksheet functions: 
AVERAGE, STDEV, QUARTILE, and SKEW. 
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3.9 RANDOM NUMBER GENERATOR FUNCTIONS 

RandBinomial 
Returns a random value from a binomial distribution. The binomial distribution can 
model a process with a fixed number of trials where the outcome of each trial is a success 
or failure, the trials are independent, and the probability of success is constant. 
RANDBINOMIAL counts the total number of successes for the specified number of 
trials. If n is the number of trials, the possible values for RANDBINOMIAL are the non-
negative integers 0,1,...,n. 

RANDBINOMIAL Syntax:  RANDBINOMIAL(trials,probability_s) 

Trials (often denoted n) is the number of independent trials. 

Probability_s (often denoted p) is the probability of success on each trial. 

RANDBINOMIAL Remarks 

Returns #N/A if there are too few or too many arguments. 

Returns #NAME! if an argument is text and the name is undefined. 

Returns #NUM! if trials is non-integer or less than one, or probability_s is less than zero 
or more than one. 

Returns #VALUE! if an argument is a defined name of a cell and the cell is blank or 
contains text. 

RANDBINOMIAL Example 

A salesperson makes ten unsolicited calls per day, where the probability of making a sale 
on each call is 30 percent. The uncertain total number of sales in one day is 
=RANDBINOMIAL(10,0.3) 

RANDBINOMIAL Related Function 

FASTBINOMIAL: Same as RANDBINOMIAL without any error checking of the 
arguments. 

CRITBINOM(trials,probability_s,RAND()): Excel's inverse of the cumulative binomial, 
or CRITBINOM(trials,probability_s,RANDUNIFORM(0,1)) to use the RiskSim Seed 
feature. 

RandCumulative 
Returns a random value from a piecewise-linear cumulative distribution. This function 
can model a continuous-valued uncertain quantity, X, by specifying points on its 
cumulative distribution. Each point is specified by a possible value, x, and a 
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corresponding left-tail cumulative probability, P(X<=x). Random values are based on 
linear interpolation between the specified points. 

RANDCUMULATIVE Syntax:  RANDCUMULATIVE(value_cumulative_table) 

Value_cumulative_table must be a reference, or the defined name of a reference, for a 
two-column range, with values in the left column and corresponding cumulative 
probabilities in the right column. 

RANDCUMULATIVE Remarks 

Returns #N/A if there are too few or too many arguments. 

Returns #NAME! if the argument is text and the name is undefined. 

Returns #NUM! if the first (top) cumulative probability is not zero, if the last (bottom) 
cumulative probability is not one, or if the values or cumulative probabilities are not in 
ascending order. 

Returns #REF! if the number of columns in the table reference is not two. 

Returns #VALUE! if the argument is not a reference, if the argument is a defined name 
but not for a reference, or if any cell of the table contains text or is blank. 

RANDCUMULATIVE Example 
 

A corporate planner thinks that minimum possible market demand is 1000 units, median 
is 5000, and maximum possible is 9000. Also, there is a ten percent chance that demand 
will be less than 4000 and a ten percent chance it will exceed 7000. The values, x, and 
cumulative probabilities, P(X<=x), are entered into spreadsheet cells A1:B5. 

Figure 3.10 RandDiscrete Example Spreadsheet Data 

 

The function is entered into another cell: =RANDCUMULATIVE(A1:B5) 

RANDCUMULATIVE Related Function 

FASTCUMULATIVE: Same as RANDCUMULATIVE without any error checking of 
the arguments. 
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Figure 3.11 RandCumulative Example Probability Density Function 
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Figure 3.12 RandCumulative Example Cumulative Probability Function 
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RandDiscrete 
Returns a random value from a discrete probability distribution. This function can model 
a discrete-valued uncertain quantity, X, by specifying its probability mass function. The 
function is specified by each possible discrete value, x, and its corresponding probability, 
P(X=x). 

RANDDISCRETE Syntax:  RANDDISCRETE(value_discrete_table) 
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Value_discrete_table must be a reference, or the defined name of a reference, for a two-
column range, with values in the left column and corresponding probability mass in the 
right column. 

RANDDISCRETE Remarks 

Returns #N/A if there are too few or too many arguments. 

Returns #NAME! if the argument is text and the name is undefined. 

Returns #NUM! if a probability is negative or if the probabilities do not sum to one. 

Returns #REF! if the number of columns in the table reference is not two. 

Returns #VALUE! if the argument is not a reference, if the argument is a defined name 
but not for a reference, or if any cell of the table contains text or is blank. 

RANDDISCRETE Example 

A corporate planner thinks that uncertain market demand, X, can be approximated by 
three possible values and their associated probabilities: P(X=3000) = 0.3, P(X=4000) = 
0.6, and P(X=5000) = 0.1. The values and probabilities are entered into spreadsheet cells 
A1:B3. 

Figure 3.13 RandDiscrete Example Spreadsheet Data 

 

The function is entered into another cell: =RANDDISCRETE(A1:B3) 

RANDDISCRETE Related Function 

FASTDISCRETE: Same as RANDDISCRETE without any error checking of the 
arguments. 
RandDiscrete Example Probability Mass Function 
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Figure 3.14 RandDiscrete Example Probability Mass Function 
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Figure 3.15 RandDiscrete Example Cumulative Probability Function 
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RandExponential 
Returns a random value from an exponential distribution. This function can model the 
uncertain time interval between successive arrivals at a queuing system or the uncertain 
time required to serve a customer. 

RANDEXPONENTIAL Syntax:  RANDEXPONENTIAL(lambda) 

Lambda is the mean number of occurrences per unit of time. 
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RANDEXPONENTIAL Remarks 

Returns #N/A if there are too few or too many arguments. 

Returns #NAME! if the argument is text and the name is undefined. 

Returns #NUM! if lambda is negative or zero. 

Returns #VALUE! if the argument is a defined name of a cell and the cell is blank or 
contains text. 

RANDEXPONENTIAL Examples 

Cars arrive at a toll plaza with a mean rate of 3 cars per minute. The uncertain time 
between successive arrivals, measured in minutes, is =RANDEXPONENTIAL(3). The 
average value returned by repeated recalculation of RANDEXPONENTIAL(3) is 0.333. 

A bank teller requires an average of two minutes to serve a customer. The uncertain 
customer service time, measured in minutes, is =RANDEXPONENTIAL(0.5). The 
average value returned by repeated recalculation of RANDEXPONENTIAL(0.5) is 2. 

RANDEXPONENTIAL Related Functions 

FASTEXPONENTIAL: Same as RANDEXPONENTIAL without any error checking of 
the arguments. 

−LN(RAND())/lambda: Excel's inverse of the exponential, or  
−LN(RANDUNIFORM(0,1))/lambda to use the RiskSim Seed feature. 

RANDPOISSON: Counts number of occurrences for a Poisson process. 

RandInteger 
Returns a uniformly distributed random integer between two integers you specify. 

RANDINTEGER Syntax:  RANDINTEGER(bottom,top) 

Bottom is the smallest integer RANDINTEGER will return. 

Top is the largest integer RANDINTEGER will return. 

RANDINTEGER Remarks 

Returns #N/A if there are too few or too many arguments. 

Returns #NAME! if an argument is text and the name is undefined. 

Returns #NUM! if top is less than or equal to bottom. 

Returns #VALUE! if bottom or top is not an integer or if an argument is a defined name 
of a cell and the cell is blank or contains text. 
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RANDINTEGER Example 

The number of orders a particular customer will place next year is between 7 and 11, with 
no number more likely than the others. The uncertain number of orders is 
=RANDINTEGER(7,11). 

RANDINTEGER Related Function 

FASTINTEGER: Same as RANDINTEGER without any error checking of the 
arguments. 

RANDBETWEEN(bottom,top): Excel’s function for uniformly distributed integers, 
without RiskSim’s capability of setting the seed. 

RandNormal 
Returns a random value from a normal distribution. This function can model a variety of 
phenomena where the values follow the familiar bell-shaped curve, and it has wide 
application in statistical quality control and statistical sampling. 

RANDNORMAL Syntax:  RANDNORMAL(mean,standard_dev) 

Mean is the arithmetic mean of the normal distribution. 

Standard_dev is the standard deviation of the normal distribution. 

RANDNORMAL Remarks 

Returns #N/A if there are too few or too many arguments. 

Returns #NAME! if an argument is text and the name is undefined. 

Returns #NUM! if standard_dev is negative. 

Returns #VALUE! if an argument is a defined name of a cell and the cell is blank or 
contains text. 

RANDNORMAL Example 

The total market for a product is approximately normally distributed with mean 60,000 
units and standard deviation 5,000 units. The uncertain total market is 
=RANDNORMAL(60000,5000). 

RANDNORMAL Related Function 

FASTNORMAL: Same as RANDNORMAL without any error checking of the 
arguments. 

NORMINV(RAND(),mean,standard_dev): Excel's inverse of the normal, or 
NORMINV(RANDUNIFORM(0,1),mean,standard_dev) to use the RiskSim Seed 
feature. 
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RandPoisson 
Returns a random value from a Poisson distribution. This function can model the 
uncertain number of occurrences during a specified time interval, for example, the 
number of arrivals at a service facility during an hour. The possible values of 
RANDPOISSON are the non-negative integers, 0, 1, 2, ... . 

RANDPOISSON Syntax:  RANDPOISSON(mean) 

Mean is the mean number of occurrences per unit of time. 

RANDPOISSON Remarks 

Returns #N/A if there are too few or too many arguments. 

Returns #NAME! if the argument is text and the name is undefined. 

Returns #NUM! if mean is negative or zero. 

Returns #VALUE! if mean is a defined name of a cell and the cell is blank or contains 
text. 

RANDPOISSON Examples 

Cars arrive at a toll plaza with a mean rate of 3 cars per minute. The uncertain number of 
arrivals in a minute is =RANDPOISSON(3). The average value returned by repeated 
recalculation of RANDPOISSON(3) is 3. 

A bank teller requires an average of two minutes to serve a customer. The uncertain 
number of customers served in a minute is =RANDPOISSON(0.5). The average value 
returned by repeated recalculation of RANDPOISSON(0.5) is 0.5. 

RANDPOISSON Related Functions 

FASTPOISSON: Same as RANDPOISSON without any error checking of the arguments. 

RANDEXPONENTIAL: Describes time between occurrences for a Poisson process. 

RandTriangular 
Returns a random value from a triangular probability density function. This function can 
model an uncertain quantity where the most likely value (mode) has the largest 
probability of occurrence, the minimum and maximum possible values have essentially 
zero probability of occurrence, and the probability density function is linear between the 
minimum and the mode and between the mode and the maximum. This function can also 
model a ramp density function where the minimum equals the mode or the mode equals 
the maximum. 

RANDTRIANGULAR Syntax:  
RANDTRIANGULAR(minimum,most_likely,maximum) 
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Minimum is the smallest value RANDTRIANGULAR will return. 

Most_likely is the most likely value RANDTRIANGULAR will return. 

Maximum is the largest value RANDTRIANGULAR will return. 

RANDTRIANGULAR Remarks 

Returns #N/A if there are too few or too many arguments. 

Returns #NAME! if an argument is text and the name is undefined. 

Returns #NUM! if minimum is greater than or equal to maximum, if most_likely is less 
than minimum, or if most_likely is greater than maximum. 

Returns #VALUE! if an argument is a defined name of a cell and the cell is blank or 
contains text. 

RANDTRIANGULAR Example 

The minimum time required to complete a particular task that is part of a large project is 
4 hours, the most likely time required is 6 hours, and the maximum time required is 10 
hours. 

The function returning the uncertain time required for the task is entered into a cell: 
=RANDTRIANGULAR(4,6,10). 

RANDTRIANGULAR Related Function 

FASTTRIANGULAR: Same as RANDTRIANGULAR without any error checking of 
arguments. 

Figure 3.16 RandTriangular Example Probability Density Function 
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Figure 3.17 RandTriangular Example Cumulative Probability Function 
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RandUniform 
Returns a uniformly distributed random value between two values you specify. As a 
special case, RANDUNIFORM(0,1) is the same as Excel's built-in RAND() function. 

RANDUNIFORM Syntax:  RANDUNIFORM(minimum,maximum) 

Minimum is the smallest value RANDUNIFORM will return. 

Maximum is the largest value RANDUNIFORM will return. 

RANDUNIFORM Remarks 

Returns #N/A if there are too few or too many arguments. 

Returns #NAME! if an argument is text and the name is undefined. 

Returns #NUM! if minimum is greater than or equal to maximum. 

Returns #VALUE! if an argument is a defined name of a cell and the cell is blank or 
contains text. 

RANDUNIFORM Example 

A corporate planner thinks that the company's product will garner between 10% and 15% 
of the total market, with all possible percentages equally likely in the specified range. The 
uncertain market proportion is =RANDUNIFORM(0.10,0.15). 

RANDUNIFORM Related Function 
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FASTUNIFORM: Same as RANDUNIFORM without any error checking of the 
arguments. 

3.10 RISKSIM TECHNICAL DETAILS 
RiskSim's random number generator functions are based on a (0,1) uniformly distributed 
random number function called RandSeed which is not directly accessible by the user. 
Internally, decimal values for RandSeed are calculated by dividing a uniformly 
distributed random integer by 2147483647, which is RandSeed's period. Random integers 
are generated using the well-documented Park-Miller algorithm, where each random 
integer depends on the previous random integer. 

When RiskSim starts, the initial integer seed depends on the system clock. Unlike Excel's 
RAND() function, you can use RiskSim at any time to specify an integer seed, which is 
used as the previous random integer for  the sequence of random numbers generated by 
the RiskSim functions. 

In the Risk Simulation dialog box, the "Random number seed" edit box changes the seed 
only for the RiskSim functions; it does not have any effect on Excel's built-in RAND() 
function. 

Each of RiskSim's random number generator functions use RandSeed as a building block. 

RANDBINOMIAL(trials,probability_s) uses RandSeed as the cumulative probability in 
Excel's built-in CRITBINOM function. 

RANDCUMULATIVE(value_cumulative_table) uses the value of RandSeed, R, searches 
to find the adjacent cumulative probabilities that bracket R, and interpolates on the linear 
segment of the cumulative distribution to find the corresponding value. 

RANDDISCRETE(value_discrete_table) compares RandSeed with summed probabilities 
of the input table until the sum exceeds the RandSeed value, and then returns the previous 
value from the input table. 

RANDEXPONENTIAL(lambda) uses the value of RandSeed, R, as follows. If the 
exponential density function is f(t) = lambda*EXP(-lambda*t), the cumulative is P(T<=t) 
= 1 - EXP(-lambda*t). Associating R with P(T<=t), the inverse cumulative is t = -LN(1-
R)/lambda. Since R and 1-R are both uniformly distributed between 0 and 1, RiskSim 
uses -LN(R)/lambda for the returned value. 

RANDINTEGER(bottom,top) returns bottom + INT(RandSeed*(top-bottom+1)). 

RANDNORMAL(mean,standard_dev) uses two RandSeed values in the well-
documented Box-Muller method.7 
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RANDPOISSON(mean) compares RandSeed with cumulative probabilities of Excel's 
built-in POISSON function until the probability exceeds the RandSeed value, and then 
returns the previous value. 

RANDTRIANGULAR(minimum,most_likely,maximum) uses RandSeed once. The 
triangular density function has two linear segments, so the cumulative distribution has 
two quadratic segments. The returned value is determined by interpolation on the 
appropriate quadratic segment. 

RANDUNIFORM(minimum,maximum) returns minimum + RandSeed*(maximum-
minimum). RANDUNIFORM(0,1) is equivalent to Excel's built-in RAND() function. 

RiskSim includes a FAST... version of each of the nine functions, e.g., 
FASTBINOMIAL, FASTCUMULATIVE, etc. The FAST... functions are identical to the 
RAND... functions except there is no error checking of arguments. 

3.11 MODELING UNCERTAIN RELATIONSHIPS 

Base Model, Four Inputs 
Price is fixed. The three uncontrollable inputs are independent. 

Figure 3.18 Four Inputs Influence Chart 
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Figure 3.19 Four Inputs Display 

1
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5
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7
8

A B
Controllable Input
Price $29
Uncontrollable Inputs
Fixed Costs $12,000
Units Sold 700
Unit Variable Cost $8
Output Variable
Net Cash Flow $2,700  

Figure 3.20 Four Inputs Formulas 
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A B
Controllable Input
Price 29
Uncontrollable Inputs
Fixed Costs 12000
Units Sold 700
Unit Variable Cost 8
Output Variable
Net Cash Flow =(B2-B6)*B5-B4  

Three Inputs 
Price is variable. Units sold depends on price. The two cost inputs are independent. 

Figure 3.21 Three Inputs Influence Chart 
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Figure 3.22 Three Inputs Display 
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A B C D E
Controllable Input Price Units Sold
Price $29 $29 700
Uncontrollable Inputs $39 550
Fixed Costs $12,000 $49 400
Unit Variable Cost $8 $59 250
Intermediate Variable
Units Sold 700 Slope -15
Output Variable Intercept 1135
Net Cash Flow $2,700  

Figure 3.23 Three Inputs Formulas 
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A B C D E
Controllable Input Price Units Sold
Price 29 29 700
Uncontrollable Inputs 39 550
Fixed Costs 12000 49 400
Unit Variable Cost 8 59 250
Intermediate Variable
Units Sold =E8+E7*B2 Slope =SLOPE(E2:E5,D2:D5)
Output Variable Intercept =INTERCEPT(E2:E5,D2:D5)
Net Cash Flow =(B2-B5)*B7-B4  

Two Inputs 
Price is variable. Units sold depends on price. Unit variable cost depends on fixed costs. 

Figure 3.24 Two Inputs Influence Chart 
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Figure 3.25 Two Inputs Display 
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A B C D E
Controllable Input Price Units Sold
Price $29 $29 700
Uncontrollable Inputs $39 550
Fixed Costs $12,000 $49 400
Intermediate Variable $59 250
Unit Variable Cost $8.00
Units Sold 700 Slope -15
Output Variable Intercept 1135
Net Cash Flow $2,700

Fixed Costs Unit Variable Cost
$10,000 $11
$12,000 $8
$15,000 $6

a 0.000000166667
b -0.005166666667
c 46  

Figure 3.26 Two Inputs Formulas 
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A B C D E
Controllable Input Price Units Sold
Price 29 29 700
Uncontrollable Inputs 39 550
Fixed Costs 12000 49 400
Intermediate Variable 59 250
Unit Variable Cost =E16*B4^2+E17*B4+E18
Units Sold =E8+E7*B2 Slope =SLOPE(E2:E5,D2:D5)
Output Variable Intercept =INTERCEPT(E2:E5,D2:D5)
Net Cash Flow =(B2-B6)*B7-B4

Fixed Costs Unit Variable Cost
10000 11
12000 8
15000 6

a =TRANSPOSE(LINEST(E12:E14,D12:D14^{1,2}))
b =TRANSPOSE(LINEST(E12:E14,D12:D14^{1,2}))
c =TRANSPOSE(LINEST(E12:E14,D12:D14^{1,2}))  

Four Inputs with Three Uncertainties 
Price is variable. Units sold depends on price. Unit variable cost depends on fixed costs. 

Fixed costs, units sold, and unit variable cost are uncertain. 
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Figure 3.27 Three Uncertainties Influence Chart 
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Figure 3.28 Three Uncertainties Display 
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A B C D E
Controllable Input Price Units Sold
Price $29 $29 700
Uncontrollable Inputs $39 550
Fixed Costs $12,000 $49 400
Units Sold Uncertainty 10 $59 250
Unit Variable Cost Uncertainty $0.10
Intermediate Variable Slope -15
Units Sold Median 700 Intercept 1135
Units Sold 710
Unit Variable Cost Median $8.00
Unit Variable Cost $8.10 Fixed Costs Unit Variable Cost
Output Variable $10,000 $11
Net Cash Flow $2,839 $12,000 $8

$15,000 $6

a 0.000000166667
b -0.005166666667
c 46  
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Figure 3.29 Three Uncertainties Formulas 
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A B C D E
Controllable Input Price Units Sold
Price 29 29 700
Uncontrollable Inputs 39 550
Fixed Costs 12000 49 400
Units Sold Uncertainty 10 59 250
Unit Variable Cost Uncertainty 0.1
Intermediate Variable Slope =SLOPE(E2:E5,D2:D5)
Units Sold Median =E8+E7*B2 Intercept =INTERCEPT(E2:E5,D2:D5)
Units Sold =B8+B5
Unit Variable Cost Median =E16*B4^2+E17*B4+E18
Unit Variable Cost =B10+B6 Fixed Costs Unit Variable Cost
Output Variable 10000 11
Net Cash Flow =(B2-B11)*B9-B4 12000 8

15000 6

a =TRANSPOSE(LINEST(E12:E14,D12:D14^{1,2}))
b =TRANSPOSE(LINEST(E12:E14,D12:D14^{1,2}))
c =TRANSPOSE(LINEST(E12:E14,D12:D14^{1,2}))  

Intermediate Details 
Price is variable. Units sold depends on price. Unit variable cost depends on fixed costs. 

Fixed costs, units sold, and unit variable cost are uncertain. 

Include revenue, total variable cost, and total costs as intermediate variables. 

Figure 3.30 Intermediate Details Influence Chart 
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Figure 3.31 Intermediate Details Display 
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A B C D E
Controllable Input Price Units Sold
Price $29 $29 700
Uncontrollable Inputs $39 550
Fixed Costs $12,000 $49 400
Units Sold Uncertainty 10 $59 250
Unit Variable Cost Uncertainty $0.10
Intermediate Variable Slope -15
Units Sold Median 700 Intercept 1135
Units Sold 710
Revenue $20,590
Unit Variable Cost Median $8.00 Fixed Costs Unit Variable Cost
Unit Variable Cost $8.10 $10,000 $11
Total Variable Cost $5,751 $12,000 $8
Total Costs $17,751 $15,000 $6
Output Variable
Net Cash Flow $2,839 a 0.000000166667

b -0.005166666667
c 46  

Figure 3.32 Intermediate Details Formulas 
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A B C D E
Controllable Input Price Units Sold
Price 29 29 700
Uncontrollable Inputs 39 550
Fixed Costs 12000 49 400
Units Sold Uncertainty 10 59 250
Unit Variable Cost Uncertainty 0.1
Intermediate Variable Slope =SLOPE(E2:E5,D2:D5)
Units Sold Median =E8+E7*B2 Intercept =INTERCEPT(E2:E5,D2:D5)
Units Sold =B8+B5
Revenue =B9*B2
Unit Variable Cost Median =E16*B4^2+E17*B4+E18 Fixed Costs Unit Variable Cost
Unit Variable Cost =B11+B6 10000 11
Total Variable Cost =B12*B9 12000 8
Total Costs =B4+B13 15000 6
Output Variable
Net Cash Flow =B10-B14 a =TRANSPOSE(LINEST(E12:E14,D12:D14^{1,2}))

b =TRANSPOSE(LINEST(E12:E14,D12:D14^{1,2}))
c =TRANSPOSE(LINEST(E12:E14,D12:D14^{1,2}))  
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Decision Trees 
Using TreePlan  4 
 

TreePlan is a decision tree add-in for Microsoft Excel 97 (and later versions of Excel) for 
Windows and Macintosh. It was developed by Professor Michael R. Middleton at the 
University of San Francisco and modified for use at Fuqua (Duke) by Professor James E. 
Smith. 

4.1 TREEPLAN INSTALLATION 
All of TreePlan’s functionality is in a single file, TreePlan.xla. Depending on your 
preference, there are three ways to install TreePlan. (These instructions also apply to the 
other Decision ToolPak add-ins: SensIt.xla and RiskSim.xla.) 

Occasional Use 
If you plan to use TreePlan on an irregular basis, simply use Excel’s File | Open 
command to load TreePlan.xla each time you want to use it. You may keep the 
TreePlan.xla file on a floppy disk, your computer’s hard drive, or a network server. 

Selective Use 
You can use Excel’s Add-In Manager to install TreePlan. First, copy TreePlan.xla to a 
location on your computer’s hard drive. Second, if you save TreePlan.xla in the Excel or 
Office Library subdirectory, go to the third step. Otherwise, run Excel, choose Tools | 
Add-Ins; in the Add-Ins dialog box, click the Browse button, use the Browse dialog box 
to specify the location of TreePlan.xla, and click OK. Third, in the Add-Ins dialog box, 
note that TreePlan is now listed with a check mark, indicating that its menu command 
will appear in Excel, and click OK. 

If you plan to not use TreePlan and you want to free up main memory, uncheck the box 
for TreePlan in the Add-In Manager. When you do want to use TreePlan, choose Tools | 
Add-Ins and check TreePlan’s box. 
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To remove TreePlan from the Add-In Manager, use Windows Explorer or another file 
manager to delete TreePlan.xla from the Library subdirectory or from the location you 
specified when you used the Add-In Manager’s Browse command. The next time you 
start Excel and choose Tools | Add-Ins, a dialog box will state “Cannot find add-in … 
treeplan.xla. Delete from list?” Click Yes. 

Steady Use 
If you want TreePlan’s options immediately available each time you run Excel, use 
Windows Explorer or another file manager to save TreePlan.xla in the Excel XLStart 
directory. Alternatively, in Excel you can use Tools | Options | General to specify an 
alternate startup file location and use a file manager to save TreePlan.xla there. When you 
start Excel, it tries to open all files in the XLStart directory and in the alternate startup file 
location. 

For additional information visit “TreePlan FAQ” at www.treeplan.com. 

After opening TreePlan.xla in Excel, the command "Decision Tree" appears at the bottom 
of the Tools menu (or, if you have a customized main menu, at the bottom of the sixth 
main menu item). 

4.2 BUILDING A DECISION TREE IN TREEPLAN 
You can start TreePlan either by choosing Tools | Decision Tree from the menu bar or by 
pressing Ctrl+t (hold down the Ctrl key and press t). If the worksheet doesn't have a 
decision tree, TreePlan prompts you with a dialog box with three options; choose New 
Tree to begin a new tree. TreePlan draws a default initial decision tree with its upper left 
corner at the selected cell. For example, the figure below shows the initial tree when 
$B$2 is selected. (Note that TreePlan writes over existing values in the spreadsheet: 
begin your tree to the right of the area where your data is stored, and do not subsequently 
add or delete rows or columns in the tree-diagram area.) In Excel 5 and 95 a terminal 
node is represented by a triangle instead of a vertical bar. 

Figure 4.1 TreePlan Initial Default Decision Tree 
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Build up a tree by adding or modifying branches or nodes in the default tree. To change 
the branch labels or probabilities, click on the cell containing the label or probability and 
type the new label or probability. To modify the structure of the tree (e.g., add or delete 
branches or nodes in the tree), select the node or the cell containing the node in the tree to 
modify, and choose Tools | Decision Tree or press Ctrl+t. TreePlan will then present a 
dialog box showing the available commands. 

For example, to add an event node to the top branch of the tree shown above, select the 
square cell (cell G4) next to the vertical line at the end of a terminal branch and press 
Ctrl+t.. TreePlan then presents this dialog box. 

Figure 4.2 TreePlan Terminal Dialog Box 

 

To add an event node to the branch, we change the selected terminal node to an event 
node by selecting Change to event node in the dialog box, selecting the number of 
branches (here two), and pressing OK. TreePlan then redraws the tree with a chance node 
in place of the terminal node. 
Figure 4.3  
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The dialog boxes presented by TreePlan vary depending on what you have selected when 
you choose Tools | Decision Tree or press Ctrl+t. The dialog box shown below is 
presented when you press Ctrl+t with an event node selected; a similar dialog box is 
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presented when you select a decision node. If you want to add a branch to the selected 
node, choose Add branch and press OK. If you want to insert a decision or event node 
before the selected node, choose Insert decision or Insert event and press OK. To get a 
description of the available commands, click on the Help button. 

Figure 4.4  

 

The Copy subtree command is particularly useful when building large trees. If two or 
more parts of the tree are similar, you can copy and paste "subtrees" rather than building 
up each part separately. To copy a subtree, select the node at the root of the subtree and 
choose Copy subtree. This tells TreePlan to copy the selected node and everything to the 
right of it in the tree. To paste this subtree, select a terminal node and choose Paste 
subtree. TreePlan then duplicates the specified subtree at the selected terminal node. 

Since TreePlan decision trees are built directly in Excel, you can use Excel's commands 
to format your tree. For example, you can use bold or italic fonts for branch labels: select 
the cells you want to format and change them using Excel's formatting commands. To 
help you, TreePlan provides a Select dialog box that appears when you choose Tools 
Decision Tree or press Ctrl+t without a node selected. You can also bring up this dialog 
box by pressing the Select button on the Node dialog box. From here, you can select all 
items of a particular type in the tree. For example, if you choose Probabilities and press 
OK, TreePlan selects all cells containing probabilities in the tree. You can then format all 
of the probabilities simultaneously using Excel's formatting commands. (Because of 
limitations in Excel, the Select dialog box will not be available when working with very 
large trees.) 

4.3 ANATOMY OF A TREEPLAN DECISION TREE 
An example of a TreePlan decision tree is shown below. In the example, a firm must 
decide (1) whether to prepare a proposal for a possible contract and (2) which method to 
use to satisfy the contract. The tree consists of decision nodes, event nodes and terminal 
nodes connected by branches. Each branch is surrounded by cells containing formulas, 
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cell references, or labels pertaining to that branch. You may edit the labels, probabilities, 
and partial cash flows associated with each branch. The partial cash flows are the amount 
the firm "gets paid" to go down that branch. Here, the firm pays $50,000 if it decides to 
prepare the proposal, receives $250,000 up front if awarded the contract, spends $50,000 
to try the electronic method, and spends $120,000 on the mechanical method if the 
electronic method fails. 

Figure 4.5  

Use mechanical method
$80,000

0.5 -$120,000 $80,000
Awarded contract

2 0.5
$250,000 $90,000 Electronic success

$150,000
Try electronic method $0 $150,000

Prepare proposal -$50,000 $90,000 0.5
Electronic failure

-$50,000 $20,000 $30,000
-$120,000 $30,000

0.5
1 Not awarded contract

$20,000 -$50,000
$0 -$50,000

Don't prepare proposal
$0

$0 $0

BRANCH LABELS: 
Type text in these 
cells.

DECISION NODES: TreePlan formula 
for which alternative is optimal.

PARTIAL CASH FLOWS: 
Enter numbers or 
formulas in these cells.

PROBABILITIES: Enter numbers 
or formulas in these cells.

ROLLBACK EVs: TreePlan formula for 
expected value at this point in the tree.

TERMINAL NODES

EVENT NODES

TERMINAL VALUES: TreePlan formula for 
sum of partial cash flows along path.

 

The trees are "solved" using formulas embedded in the spreadsheet. The terminal values 
sum all the partial cash flows along the path leading to that terminal node. The tree is 
then "rolled back" by computing expected values at event nodes and by maximizing at 
decision nodes; the rollback EVs appear next to each node and show the expected value 
at that point in the tree. The numbers in the decision nodes indicate which alternative is 
optimal for that decision. In the example, the "1" in the first decision node indicates that 
it is optimal to prepare the proposal, and the "2" in the second decision node indicates the 
firm should try the electronic method because that alternative leads to a higher expected 
value, $90,000, than the mechanical method, $80,000. 

TreePlan has a few options that control the way calculations are done in the tree. To 
select these options, press the Options button in any of TreePlan's dialog boxes. The first 
choice is whether to Use Expected Values or Use Exponential Utility Function for 
computing certainty equivalents. The default is to rollback the tree using expected values. 
If you choose to use exponential utilities, TreePlan will compute utilities of endpoint cash 
flows at the terminal nodes and compute expected utilities instead of expected values at 
event nodes. Expected utilities are calculated in the cell below the certainty equivalents. 
You may also choose to Maximize (profits) or Minimize (costs) at decision nodes; the 
default is to maximize profits. If you choose to minimize costs instead, the cash flows are 
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interpreted as costs, and decisions are made by choosing the minimum expected value or 
certainty equivalent rather than the maximum. See the Help file for details on these 
options. 

4.4 STEP-BY-STEP TREEPLAN TUTORIAL 
A decision tree can be used as a model for a sequential decision problems under 
uncertainty. A decision tree describes graphically the decisions to be made, the events 
that may occur, and the outcomes associated with combinations of decisions and events. 
Probabilities are assigned to the events, and values are determined for each outcome. A 
major goal of the analysis is to determine the best decisions. 

Decision tree models include such concepts as nodes, branches, terminal values, strategy, 
payoff distribution, certainty equivalent, and the rollback method. The following problem 
illustrates the basic concepts. 

DriveTek Problem 
DriveTek Research Institute discovers that a computer company wants a new tape drive 
for a proposed new computer system. Since the computer company does not have 
research people available to develop the new drive, it will subcontract the development to 
an independent research firm. The computer company has offered a fee of $250,000 for 
the best proposal for developing the new tape drive. The contract will go to the firm with 
the best technical plan and the highest reputation for technical competence. 

DriveTek Research Institute wants to enter the competition. Management estimates a cost 
of $50,000 to prepare a proposal with a fifty-fifty chance of winning the contract. 

However, DriveTek's engineers are not sure about how they will develop the tape drive if 
they are awarded the contract. Three alternative approaches can be tried. The first 
approach is a mechanical method with a cost of $120,000, and the engineers are certain 
they can develop a successful model with this approach. A second approach involves 
electronic components. The engineers estimate that the electronic approach will cost only 
$50,000 to develop a model of the tape drive, but with only a 50 percent chance of 
satisfactory results. A third approach uses magnetic components; this costs $80,000, with 
a 70 percent chance of success. 

DriveTek Research can work on only one approach at a time and has time to try only two 
approaches. If it tries either the magnetic or electronic method and the attempt fails, the 
second choice must be the mechanical method to guarantee a successful model. 

The management of DriveTek Research needs help in incorporating this information into 
a decision to proceed or not. 
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[Source: The tape drive example is adapted from Spurr and Bonini, Statistical Analysis 
for Business Decisions, Irwin.] 

Nodes and Branches 
Decision trees have three kinds of nodes and two kinds of branches. A decision node is a 
point where a choice must be made; it is shown as a square. The branches extending from 
a decision node are decision branches, each branch representing one of the possible 
alternatives or courses of action available at that point. The set of alternatives must be 
mutually exclusive (if one is chosen, the others cannot be chosen) and collectively 
exhaustive (all possible alternatives must be included in the set). 

There are two major decisions in the DriveTek problem. First, the company must decide 
whether or not to prepare a proposal. Second, if it prepares a proposal and is awarded the 
contract, it must decide which of the three approaches to try to satisfy the contract. 

An event node is a point where uncertainty is resolved (a point where the decision maker 
learns about the occurrence of an event). An event node, sometimes called a "chance 
node," is shown as a circle. The event set consists of the event branches extending from 
an event node, each branch representing one of the possible events that may occur at that 
point. The set of events must be mutually exclusive (if one occurs, the others cannot 
occur) and collectively exhaustive (all possible events must be included in the set). Each 
event is assigned a subjective probability; the sum of probabilities for the events in a set 
must equal one. 

The three sources of uncertainty in the DriveTek problem are: whether it is awarded the 
contract or not, whether the electronic approach succeeds or fails, and whether the 
magnetic approach succeeds or fails. 

In general, decision nodes and branches represent the controllable factors in a decision 
problem; event nodes and branches represent uncontrollable factors. 

Decision nodes and event nodes are arranged in order of subjective chronology. For 
example, the position of an event node corresponds to the time when the decision maker 
learns the outcome of the event (not necessarily when the event occurs). 

The third kind of node is a terminal node, representing the final result of a combination of 
decisions and events. Terminal nodes are the endpoints of a decision tree, shown as the 
end of a branch on hand-drawn diagrams and as a triangle on computer-generated 
diagrams. 

The following table shows the three kinds of nodes and two kinds of branches used to 
represent a decision tree. 
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Figure 4.6 Nodes and Symbols 
Type of Node  Written Symbol  Computer Symbol  Node Successor 
Decision  square  square  decision branches 
Event  circle  circle  event branches 
Terminal  endpoint  triangle or bar  terminal value 

Terminal Values 
Each terminal node has an associated terminal value, sometimes called a payoff value, 
outcome value, or endpoint value. Each terminal value measures the result of a scenario: 
the sequence of decisions and events on a unique path leading from the initial decision 
node to a specific terminal node. 

To determine the terminal value, one approach assigns a cash flow value to each decision 
branch and event branch and then sum the cash flow values on the branches leading to a 
terminal node to determine the terminal value. In the DriveTek problem, there are distinct 
cash flows associated with many of the decision and event branches. Some problems 
require a more elaborate value model to determine the terminal values. 

The following diagram shows the arrangement of branch names, probabilities, and cash 
flow values on an unsolved tree. 
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Figure 4.7  
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To build the decision tree, you use TreePlan’s dialog boxes to develop the structure. You 
enter a branch name, branch cash flow, and branch probability (for an event) in the cells 
above and below the left side of each branch. As you build the tree diagram, TreePlan 
enters formulas in other cells. 

Building the Tree Diagram 
 1. Start with a new worksheet. (If no workbook is open, choose File | New. If a 

workbook is open, choose Insert | Worksheet.) 

 2. Select cell A1. From the Tools menu, choose Decision Tree. In the TreePlan 
New dialog box, click the New Tree button. A decision node with two branches 
appears. 
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Figure 4.8  

 

Figure 4.9  
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 3. Do not type the quotation marks in the following instructions. Select cell D2, 
and enter Prepare proposal. Select cell D4, and enter –50000. Select cell D7, 
and enter Don't prepare proposal. 

Figure 4.10  
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 4. Select cell F3. From the Tools menu, choose Decision Tree. In the TreePlan 
Terminal dialog box, select Change To Event Node, select Two Branches, and 
click OK. The tree is redrawn. 
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Figure 4.11  

 

Figure 4.12  
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 5. Select cell H2, and enter Awarded contract. Select cell H4, and enter 250000. 
Select cell H7, and enter Not awarded contract. 
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Figure 4.13  
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 6. Select cell J3. From the Tools menu, choose Decision Tree. In the TreePlan 
Terminal dialog box, select Change To Decision Node, select Three Branches, 
and click OK. The tree is redrawn. 

Figure 4.14  
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 7. Select cell L2, and enter Use mechanical method. Select cell L4, and enter –
120000. Select cell L7, and enter Try electronic method. Select cell L9, and 
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enter –50000. Select cell L12, and enter Try magnetic method. Select cell L14, 
and enter –80000.  

Figure 4.15  
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 8. Select cell N8. From the Tools menu, choose Decision Tree. In the TreePlan 
Terminal dialog box, select Change To Event Node, select Two Branches, and 
click OK. The tree is redrawn. 
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Figure 4.16  
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 9. Select cell P7, and enter Electronic success. Select cell P12, and enter 
Electronic failure. Select cell P14, and enter –120000. 
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Figure 4.17  
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 10. Select cell N18. From the Tools menu, choose Decision Tree. In the TreePlan 
Terminal dialog box, select Change To Event Node, select Two Branches, and 
click OK. The tree is redrawn. 



72     Chapter 4 Decision Trees Using TreePlan 

Figure 4.18  
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 11. Select cell P16, and enter .7. Select cell P17, and enter Magnetic success. Select 
cell P21, and enter .3. Select cell P22, and enter Magnetic failure. Select cell 
P24, and enter –120000. 
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Figure 4.19  

1
2
3
4
5
6
7
8
9

10
11
12
13
14
15
16
17
18
19
20
21
22
23
24
25
26
27
28
29
30
31
32
33
34

A B C D E F G H I J K L M N O P Q R S

Use mechanical method
80000

-120000 80000

0.5
Electronic success

150000
0.5 Try electronic method 0 150000

Awarded contract
2 -50000 90000 0.5

250000 90000 Electronic failure
30000

-120000 30000

0.7
Magnetic success

Prepare proposal 120000
Try magnetic method 0 120000

-50000 20000
-80000 84000 0.3

Magnetic failure
0

-120000 0

1 0.5
20000 Not awarded contract

-50000
0 -50000

Don't prepare proposal
0

0 0  

 12. Double-click the sheet tab (or right-click the sheet tab and choose Rename from 
the shortcut menu), and enter Original. Save the workbook. 

Interpreting the Results 
The $30,000 terminal value on the far right of the diagram in cell S13 is associated with 
the following scenario: 

Figure 4.20  
 Branch Type  Branch Name  Cash Flow 
 Decision  Prepare proposal  –$50,000 
 Event  Awarded contract  $250,000 
 Decision  Try electronic method  –$50,000 
 Event  Electronic failure (Use mechanical method)  –$120,000 

   Terminal value  $30,000 
 

TreePlan put the formula =SUM(P14,L11,H12,D20) into cell S13 for determining the 
terminal value.  
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Other formulas, called rollback formulas, are in cells below and to the left of each node. 
These formulas are used to determine the optimal choice at each decision node. 

In cell B26, a formula displays 1, indicating that the first branch is the optimal choice. 
Thus, the initial choice is to prepare the proposal. In cell J11, a formula displays 2, 
indicating that the second branch (numbered 1, 2, and 3, from top to bottom) is the 
optimal choice. If awarded the contract, DriveTek should try the electronic method. A 
subsequent chapter provides more details about interpretation. 

Formatting the Tree Diagram 
The following steps show how to use TreePlan and Excel features to format the tree 
diagram. You may choose to use other formats for your own tree diagrams. 

 13. From the Edit menu, choose Move or Copy Sheet (or right-click the sheet tab 
and choose Move Or Copy from the shortcut menu). In the lower left corner of 
the Move Or Copy dialog box, check the Create A Copy box, and click OK.  

14.On sheet Original (2), select cell H9. From the Tools menu, choose Decision Tree. In 
the TreePlan Select dialog box, verify that the option button for Cells with 
Probabilities is selected, and click OK. With all probability cells selected, click 
the Align Left button. 

Figure 4.21  

 

 15. Select cell H12. From the Tools menu, choose Decision Tree. In the TreePlan 
Select dialog box, verify that the option button for Cells with Partial Cash Flows 
is selected, and click OK. With all partial cash flow cells selected, click the 
Align Left button. With those cells still selected, choose Format | Cells. In the 
Format Cells dialog box, click the Number tab. In the Category list box, choose 
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Currency; type 0 (zero) for Decimal Places; select $ in the Symbol list box; 
select -$1,234 for Negative Numbers. Click OK. 

Figure 4.22  

 

 16. Select cell I12. From the Tools menu, choose Decision Tree. In the TreePlan 
Select dialog box, verify that the option button for Cells with Rollback EVs/CEs 
is selected, and click OK. With all rollback cells selected, choose Format | Cells. 
Repeat the Currency formatting of step 16 above. 

 17. Select cell S3. From the Tools menu, choose Decision Tree. In the TreePlan 
Select dialog box, verify that the option button for Cells with Terminal Values is 
selected, and click OK. With all terminal value cells selected, choose Format | 
Cells. Repeat the Currency formatting of step 16 above. 
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Figure 4.23  
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 18. Double-click the Original (2) sheet tab (or right-click the sheet tab and choose 
Rename from the shortcut menu), and enter Formatted. Save the workbook. 

Displaying Model Inputs 
When you build a decision tree model, you may want to discuss the model and its 
assumptions with co-workers or a client. For such communication it may be preferable to 
hide the results of formulas that show rollback values and decision node choices. The 
following steps show how to display only the model inputs. 

 19. From the Edit menu, choose Move or Copy Sheet (or right-click the sheet tab 
and choose Move Or Copy from the shortcut menu). In the lower left corner of 
the Move Or Copy dialog box, check the Create A Copy box, and click OK.  

 20. On sheet Formatted (2), select cell B1. From the Tools menu, choose Decision 
Tree. In the TreePlan Select dialog box, verify that the option button for 
Columns with Nodes is selected, and click OK. With all node columns selected, 
choose Format | Cells | Number. In the Category list box, select Custom. Select 
the entry in the Type edit box, and type ;;; (three semicolons). Click OK. 
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Figure 4.24  

 

Explanation: A custom number format has four sections of format codes. The sections are 
separated by semicolons, and they define the formats for positive numbers, negative 
numbers, zero values, and text, in that order. When you specify three semicolons without 
format codes, Excel does not display positive numbers, negative numbers, zero values, or 
text. The formula remains in the cell, but its result is not displayed. Later, if you want to 
display the result, you can change the format without having to enter the formula again. 
Editing an existing format does not delete it. All formats are saved with the workbook 
unless you explicitly delete a format. 

 21. Select cell A27. From the Tools menu, choose Decision Tree. In the TreePlan 
Select dialog box, verify that the option button for Cells with Rollback EVs/CEs 
is selected, and click OK. With all rollback values selected, choose Format | 
Cells | Number. In the Category list box, select Custom. Scroll to the bottom of 
the Type list box, and select the three-semicolon entry. Click OK. 

 22. Double-click the Formatted (2) sheet tab (or right-click the sheet tab and choose 
Rename from the shortcut menu), and enter Model Inputs. Save the workbook. 
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Printing the Tree Diagram 
 23. In the Name Box list box, select TreeDiagram (or select cells A1:S34).  

 24. To print the tree diagram from Excel, with the tree diagram range selected 
choose File | Print Area | Set Print Area. Choose File | Page Setup. In the Page 
Setup dialog box, click the Page tab; for Orientation click the option button for 
Landscape, and for Scaling click the option button for Fit To 1 Page Wide By 1 
Page Tall. Click the Header/Footer tab; in the Header list box select None, and 
in the Footer list box select None (or select other appropriate headers and 
footers). Click the Sheet tab; clear the check box for Gridlines, and clear the 
check box for Row And Column Headings. Click OK. Choose File | Print and 
click OK. 

 25. To print the tree diagram from Word, clear the check boxes for Gridlines and for 
Row And Column Headings on Excel’s Page Setup dialog box Sheet tab. Select 
the tree diagram range. Hold down the Shift key and from the Edit menu choose 
Copy Picture. In the Copy Picture dialog box, click the option button As Shown 
When Printed, and click OK. In Word select the location where you want to 
paste the tree diagram and choose Edit | Paste.  

Figure 4.25  
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Alternative Model 
If you want to emphasize that the time constraint forces DriveTek to use the mechanical 
approach if they try either of the uncertain approaches and experience a failure, you can 
change the terminal nodes in cells R13 and R23 to decision nodes, each with a single 
branch.  

Figure 4.26  
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4.5 DECISION TREE SOLUTION 

Strategy 
A strategy specifies an initial choice and any subsequent choices to be made by the 
decision maker. The subsequent choices usually depend upon events. The specification of 
a strategy must be comprehensive; if the decision maker gives the strategy to a colleague, 
the colleague must know exactly which choice to make at each decision node. 

Most decision problems have many possible strategies, and a goal of the analysis is to 
determine the optimal strategy, taking into account the decision maker's risk attitude. 
There are four strategies in the DriveTek problem. One of the strategies is: Prepare the 
proposal; if not awarded the contract, stop; if awarded the contract, try the magnetic 
method; if the magnetic method is successful, stop; if the magnetic method fails, use the 
mechanical method. The four strategies will be discussed in detail below. 
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Payoff Distribution 
Each strategy has an associated payoff distribution, sometimes called a risk profile. The 
payoff distribution of a particular strategy is a probability distribution showing the 
probability of obtaining each terminal value associated with a particular strategy. 

In decision tree models, the payoff distribution can be shown as a list of possible payoff 
values, x, and the discrete probability of obtaining each value, P(X=x), where X 
represents the uncertain terminal value associated with a strategy. Since a strategy 
specifies a choice at each decision node, the uncertainty about terminal values depends 
only on the occurrence of events. The probability of obtaining a specific terminal value 
equals the product of the probabilities on the event branches on the path leading to the 
terminal node. 

DriveTek Strategies 
In this section each strategy of the DriveTek problem is described by a shorthand 
statement and a more detailed statement. The possible branches following a specific 
strategy are shown in decision tree form, and the payoff distribution is shown in a table 
with an explanation of the probability calculations. 

 

Strategy 1 (Mechanical): Prepare; if awarded, use mechanical. 

Details: Prepare the proposal; if not awarded the contract, stop (payoff = -$50,000); if 
awarded the contract, use the mechanical method (payoff = $80,000). 
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Figure 4.27  
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Figure 4.28  
  

Value, x 
 Probability 

P(X=x) 
  

 $80,000  0.50   
 -$50,000  0.50   
   1.00   

 

Strategy 2 (Electronic): Prepare; if awarded, try electronic. 

Details: Prepare the proposal; if not awarded the contract, stop (payoff = -$50,000); if 
awarded the contract, try the electronic method; if the electronic method is successful, 
stop (payoff = $150,000); if the electronic method fails, use the mechanical method 
(payoff = $30,000). 
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Figure 4.29  
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Figure 4.30  
  

Value, x 
 Probability 

P(X=x) 
  

 $150,000  0.25  = 0.5 * 0.5 
 $30,000  0.25  = 0.5 * 0.5 
 -$50,000  0.50   
   1.00   

 

Strategy 3 (Magnetic): Prepare; if awarded, try magnetic. 

Details: Prepare the proposal; if not awarded the contract, stop (payoff = -$50,000); if 
awarded the contract, try the magnetic method; if the magnetic method is successful, stop 
(payoff = $120,000); if the magnetic method fails, use the mechanical method (payoff = 
$0). 



4.5 Decision Tree Solution     83 

Figure 4.31  
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Figure 4.32  
  

Value, x 
 Probability 

P(X=x) 
  

 $120,000  0.35  = 0.5 * 0.7 
 $0  0.15  = 0.5 * 0.3 
 -$50,000  0.50   
   1.00   
 

Strategy 4 (Don't): Don't. 

Details: Don't prepare the proposal (payoff = $0). 
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Figure 4.33  
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Figure 4.34  
  

Value, x 
 Probability 

P(X=x) 
  

 $0  1.00   
   1.00   
 

Strategy Choice 
Since each strategy can be characterized completely by its payoff distribution, selecting 
the best strategy becomes a problem of choosing the best payoff distribution.  

One approach is to make a choice by direct comparison of the payoff distributions. 
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Figure 4.35  
 Strategy 1 (Mechanical)    Strategy 2 (Electronic) 
  

Value, x 
 Probability 

P(X=x) 
  

Value, x 
 Probability 

P(X=x) 
 $80,000  0.50  $150,000  0.25 
 -$50,000  0.50  $30,000  0.25 
   1.00  -$50,000  0.50 
       1.00 
        
        
 Strategy 3 (Magnetic)    Strategy 4 (Don't) 
  

Value, x 
 Probability 

P(X=x) 
  

Value, x 
 Probability 

P(X=x) 
 $120,000  0.35  $0  1.00 
 $0  0.15    1.00 
 -$50,000  0.50     
   1.00     

Another approach for making choices involves certainty equivalents. 

Certainty Equivalent 
A certainty equivalent is a certain payoff value which is equivalent, for the decision 
maker, to a particular payoff distribution. If the decision maker can determine his or her 
certainty equivalent for the payoff distribution of each strategy, then the optimal strategy 
is the one with the highest certainty equivalent. 

The certainty equivalent is the minimum selling price for a payoff distribution; it depends 
on the decision maker's personal attitude toward risk. A decision maker may be risk 
preferring, risk neutral, or risk avoiding. 

If the terminal values are not regarded as extreme (relative to the decision maker's total 
assets), if the decision maker will encounter other decision problems with similar payoffs, 
and if the decision maker has the attitude that he or she will "win some and lose some," 
then the decision maker's attitude toward risk may be described as risk neutral. 

If the decision maker is risk neutral, the expected value is the appropriate certainty 
equivalent for choosing among the strategies. Thus, for a risk neutral decision maker, the 
optimal strategy is the one with the highest expected value. 

The expected value of a payoff distribution is calculated by multiplying each terminal 
value by its probability and summing the products. The expected value calculations for 
each of the four strategies of the DriveTek problem are shown below. 
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Figure 4.36  
 Strategy 1 (Mechanical)     
  

Value, x 
 Probability 

P(X=x) 
  

x * P(X=x) 
 $80,000  0.50  $40,000 
 -$50,000  0.50  -$25,000 
     $15,000 

 
 Strategy 2 (Electronic)     
  

Value, x 
 Probability 

P(X=x) 
  

x * P(X=x) 
 $150,000  0.25  $37,500 
 $30,000  0.25  7,500 
 -$50,000  0.50  -$25,000 
     $20,000 

 
 Strategy 3 (Magnetic)     
  

Value, x 
 Probability 

P(X=x) 
  

x * P(X=x) 
 $120,000  0.35  $42,000 
 $0  0.15  $0 
 -$50,000  0.50  -$25,000 
     $17,000 

 
 Strategy 4 (Don't)     
  

Value, x 
 Probability 

P(X=x) 
  

x * P(X=x) 
 $0  1.00  $0 
     $0 

The four strategies of the DriveTek problem have expected values of $15,000, $20,000, 
$17,000, and $0. Strategy 2 (Electronic) is the optimal strategy with expected value 
$20,000. 

A risk neutral decision maker's choice is based on the expected value. However, note that 
if strategy 2 (Electronic) is chosen, the decision maker does not receive $20,000. The 
actual payoff will be $150,000, $30,000, or -$50,000, with probabilities shown in the 
payoff distribution. 
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Rollback Method 
If we have a method for determining certainty equivalents (expected values for a risk 
neutral decision maker), we don't need to examine every possible strategy explicitly. 
Instead, the method known as rollback determines the single best strategy. 

The rollback algorithm, sometimes called backward induction or "average out and fold 
back," starts at the terminal nodes of the tree and works backward to the initial decision 
node, determining the certainty equivalent rollback values for each node. Rollback values 
are determined as follows: 

 • At a terminal node, the rollback value equals the terminal value. 

 • At an event node, the rollback value for a risk neutral decision maker is 
determined using expected value; the branch probability is multiplied times the 
successor rollback value, and the products are summed. 

 • At a decision node, the rollback value is set equal to the highest rollback value 
on the immediate successor nodes. 

In TreePlan tree diagrams the rollback values are located to the left and below each 
decision, event, and terminal node. Terminal values and rollback values for the DriveTek 
problem are shown below. 

Figure 4.37  

Use mechanical method
$80,000

$80,000

0.5
Electronic success

$150,000
0.5 Try electronic method $150,000
Awarded contract

$90,000 0.5
$90,000 Electronic failure

$30,000
$30,000

0.7
Magnetic success

Prepare proposal $120,000
Try magnetic method $120,000

$20,000
$84,000 0.3

Magnetic failure
$0

$0

0.5
$20,000 Not awarded contract

-$50,000
-$50,000

Don't prepare proposal
$0

$0  
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Optimal Strategy 
After the rollback method has determined certainty equivalents for each node, the optimal 
strategy can be identified by working forward through the tree. At the initial decision 
node, the $20,000 rollback value equals the rollback value of the "Prepare proposal" 
branch, indicating the alternative that should be chosen. DriveTek will either be awarded 
the contract or not; there is a subsequent decision only if DriveTek obtains the contract. 
(In a more complicated decision tree, the optimal strategy must include decision choices 
for all decision nodes that might be encountered.) At the decision node following 
"Awarded contract," the $90,000 rollback value equals the rollback value of the "Try 
electronic method" branch, indicating the alternative that should be chosen. 
Subsequently, if the electronic method fails, DriveTek must use the mechanical method 
to satisfy the contract. 

Cell B26 has the formula =IF(A27=E20,1,IF(A27=E34,2)) which displays 1, indicating 
that the first branch is the optimal choice. Thus, the initial choice is to prepare the 
proposal. Cell J11 has the formula =IF(I12=M4,1,IF(I12=M11,2,IF(I12=M21,3))) which 
displays 2, indicating that the second branch (numbered 1, 2, and 3, from top to bottom) 
is the optimal choice. If awarded the contract, DriveTek should try the electronic method. 

The pairs of rollback values at the relevant decision nodes ($20,000 and $90,000) and the 
preferred decision branches are shown below in bold. 
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Figure 4.38  

1
2
3
4
5
6
7
8
9
10
11
12
13
14
15
16
17
18
19
20
21
22
23
24
25
26
27
28
29
30
31
32
33
34

A B C D E F G H I J K L M N O P Q R S

Use mechanical method
$80,000

$80,000

0.5
Electronic success

$150,000
0.5 Try electronic method $150,000
Awarded contract

2 $90,000 0.5
$90,000 Electronic failure

$30,000
$30,000

0.7
Magnetic success

Prepare proposal $120,000
Try magnetic method $120,000

$20,000
$84,000 0.3

Magnetic failure
$0

$0

1 0.5
$20,000 Not awarded contract

-$50,000
-$50,000

Don't prepare proposal
$0

$0  

Taking into account event branches with subsequent terminal nodes, all branches and 
terminal values associated with the optimal risk neutral strategy are shown below. 
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Figure 4.39  

Use mechanical method
$80,000

0.5
Electronic success

$150,000
0.5 Try electronic method
Awarded contract

0.5
Electronic failure

$30,000

0.7
Magnetic success

Prepare proposal $120,000
Try magnetic method

0.3
Magnetic failure

$0

0.5
Not awarded contract

-$50,000

Don't prepare proposal
$0

 

The rollback method has identified strategy 2 (Electronic) as optimal. The rollback value 
on the initial branch of the optimal strategy is $20,000, which must be the same as the 
expected value for the payoff distribution of strategy 2. Some of the intermediate 
calculations for the rollback method differ from the calculations for the payoff 
distributions, but both approaches identify the same optimal strategy with the same initial 
expected value. For decision trees with a large number of strategies, the rollback method 
is more efficient. 

4.6 NEWOX DECISION TREE PROBLEM 
The Newox Company is considering whether or not to drill for natural gas on its own 
land. If they drill, their initial expenditure will be $40,000 for drilling costs. If they strike 
gas, they must spend an additional $30,000 to cap the well and provide the necessary 
hardware and control equipment. (This $30,000 cost is not a decision; it is associated 
with the event "strike gas.") If they decide to drill but no gas is found, there are no other 
subsequent alternatives, so their outcome value is $-40,000. 

If they drill and find gas, there are two alternatives. Newox could sell to West Gas, which 
has made a standing offer of $200,000 to purchase all rights to the gas well's production 
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(assuming that Newox has actually found gas). Alternatively, if gas is found, Newox can 
decide to keep the well instead of selling to West Gas; in this case Newox manages the 
gas production and takes its chances by selling the gas on the open market. 

At the current price of natural gas, if gas is found it would have a value of $150,000 on 
the open market. However, there is a possibility that the price of gas will rise to double its 
current value, in which case a successful well will be worth $300,000. 

The company's engineers feel that the chance of finding gas is 30 percent; their staff 
economist thinks there is a 60 percent chance that the price of gas will double. 

4.7 BRANDON DECISION TREE PROBLEM 
Brandon Appliance Corporation, a predominant producer of microwave ovens, is 
considering the introduction of a new product. The new product is a microwave oven that 
will defrost, cook, brown, and boil food as well as sense when the food is done. 

Brandon must decide on a course of action for implementing this new product line. An 
initial decision must be made to (1) nationally distribute the product from the start, (2) 
conduct a marketing test first, or (3) not market the product at all. If a marketing test is 
conducted, Brandon will consider the result and then decide whether to abandon the 
product line or make it available for national distribution. 

The finance department has provided some cost information and probability assignments 
relating to this decision. The preliminary costs for research and development have 
already been incurred and are considered irrelevant to the marketing decision. A success 
nationally will increase profits by $5,000,000, and failure will reduce them by 
$1,000,000, while abandoning the product will not affect profits. The test market analysis 
will cost Brandon an additional $35,000. 

If a market test is not performed, the probability of success in a national campaign is 60 
percent. If the market test is performed, the probability of a favorable test result is 58 
percent. With favorable test results, the probability for national success is approximately 
93 percent. However, if the test results are unfavorable, the national success probability is 
approximately 14 percent. 

Decision Tree Strategies 
Brandon Appliance Corporation must decide on a course of action for implementing this 
new microwave oven. An initial decision must be made to (1) nationally distribute the 
product from the start, (2) conduct a marketing test first, or (3) not market the product at 
all. If a marketing test is conducted, Brandon will consider the result and then decide 
whether to abandon the product line or make it available for national distribution. The 
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following decision tree is based on information about cash flows and probability 
assignments. 

Figure 4.40  
0.6
Success

+$5,000
National

0.4
Failure

-$1,000

0.93
Success

+$4,965
National

0.07
0.58 Failure
Favorable -$1,035

Don't
Brandon -$35

Test
0.14
Success

+$4,965
National

0.86
0.42 Failure
Unfavorable -$1,035

Don't
-$35

Don't
$0

 

In a decision tree model, a strategy is a specification of an initial choice and any 
subsequent choices that must be made by the decision maker. 

How many strategies are there in the Brandon problem? 

Describe each strategy. 
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Figure 4.41 Strategy 1: National 
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0.58 Failure
Favorable -$1,035

Don't
Brandon -$35

Test
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Success
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Don't
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Figure 4.42 Strategy 2: Test; if Favorable, National; if Unfavorable, National 
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Figure 4.43 Strategy 3: Test; if Favorable, National; if Unfavorable, Don't 
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Figure 4.44 Strategy 4: Test; if Favorable, Don't; if Unfavorable, National 
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Figure 4.45 Strategy 5: Test; if Favorable, Don't; if Unfavorable, Don't 
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Figure 4.46 Strategy 6: Don't 
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5.1 APPLICATIONS OF MULTI-ATTRIBUTE UTILITY 
Strategy for Dealing with Microcomputer Networking 

 Impact on microcomputer users 

  Productivity enhancement 

  User satisfaction 

 Impact on mainframe capacity 

 Costs 

 Upward compatibility of the network 

 Impacts on organizational structure 

 Risks 

Purchase of manufacturing machinery 

 Price 

 Technical features 

 Service 

Choosing a manager candidate 

 Education 

 Management skills 

 Technical skills 

 Personal skills 

Choosing a beverage container (soft drink industry) 
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 Energy to produce 

 Cost 

 Environmental waste 

 Customer service 

Selecting a best job 

 Monetary compensation 

 Geographical location 

 Travel requirements 

 Nature of work 

5.2 MULTIATTRIBUTE UTILITY SWING WEIGHTS 
Excel Workbook Clemen15.xls 

Conflicting Objectives: Fundamental Objectives versus Means Objectives 

Clemen, Making Hard Decisions, Ch. 15 

Multiattribute Utility 

Set of Objectives should be 

 1)  complete 

 2)  as small as possible 

 3)  not redundant 

 4)  decomposable ("independent" or unrelated) 

Additive Utility Function 

Overall Score of Alternative  =  Sum [ Weight times Attribute Score of Alternative ] 

Figure 5.1 Data for Example 

Attribute  Red Portalo  Blue Norushi  Yellow Standard 

Life span, in years 12  9  6  

Price  $17,000  $10,000  $8,000  

Color  Red  Blue  Yellow  
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Attribute Scores 

Figure 5.2 Individual Utility for Life Span 

Life Span

Years Score
6 0
9 0.5

12 1

Scores for Life Span

0.0

0.2

0.4

0.6

0.8

1.0

5 6 7 8 9 10 11 12 13

Life Span, in years

Li
fe

 S
pa

n 
Sc

or
e

 

Figure 5.3 Individual Utility for Price 
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Figure 5.4 Individual Utility for Color 
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Swing Weights 

Figure 5.5 Swing Weight Assessment Display 

1
2
3
4
5
6
7
8
9
10

A B C D E F G
Swing Weights

Consequence to Compare
Attribute Swung from
 Worst to Best Life span Price Color Rank Rate Weight
(Benchmark) 6 years $17,000 red 4 0 0.000
Life span 12 years $17,000 red 2 75 0.405
Price 6 years $8,000 red 1 100 0.541
Color 6 years $17,000 yellow 3 10 0.054

185  

1)  Hypothetical alternatives (number of attributes plus one) 

     Benchmark alternative is worst for all attributes 

     Each other hypothetical alternative has one attribute at best, all others at worst 

2)  Rank the hypothetical alternatives 

3)  Benchmark has rating zero, first ranked alternative has rating 100 
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     Assign level-of-satisfaction ratings to the intermediate alternatives 

4)  Weight equals rating divided by sum of ratings 

Figure 5.6 Swing Weight Assessment Formulas 

1
2
3
4
5
6
7
8
9

10

A B C D E F G
Swing Weights

Consequence to Compare
Attribute Swung from
 Worst to Best Life span Price Color Rank Rate Weight
(Benchmark) 6 years $17,000 red 4 0 =F6/$F$10
Life span 12 years $17,000 red 2 75 =F7/$F$10
Price 6 years $8,000 red 1 100 =F8/$F$10
Color 6 years $17,000 yellow 3 10 =F9/$F$10

=SUM(F6:F9)  

Overall Scores 

Figure 5.7 Swing Weight Overall Scores Display 

1
2
3
4
5
6
7
8
9

10
11
12

I J K L M N O P Q
Overall Scores

Red Portalo Blue Norushi Yellow Standard
Attribute Attribute Attribute Attribute Attribute Attribute

Attribute Value Score Value Score Value Score
Life span 12 1.000 9 0.500 6 0.000
Price $17,000 0.000 $10,000 0.780 $8,000 1.000
Color Red 0.000 Blue 0.667 Yellow 1.000

Overall Score 0.40541 0.66038 0.59459

Best Blue Norushi  

Figure 5.8 Swing Weight Overall Scores Formulas 

1
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5
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10
11
12

I J K L M N O P Q R
Overall Scores

Red Portalo Blue Norushi Yellow Standard
Attribute Attribute Attribute Attribute Attribute Attribute

Attribute Value Score Value Score Value Score
Life span 12 1.000 9 0.500 6 0.000
Price $17,000 0.000 $10,000 0.780 $8,000 1.000
Color Red 0.000 Blue 0.667 Yellow 1.000

Overall Score =SUMPRODUCT($G$7:$G$9,K6:K8) =SUMPRODUCT($G$7:$G$9,N6:N8) =SUMPRODUCT($G$7:$G$9,Q6:Q8)

Best =IF(K10=MAX(K10,N10,Q10),"Red Portalo",IF(N10=MAX(K10,N10,Q10),"Blue Norushi","Yellow Standard"))  
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Figure 5.9 Sensitivity Analysis 
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U V W X Y Z AA
Sensitivity Analysis Data Tables

Life Span Rate (10 to 100) Color Rate (0 to 75)

W9 Output Formula: =J12 Z9 Output Formula: =J12
Column Input Cell:  F7 Column Input Cell:  F9

Life Span Rate Best Color Rate Best

10 Yellow Standard 0 Blue Norushi
15 Yellow Standard 5 Blue Norushi
20 Yellow Standard 10 Blue Norushi Base Case
25 Yellow Standard 15 Blue Norushi
30 Yellow Standard 20 Blue Norushi
35 Yellow Standard 25 Blue Norushi
40 Yellow Standard 30 Blue Norushi
45 Yellow Standard 35 Blue Norushi
50 Yellow Standard 40 Blue Norushi
55 Blue Norushi 45 Blue Norushi
60 Blue Norushi 50 Yellow Standard
65 Blue Norushi 55 Yellow Standard
70 Blue Norushi 60 Yellow Standard

Base Case 75 Blue Norushi 65 Yellow Standard
80 Blue Norushi 70 Yellow Standard
85 Blue Norushi 75 Yellow Standard
90 Blue Norushi
95 Blue Norushi

100 Blue Norushi  

5.3 SENSITIVITY ANALYSIS METHODS 
SENSITIVITY ANALYSIS FOR MULTI-ATTRIBUTE UTILITY USING EXCEL 

This paper describes several standard methods for analyzing decisions where the 
outcomes have multiple attributes. The example problem concerns a large company that 
is planning to purchase several hundred cars for use by the sales force. The company 
wants a car that is inexpensive, safe, and lasts a long time. Figure 1 shows data for seven 
cars that are being considered. 
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Figure 1 Attribute Data for Seven Alternatives 

1
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A B C D E F G H
Alternatives

Attribute Alta Bulldog Cruiser Delta Egret Fleet Garnett
Cost $20 $18 $16 $14 $12 $10 $15
Lifetime 10 10 8 8 6 6 8
Safety High Medium High Medium Medium Low Low

Cost thousands of dollars
Lifetime expected years
Safety third-party rating  

Other attributes might be important, e.g., comfort and prestige. The cost attribute should 
include operating costs, insurance, and salvage value, in addition to purchase price. It 
might be appropriate to combine the cost and lifetime attributes into a single attribute, 
e.g., cost per year. Clemen [1] suggests that a set of attributes should be complete (so that 
all important objectives are included), as small as possible (to facilitate analysis), not 
redundant (to avoid double-counting a common underlying characteristic), and 
decomposable (so that the decision maker can think about each attribute separately). 

Dominance 
An alternative can be eliminated if another alternative is better on some objectives and no 
worse on the others. The Garnett is more expensive than the Delta, has the same lifetime, 
and has a lower safety rating. So the Garnett can be eliminated from further 
consideration. 

Monetary Equivalents Assessment 
One method for comparing multi-attribute alternatives is to subjectively assign monetary 
values to the non-monetary attributes. For example, the decision maker may determine 
that each additional year of expected lifetime is worth $500, medium safety is $4,000 
better than low safety, and high safety is $6,000 better than low safety. Arbitrarily using 
Fleet as the base case with total equivalent cost of $10,000, Figure 2 shows costs and 
equivalent costs, in thousands of dollars, in rows 9:11. The negative entries for Lifetime 
and Safety correspond to positive benefits relative to the Fleet car's base case values. 

Based on this method, the Egret is chosen. Sensitivity analysis, not shown here, would 
involve seeing how the choice depends on subjective equivalents different from the $500 
per year lifetime and the $4,000 and $6,000 safety assessments. 

Hammond et al. [3] describe another method involving even swaps that could be used to 
select the best alternative. 
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Figure 2 Monetary Equivalents for Non-Dominated Alternatives 
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A B C D E F G
Non-Dominated Alternatives

Attribute Alta Bulldog Cruiser Delta Egret Fleet
Cost $20 $18 $16 $14 $12 $10
Lifetime, years 10 10 8 8 6 6
Safety rating High Medium High Medium Medium Low

Non-Dominated Alternatives
Attribute Alta Bulldog Cruiser Delta Egret Fleet
Cost $20 $18 $16 $14 $12 $10
Lifetime, $ -$2 -$2 -$1 -$1 $0 $0
Safety, $ -$6 -$4 -$6 -$4 -$4 $0

Equiv. Cost $12 $12 $9 $9 $8 $10  

Additive Utility Function 
The additive multi-attribute utility function U includes individual utility functions Ui for 
each attribute xi, usually scaled from 0 to 1, and weights wi that reflect the decision 
maker's tradeoffs among the attributes. 

 U(x1,x2,x3) = w1
.U1(x1) + w2

.U2(x2) + w3
.U3(x3), where w1 + w2 + w3 = 1 (1) 

Weights may be specified directly, as ratios, or using a swing weight procedure. 
Individual utility functions are assessed using the range of attribute values for the 
alternatives being considered. 

The individual utility values for Cost and Lifetime shown in Figure 3 are based on 
proportional scores, corresponding to linear utility functions. For example, each thousand 
dollar difference in cost is associated with a 0.1 difference in utility. The utility values for 
Safety are subjective judgments. For example, the decision maker thinks that a change in 
Safety from Low to Medium achieves only two-thirds of the satisfaction associated with 
a change from Low to High. 
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Figure 3 Individual Utilities 
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Non-Dominated Alternatives

Attribute Alta Bulldog Cruiser Delta Egret Fleet
Cost $20 $18 $16 $14 $12 $10
Lifetime 10 10 8 8 6 6
Safety High Medium High Medium Medium Low

Assess individual utility for each attribute.
Cost U($20,000)=0, U($10,000)=1, linear
Lifetime U(6 years)=0, U(10 years)=1, linear
Safety U(Low)=0, U(Medium)=2/3, U(High)=1

Non-Dominated Alternatives
Attribute Alta Bulldog Cruiser Delta Egret Fleet
Cost 0.000 0.200 0.400 0.600 0.800 1.000
Lifetime 1.000 1.000 0.500 0.500 0.000 0.000
Safety 1.000 0.667 1.000 0.667 0.667 0.000  

Compared to the assessments for individual utility, the assessments for tradeoffs are 
usually much more difficult to make. The following sections focus on assessments of 
tradeoff weights and sensitivity analysis. 

Weight Ratio Assessment 
One method for measuring trade-offs among the conflicting objectives is to assess weight 
ratios. For example, the decision maker may judge that cost is five times as important as 
lifetime, which may be interpreted to mean that the change in overall satisfaction 
corresponding to a change in cost from $20,000 to $10,000 is five times the change in 
overall satisfaction corresponding to a change in lifetime from 6 years to 10 years. 
Similarly, the decision maker may judge that a $10,000 decrease in cost is one and a half 
times as satisfying as a change from a low to a high safety rating. The assessments are 
shown in cells J4:J5 in Figure 4. 
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Figure 4 Weight Ratio Assessment and Choice 
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Non-Dominated Alternatives Assess weight ratios.

Attribute Alta Bulldog Cruiser Delta Egret Fleet
Cost 0.000 0.200 0.400 0.600 0.800 1.000 Weight Ratio Input
Lifetime 1.000 1.000 0.500 0.500 0.000 0.000 Cost/Lifetime 5.0
Safety 1.000 0.667 1.000 0.667 0.667 0.000 Cost/Safety 1.5

Overall 0.464 0.452 0.625 0.613 0.667 0.536 Weights
Cost 0.536

Max Value 0.667 Lifetime 0.107
Location 5 Safety 0.357
Choice Egret

Choice Egret  

With three attributes, the two assessed weight ratios determine two equations and the 
requirement that the weights sum to one determines a third equation. Using algebra, a 
solution for the three unknown weights is shown in cells J8:J10 in Figure 5. 

The formula for overall utility in cell B7, with a relative reference to the attribute utilities 
in B3:B5 and an absolute reference to the weights in J8:J10, is copied to cells C7:G7. 

The MAX worksheet function determines the maximum overall utility in B7:G7, the 
MATCH function determines the location of that maximum in B7:G7, and the INDEX 
function returns the alternative name located in B2:G2. The zero argument in the 
MATCH function is needed to specify that an exact match is required; the zero argument 
in the INDEX function is used as a placeholder and could be omitted in this application 
without affecting the results. Cell B13 combines these functions into a single formula. 

Figure 5 Formulas for Weight Ratio Assessment and Choice 

1
2
3
4
5
6
7
8
9

10
11
12
13

A B H I J
Non-Dominated Alternatives Assess weight ratios.

Attribute Alta
Cost 0 Weight Ratio Input
Lifetime 1 Cost/Lifetime 5
Safety 1 Cost/Safety 1.5

Overall =SUMPRODUCT(B3:B5,$J$8:$J$10) Weights
Cost =1/(1/J4+1/J5+1)

Max Value =MAX(B7:G7) Lifetime =J8/J4
Location =MATCH(B9,B7:G7,0) Safety =J8/J5
Choice =INDEX(B2:G2,0,B10)

Choice =INDEX(B2:G2,0,MATCH(MAX(B7:G7),B7:G7,0))  

After deleting cells A9:B12, the single formula is in cell B9. The arrangement shown in 
Figure 6 is used for the remaining analyses. 
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Figure 6 Weight Ratio Choice for Sensitivity Analysis 

1
2
3
4
5
6
7
8
9

A B C D E F G
Non-Dominated Alternatives

Attribute Alta Bulldog Cruiser Delta Egret Fleet
Cost 0.000 0.200 0.400 0.600 0.800 1.000
Lifetime 1.000 1.000 0.500 0.500 0.000 0.000
Safety 1.000 0.667 1.000 0.667 0.667 0.000

Overall 0.464 0.452 0.625 0.613 0.667 0.536

Choice Egret  

Weight Ratio Sensitivity Analysis 
The decision maker specified tradeoffs using weight ratios, so it is appropriate to see 
whether the choice is sensitive to changes in those assessed values. To construct a two-
way data table for sensitivity analysis of the weight ratios as shown in Figures 7 and 8, 
enter a set of values in a row, N4:R4, and another set of values in a column, M5:M13. In 
the top left cell of the data table, M4, enter a formula for determining the data table's 
output values, =B9. (To improve the appearance of the table, cell M4 is formatted with a 
custom three-semicolon format so that the formula result is not displayed.) Select 
M4:R13. Choose Data | Table. In the Data Table dialog box, specify J4 as the Row Input 
Cell and J5 as the Column Input Cell. Click OK. 

Figure 7 Coarse Two-Factor Sensitivity Analysis of Weight Ratios 

1
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4
5
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7
8
9
10
11
12
13

L M N O P Q R
Two-Factor Sensitivity Analysis

Cost/Lifetime Weight Ratio
3.0 4.0 5.0 6.0 7.0

Cost/Safety 1.00 Cruiser Cruiser Cruiser Cruiser Cruiser
Weight 1.25 Cruiser Egret Egret Egret Egret
Ratio 1.50 Egret Egret Egret Egret Egret

1.75 Egret Egret Egret Egret Egret
2.00 Egret Egret Egret Egret Egret
2.25 Egret Egret Egret Egret Egret
2.50 Egret Egret Egret Egret Egret
2.75 Egret Egret Egret Egret Egret
3.00 Egret Egret Egret Egret Egret  

Cell P7, corresponding to the original assessments, has a border. The data table is 
dynamic, so the macro view may be refined near the base-case assessments by specifying 
different input values. 
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Figure 8 Fine Two-Factor Sensitivity Analysis of Weight Ratios 

1
2
3
4
5
6
7
8
9
10
11
12
13

L M N O P Q R
Two-Factor Sensitivity Analysis

Cost/Lifetime Weight Ratio
4.0 4.5 5.0 5.5 6.0

Cost/Safety 1.00 Cruiser Cruiser Cruiser Cruiser Cruiser
Weight 1.10 Cruiser Cruiser Cruiser Egret Egret
Ratio 1.20 Cruiser Egret Egret Egret Egret

1.30 Egret Egret Egret Egret Egret
1.40 Egret Egret Egret Egret Egret
1.50 Egret Egret Egret Egret Egret
1.60 Egret Egret Egret Egret Egret
1.70 Egret Egret Egret Egret Egret
1.80 Egret Egret Egret Egret Egret  

Figure 8 shows that the Cost/Safety weight ratio must be less than 1.2 to affect the 
choice. If the decision maker regards 1.2 as "far away" from 1.5, then the Egret choice is 
appropriate. Otherwise, the decision maker should think more carefully about the original 
assessments before making a choice based on this analysis. The assessment of the 
Cost/Lifetime weight ratio is not as critical, because any value between 4 and 6 yields the 
same choice. 

Swing Weight Assessment 
Compared to weight ratio assessment, the swing weight method requires assessments that 
are similar to directly assigning an overall utility to an alternative. However, the 
hypothetical alternatives requiring assessment in this method are constructed so that it 
should be easier for the decision maker to assign overall utilities to them instead of to the 
actual alternatives. 

The swing weight method involves four steps as shown in Figure 9. 

 1) Develop the hypothetical alternatives. The number of hypothetical alternatives 
equals the number of attributes plus one. The benchmark alternative in column J 
is worst for all attributes. Each other hypothetical alternative, shown in columns 
K, L, and M, has one attribute at best and all others at worst. 

 2) Rank the hypothetical alternatives, as shown in row 7. This is an intermediate 
step that facilitates assigning overall utilities. 

 3) Assign overall utility scores reflecting overall satisfaction for the hypothetical 
alternatives. The benchmark worst case has score zero, and the first-ranked 
alternative has score 100. Then assign level-of-satisfaction scores to the 
intermediate alternatives, as shown in cells L9 and M9. 
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 4) Sum the scores, as shown in cell N9. In the additive utility function, the weight 
for each attribute equals the score divided by sum of the scores. (The algebra 
solution, not shown here, is based on the special zero and one individual utility 
values of the hypothetical alternatives.) Formulas are shown in Figure 10. 

Figure 9 Hypothetical Alternatives and Weights for Swing Weight Assessment 

1
2
3
4
5
6
7
8
9
10
11
12
13

I J K L M N
Hypothetical Alternatives

Attribute Worst Best Cost Best Lifetime Best Safety
Cost $20 $10 $20 $20
Lifetime 6 6 10 6
Safety Low Low Low High

Rank 4 1 3 2
Total

Overall Score 0 100 20 70 190

Weight 0.000 0.526 0.105 0.368

Decision Maker's Inputs Underlined  

Figure 10 Formulas for Swing Weight Assessment 

1
2
3
4
5
6
7
8
9
10
11
12
13

I J K L M N

Attribute Worst Best Cost Best Lifetime Best Safety
Cost 20 10 20 20
Lifetime 6 6 10 6
Safety Low Low Low High

Rank 4 1 3 2
Total

Overall Score 0 100 20 70 =SUM(J9:M9)

Weight =J9/$N$9 =K9/$N$9 =L9/$N$9 =M9/$N$9

Hypothetical Alternatives

Decision Maker's Inputs Underlined  

The individual utility values are in a column, and the weights are in a row.  The 
SUMPRODUCT function requires that the two arrays for its arguments have the same 
orientation, so the TRANSPOSE function converts the weights into a column format, as 
shown in Figure 11. The function in B7 must be array-entered; after typing the function, 
hold down Control and Shift while you press Enter. 
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Figure 11 Formulas for Swing Weight Choice 

1
2
3
4
5
6
7
8
9

A B
Non-Dominated Alternatives

Attribute Alta
Cost 0
Lifetime 1
Safety 1

Overall =SUMPRODUCT(B3:B5,TRANSPOSE($K$11:$M$11))

Choice =INDEX(B2:G2,0,MATCH(MAX(B7:G7),B7:G7,0))  

Figure 12 Swing Weight Choice 

1
2
3
4
5
6
7
8
9

A B C D E F G
Non-Dominated Alternatives

Attribute Alta Bulldog Cruiser Delta Egret Fleet
Cost 0.000 0.200 0.400 0.600 0.800 1.000
Lifetime 1.000 1.000 0.500 0.500 0.000 0.000
Safety 1.000 0.667 1.000 0.667 0.667 0.000

Overall 0.474 0.456 0.632 0.614 0.667 0.526

Choice Egret  

Swing Weight Sensitivity Analysis 
The decision maker specified tradeoffs using overall scores for the hypothetical 
alternatives, so it is appropriate to see whether the choice is sensitive to changes in those 
assessed values. Figure 13 shows the sensitivity for the Best-Lifetime score that was 
specified as 20 relative to the worst-case benchmark and the highest-ranked Best-Cost 
hypothetical alternative. The Best-Lifetime alternative is still ranked 3 as long as its score 
is between 0 and 70.  

To improve the appearance of the sensitivity analysis tables in Figure 13, the output 
formula cells, R13 and T13, have a three-semicolon custom format.  
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Figure 13 Sensitivity Analysis of Swing Weight Best-Lifetime Score 

1
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14
15
16
17
18
19
20
21
22
23
24
25
26
27
28

P Q R S T U
Single-Factor Sensitivity Analysis

Best Lifetime Overall Score
Base case Score is 20
Rank 3 as long as Score is between 0 and 70

Output Formula in cell R13: =B9
Data Table Column Input Cell: M9

Detail
Best Lifetime Best Lifetime
Overall Score Choice Overall Score Choice

0 Egret 30 Egret
5 Egret 31 Egret

10 Egret 32 Egret
15 Egret 33 Egret

Base Case 20 Egret 34 Cruiser
25 Egret 35 Cruiser
30 Egret
35 Cruiser
40 Cruiser
45 Cruiser
50 Cruiser
55 Cruiser
60 Cruiser
65 Cruiser
70 Cruiser  

The results in the left table Figure 13, cells Q13:R28, indicate that the Best-Lifetime 
score must be greater than 30 to affect the choice. A refined data table in cells T13:U19 
shows that the score must be greater than 33 before the choice changes from Egret to 
Cruiser. If the decision maker regards 33 as "far away" from 20, then the Egret choice is 
appropriate. 

Figure 14 shows a similar sensitivity analysis for the Best-Safety score. The assessed 
score of 70  must be greater than 89 to affect the choice. 
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Figure 14 Sensitivity Analysis of Swing Weight Best-Safety Score 
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14
15
16
17
18
19
20
21
22
23
24
25
26
27
28
29
30

W X Y Z AA AB
Single-Factor Sensitivity Analysis

Best Safety Overall Score
Base case Score is 70
Rank 2 as long as Score is between 20 and 100

Output Formula in cell Y13 and cell AB13: =B9
Data Table Column Input Cell: N9

Detail
Best Safety Best Safety

Overall Score Choice Overall Score Choice

20 Fleet 85 Egret
25 Fleet 86 Egret
30 Fleet 87 Egret
35 Egret 88 Egret
40 Egret 89 Egret
45 Egret 90 Cruiser
50 Egret
55 Egret
60 Egret
65 Egret

Base Case 70 Egret
75 Egret
80 Egret
85 Egret
90 Cruiser
95 Cruiser

100 Cruiser  

To construct a two-way data table for sensitivity analysis of the swing weight 
assessments as shown in Figure 15, enter a set of values in a row, R4:V4, and another set 
of values in a column, Q5:Q13. In the top left cell of the data table, Q4, enter a formula 
for determining the data table's output values, =B9. (To improve the appearance of the 
table, cell Q4 is formatted with a custom three-semicolon format so that the formula 
result is not displayed.) Select Q4:V13. Choose Data | Table. In the Data Table dialog 
box, specify L9 as the Row Input Cell and M9 as the Column Input Cell. Click OK. 
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Figure 15 Sensitivity Analysis of Both Swing Weight Scores 

1
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P Q R S T U V
Two-Way Sensitivity Analysis

Best Lifetime Overall Score
10 15 20 25 30

Best 50 Egret Egret Egret Egret Egret
Safety 55 Egret Egret Egret Egret Egret
Overall 60 Egret Egret Egret Egret Egret
Score 65 Egret Egret Egret Egret Egret

70 Egret Egret Egret Egret Egret
75 Egret Egret Egret Egret Cruiser
80 Egret Egret Egret Egret Cruiser
85 Egret Egret Egret Cruiser Cruiser
90 Egret Egret Cruiser Cruiser Cruiser  

The table shows that the choice changes from Egret to Cruiser if the combination of 
assessments is changed from 20 & 70 to 30 & 75. This table could be refined to examine 
the exact threshold values. 

Direct Weight Assessment and Sensitivity Analysis 
In some situations the decision maker may be able to assign tradeoff weights directly. 
Figure 16 shows results using the formulas shown in Figure 17. 

Figure 16 Direct Weight Assessment 

1
2
3
4
5
6
7
8
9

A B C D E F G H I J
Non-Dominated Alternatives Weights

Attribute Alta Bulldog Cruiser Delta Egret Fleet Cost 0.500
Cost 0.000 0.200 0.400 0.600 0.800 1.000 Lifetime 0.100
Lifetime 1.000 1.000 0.500 0.500 0.000 0.000 Safety 0.400
Safety 1.000 0.667 1.000 0.667 0.667 0.000

Overall 0.500 0.467 0.650 0.617 0.667 0.500

Choice Egret  

The formula in cell B9 includes an IF function to verify that each weight is between 0 
and 1, inclusive, and that the sum of the weights equals one. If not, the formula returns 
empty text. This formula must be array-entered; after typing the function, hold down 
Control and Shift while you press Enter. 
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Figure 17 Formulas for Direct Weight Assessment 

1
2
3
4
5
6
7
8
9

A B H I J
Non-Dominated Alternatives Weights

Attribute Alta Cost 0.5
Cost 0 Lifetime 0.1
Lifetime 1 Safety =1-J3-J2
Safety 1

Overall =SUMPRODUCT(B3:B5,$J$2:$J$4)

Choice =IF(AND(SUM(J2:J4)<=1,J2:J4>=0),INDEX(B2:G2,0,MATCH(MAX(B7:G7),B7:G7,0)),"")  

Figure 18 shows a two-way table for sensitivity analysis of the weights. Cell R5 
corresponds to the approximate base case assessments in the weight ratio and swing 
weight methods.  

Figure 18 Sensitivity Analysis of Direct Weight Assessment 

1
2
3
4
5
6
7
8
9

10
11
12
13

L M N O P Q R S T U V
Two-Factor Sensitivity Analysis

Cost Weight
0.1 0.2 0.3 0.4 0.5 0.6 0.7 0.8 0.9

Lifetime 0.1 Alta Cruiser Cruiser Cruiser Egret Egret Fleet Fleet Fleet
Weight 0.2 Alta Alta Cruiser Cruiser Cruiser Egret Fleet Fleet

0.3 Alta Alta Alta Cruiser Delta Fleet Fleet
0.4 Alta Alta Alta Bulldog Bulldog Fleet
0.5 Alta Alta Alta Bulldog Bulldog
0.6 Alta Alta Bulldog Bulldog
0.7 Alta Bulldog Bulldog
0.8 Alta Bulldog
0.9 Bulldog  

Figure 19 is a more detailed view. The choice formula in cell B9 is modified by placing 
the INDEX function inside the LEFT function so that only the first letter of the 
alternative's name is returned.  



5.3 Sensitivity Analysis Methods     117 

Figure 19 Detailed Sensitivity Analysis of Direct Weight Assessment 

1
2
3
4
5
6
7
8
9

10
11
12
13
14
15
16
17
18
19
20
21
22
23
24
25

L M N O P Q R S T U V W X Y Z AA AB AC AD AE AF AG AH
Two-Factor Sensitivity Analysis

Cost Weight
0.00 0.05 0.10 0.15 0.20 0.25 0.30 0.35 0.40 0.45 0.50 0.55 0.60 0.65 0.70 0.75 0.80 0.85 0.90 0.95 1.00

Lifetime 0.00 A C C C C C C C C C E E E E E E F F F F F
Weight 0.05 A A C C C C C C C C E E E E E F F F F F

0.10 A A A C C C C C C C E E E E F F F F F
0.15 A A A A C C C C C C E E E E F F F F
0.20 A A A A A A C C C C C E E F F F F
0.25 A A A A A A A C C C D D F F F F
0.30 A A A A A A A A C D D D F F F
0.35 A A A A A A A A A D D D F F
0.40 A A A A A A A A B B B D F
0.45 A A A A A A A B B B B B
0.50 A A A A A A A B B B B
0.55 A A A A A A B B B B
0.60 A A A A A A B B B
0.65 A A A A A B B B
0.70 A A A A B B B
0.75 A A A A B B
0.80 A A A B B
0.85 A A B B
0.90 A A B
0.95 A B
1.00 A  

The results in Figure 19 show that all alternatives in this data set are candidates 
depending on the tradeoffs specified by the decision maker. In general, moving left to 
right, if more weight is given to cost, a less expensive alternative is chosen. 

Summary 
This paper considered three methods for assessing tradeoffs in the additive utility 
function. For each method sensitivity analysis is useful for gaining insight into which 
tradeoff assumptions are critical. Kirkwood [2] includes Excel VBA methods for 
sensitivity analysis of individual utility functions in addition to weights. 

Sensitivity Analysis Examples References 
 [1] Clemen, R.T. Making Hard Decisions: An Introduction to Decision Analysis, 

2nd Edition. Duxbury Press, 1996. 

 [2] Kirkwood, C.W. Strategic Decision Making: Multiobjective Decision Analysis 
with Spreadsheets. Duxbury Press, 1997. 

 [3] Hammond, J.S., Keeney, R.L., and Raiffa, H. Smart Choices: A Practical Guide 
to Making Better Decisions. Harvard Business School Press, 1999. 
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Screenshots from Excel to Word 
To copy Excel displays for the figures in this paper, choose File | Page Setup | Sheet | 
Gridlines and File | Page Setup | Sheet | Row And Column Headings. Select the cell 
range, hold down the Shift key, and in Excel's main menu choose Edit | Copy Picture | As 
Shown When Printed. In Word, position the pointer in an empty paragraph and choose 
Edit | Paste. 

 



 

Product Mix Optimization 6 
 

6.1 LINEAR PROGRAMMING CONCEPTS 

Formulation 
 Decision variables  (Excel Solver “Changing Cells”) 

 Objective function  (“Target Cell”) 

 Constraints and right-hand-side values  (“Constraints”) 

 Non-negativity constraints  (“Constraints”) 

Graphical Solution 
 Constraints 

 Feasible region 

 Corner points (extreme points) 

 Objective function value at each corner point 

 Total enumeration vs. simplex algorithm (search) 

 Optimal solution 

Sensitivity Analysis 
Post-optimality analysis and interpretation of computer print-outs 

Shadow price (a marginal value) 

  (Excel Solver Sensitivity Report, Constraints section, “Shadow Price”) 

  The shadow price for a particular constraint is the amount of change in the value 
of the objective function corresponding to a unit change in the right-hand-side 
value of the constraint. 
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Range on a right-hand-side (RHS) value 

  (Excel Solver Sensitivity Report, Constraints section, “Allowable 
Increase/Decrease”) 

  Range over which the shadow price applies.  The optimal values of the decision 
variables would change depending on the exact RHS value, but the current mix 
of decision variables remains optimal over the specified range of RHS values. 

Range on an objective function coefficient 

  (Excel Solver Sensitivity Report, Changing Cells section, “Allowable 
Increase/Decrease”) 

  Range over which an objective function coefficient could change with the 
current optimal solution remaining optimal (same mix and values of decision 
variables).  The value of the objective function would change depending on the 
exact value of the objective function coefficient. 

Simplex algorithm terminology 

 Slack, surplus, and artificial variables 

 Basic variables (variables "in the solution," typically with non-zero values) 

 Non-basic variables (value equal to zero) 

 Complementary slackness 
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6.2 BASIC PRODUCT MIX PROBLEM 

Figure 6.1 Display 

1
2
3
4
5
6
7
8
9
10
11
12
13
14
15
16

A B C D E F G
Small Example 1:  Product mix problem
Your company manufactures TVs and stereos, using a common parts inventory
of power supplies, speaker cones, etc.  Parts are in limited supply and you must
determine the most profitable mix of products to build.

TV set Stereo RHS
Number to Build-> 250 100 Used Available Slack

Part Name Chassis 1 1 350 450 100
Picture Tube 1 0 250 250 0
Speaker Cone 2 2 700 800 100
Power Supply 1 1 350 450 100
Electronics 2 1 600 600 0

Profit
Per Unit $75 $50

By Product $18,750 $5,000
Total $23,750  

Figure 6.2 Formulas 

1
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16

A B C D E F G
Small Example 1:  Product mix problem
Your company manufactures TVs and stereos, using a common parts inventory
of power supplies, speaker cones, etc.  Parts are in limited supply and you must
determine the most profitable mix of products to build.

TV set Stereo RHS
Number to Build-> 250 100 Used Available Slack

Part Name Chassis 1 1 =SUMPRODUCT($C$7:$D$7,C8:D8) 450 =F8-E8
Picture Tube 1 0 =SUMPRODUCT($C$7:$D$7,C9:D9) 250 =F9-E9
Speaker Cone 2 2 =SUMPRODUCT($C$7:$D$7,C10:D10) 800 =F10-E10
Power Supply 1 1 =SUMPRODUCT($C$7:$D$7,C11:D11) 450 =F11-E11
Electronics 2 1 =SUMPRODUCT($C$7:$D$7,C12:D12) 600 =F12-E12

Profit
Per Unit $75 $50

By Product =C14*C7 =D14*D7
Total =SUMPRODUCT(C7:D7,C14:D14)  
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Figure 6.3 Graphical Solution 
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Figure 6.4 Solver Solution 
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Figure 6.5 Solver Answer Report 

Target Cell (Max)
Cell Name Original Value Final Value

$C$16 Total  Profit $23,750 $25,000

Adjustable Cells
Cell Name Original Value Final Value

$C$7 Number to Build-> TV set 250 200
$D$7 Number to Build-> Stereo 100 200

Constraints
Cell Name Cell Value Formula Status Slack

$E$8 Chassis Used 400 $E$8<=$F$8 Not Binding 50
$E$9 Picture Tube Used 200 $E$9<=$F$9 Not Binding 50
$E$10 Speaker Cone Used 800 $E$10<=$F$10 Binding 0
$E$11 Power Supply Used 400 $E$11<=$F$11 Not Binding 50
$E$12 Electronics Used 600 $E$12<=$F$12 Binding 0  

Figure 6.6 Solver Sensitivity Report 

Adjustable Cells
Final Reduced Objective Allowable Allowable

Cell Name Value Cost Coefficient Increase Decrease
$C$7 Number to Build-> TV set 200 $0.00 $75.00 $25.00 $25.00
$D$7 Number to Build-> Stereo 200 $0.00 $50.00 $25.00 $12.50

Constraints
Final Shadow Constraint Allowable Allowable

Cell Name Value Price R.H. Side Increase Decrease
$E$8 Chassis Used 400 $0.00 450 1E+30 50
$E$9 Picture Tube Used 200 $0.00 250 1E+30 50
$E$10 Speaker Cone Used 800 $12.50 800 100 100
$E$11 Power Supply Used 400 $0.00 450 1E+30 50
$E$12 Electronics Used 600 $25.00 600 50 200  
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Figure 6.7 Solver Limits Report 

Target
Cell Name Value

$C$16 Total  Profit $25,000

Adjustable Lower Target Upper Target
Cell Name Value Limit Result Limit Result

$C$7 Number to Build-> TV set 200 0 $10,000 200 $25,000
$D$7 Number to Build-> Stereo 200 0 $15,000 200 $25,000  

6.3 OUTDOORS PROBLEM 
Outdoors, Inc., has lawn furniture as one of its product lines.  They currently have three 
items in that line:  a lawn chair, a standard bench, and a table.  These products are 
produced in a two-step manufacturing process involving the tube bending department and 
the welding department.  The hours required by each item in each department is as 
follows: 
 
    Product    
 Department  Chair Bench Table Present Capacity 
 Bending   1.2  1.7  1.2 1,000 hours 
 Welding   0.8  0.0  2.3 1,200 hours 

The profit contribution that Outdoors receives from manufacture and sale of one unit of 
each product is $3 for a chair, $3 for a bench, and $5 for a table. 

The company is trying to plan its production mix for the current selling season.  They feel 
that they can sell any number they produce, but unfortunately production is further 
limited by available material because of a prolonged strike.  The company currently has 
on hand 2,000 pounds of tubing.  The three products require the following amounts of 
this tubing:  2 pounds per chair, 3 pounds per bench, and 4.5 pounds per table. 

In order to determine the optimal product mix, the production manager has formulated 
the linear programming problem as shown below. 
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    Product      
   Chair Bench Table     
 Contribution  $3 $3 $5     
          
 Constraint      Relation  Limit 
 Bending  1.2 1.7 1.2   <=  1,000 
 Welding  0.8 0.0 2.3   <=  1,200 
 Tubing  2.0 3.0 4.5   <=  2,000 
 

 A. The inventory manager suggests that the company produce 200 units of each 
product.  Is the plan to produce 200 units of each product a feasible plan, i.e., 
does it satisfy all contraints?  If not, which constraints are not satisfied? 

 B. If the company produces 200 chairs, 200 benches, and 200 tables, how much 
tubing, if any, will be left over? 

Each of the following questions refer to the solution of the original linear programming 
problem. 

 C. A local manufacturing firm has excess capacity in its welding department and 
has offered to sell 100 hours of welding time to Outdoors for $3 per hour.  This 
arrangement would cost $300 and would increase welding capacity from 1,200 
hours to 1,300 hours.  Should Outdoors purchase the additional welding 
capacity?  Why or why not? 

 D. The marketing manager thinks that the original estimate of $3 profit contribution 
per chair should be changed to $2.50 per chair.  Should the production manager 
solve the linear programming problem again using the $2.50 value, or should 
Outdoors go ahead with the plan to produce 700 chairs, zero benches, and 133 
tables?  Why or why not? 

 E. A local metal products distributor has offered to sell Outdoors some additional 
metal tubing for 60 cents per pound.  Should Outdoors buy additional tubing at 
this price?  If so, how much would their contribution increase if they bought 500 
pounds and used it in an optimal fashion? 

 F. The R&D department has been redesigning the bench to make it more 
profitable.  The new design will require 1.1 hours of tube bending time, 2 hours 
of welding time, and 2.0 pounds of metal tubing.  If they can sell one unit of this 
bench with a unit contribution of $3, what effect will it have on overall 
contribution? 

 G. Marketing has suggested a new patio awning that would require 1.8 hours of 
tube bending time, 0.5 hours of welding time, and 1.3 pounds of metal tubing.  
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What contribution must this new product have to make it attractive to produce 
this season? 

 H. Outdoors, Inc., has a chance to sell some of its capacity in tube bending at a 
price of $1.50 per hour.  If it sells 200 hours at that price, how will this affect 
contribution? 

 I. If Outdoors, Inc., feels that it must produce benches to round out its production 
line, what effect will production of benches have on overall contribution? 

Adapted from Vatter et al., Quantitative Methods in Management, Irwin, 1978. 

Spreadsheet Model 

Figure 6.8 Model 
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A B C D E F G H
Outdoors, Inc.

Chair Bench Table
Number to Build-> 100 100 100 Used Available Slack

Resource Tube Bending 1.2 1.7 1.2 410 1000 590
Welding 0.8 0 2.3 310 1200 890
Tubing 2 3 4.5 950 2000 1050

Profits Per Unit $3 $3 $5
By Product $300 $300 $500

Total $1,100  

Figure 6.9 Formulas 

1
2
3
4
5
6
7
8
9

A B C D E F G H
Outdoors, Inc.

Chair Bench Table
Number to Build-> 100 100 100 Used Available Slack

Resource Tube Bending 1.2 1.7 1.2 =SUMPRODUCT(C$3:E$3,C4:E4) 1000 =G4-F4
Welding 0.8 0 2.3 =SUMPRODUCT(C$3:E$3,C5:E5) 1200 =G5-F5
Tubing 2 3 4.5 =SUMPRODUCT(C$3:E$3,C6:E6) 2000 =G6-F6

Profits Per Unit 3 3 5
By Product =C7*C3 =D7*D3 =E7*E3

Total =SUMPRODUCT(C3:E3,C7:E7)  
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Figure 6.10 Solution 
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A B C D E F G H
Outdoors, Inc.

Chair Bench Table
Number to Build-> 700 0 133.33 Used Available Slack

Resource Tube Bending 1.2 1.7 1.2 1000 1000 0
Welding 0.8 0.0 2.3 866.67 1200 333.33
Tubing 2.0 3.0 4.5 2000 2000 0

Profits Per Unit $3 $3 $5
By Product $2,100.00 $0.00 $666.67

Total $2,766.67  

Solver Reports 

Figure 6.11 Answer Report 

Target Cell (Max)
Cell Name Original Value Final Value

$C$9 Total  Chair $1,100 $2,767

Adjustable Cells
Cell Name Original Value Final Value

$C$3 Number to Build-> Chair 100 700
$D$3 Number to Build-> Bench 100 0
$E$3 Number to Build-> Table 100 133.33

Constraints
Cell Name Cell Value Formula Status Slack

$F$4 Tube Bending Used 1000 $F$4<=$G$4 Binding 0
$F$5 Welding Used 866.67 $F$5<=$G$5 Not Binding 333.33
$F$6 Tubing Used 2000 $F$6<=$G$6 Binding 0  
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Figure 6.12 Sensitivity Report 

Adjustable Cells
Final Reduced Objective Allowable Allowable

Cell Name Value Cost Coefficient Increase Decrease
$C$3 Number to Build-> Chair 700 $0.00 $3.00 $2.00 $0.778
$D$3 Number to Build-> Bench 0 -$1.383 $3.00 $1.383 1E+30
$E$3 Number to Build-> Table 133 $0.00 $5.00 $1.75 $2.00

Constraints
Final Shadow Constraint Allowable Allowable

Cell Name Value Price R.H. Side Increase Decrease
$F$4 Tube Bending Used 1000 $1.167 1000 200 466.67
$F$5 Welding Used 866.67 $0.00 1200 1E+30 333.33
$F$6 Tubing Used 2000 $0.80 2000 555.56 333.33  
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7.1 DISCRETE UNCERTAIN QUANTITIES 
Discrete UQ: a few, distinct values 

Assign probability mass to each value (probability mass function). 

Contrast discrete UQs with continuous UQs. Continuous UQs have an infinite number of 
values or so many distinct values that it is difficult to assign probability to each value. 
Instead, for a continuous UQ we assign probability only to ranges of values. 

7.2 CONTINUOUS UNCERTAIN QUANTITIES 
Probability Density Functions and Cumulative Probability for Continuous Uncertain 
Quantities 

The total area under a probability density function equals one. 

A portion of the area under a density function is a probability. 

The height of a density function is not a probability. 

The simplest probability density function is the uniform density function. 

Case A: Uniform Density 
The number of units of a new product that will be sold is an uncertain quantity. 

 What is the minimum quantity? “1000 units” 

 What is the maximum quantity? “5000 units” 

 Are any values in the range between 1000 and 5000 more likely than others?
 “No” 

Represent the uncertainty using a uniform density function. 
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Technical point:  For a continuous UQ, P(X=x) = 0. 

For a continuous UQ, probability is non-zero only for a range of values. 

For convenience in computation and assessment, we may use a continuous UQ to 
approximate a discrete UQ, and vice versa. 

In Figure 1, the range of values is 5000 – 1000 = 4000, which is the width of the total 
area under the uniform (rectangular) density function. The area of a rectangle is Width * 
Height = Area, and the area under the uniform density function in Figure 1 must equal 1.  
So, Height = Area / Base.  Here the Base is 5000 – 1000 = 4000 units.  Therefore, Height 
= 1/4000 = 0.00025. 

Figure 7.1 Uniform Density Function 
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Figure 7.2 Figure 2 

Cumulative Probability for Uniform Density
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Both probability mass functions (for discrete UQs) and probability density functions (for 
continuous UQs) have corresponding cumulative probability functions. 

It is important to understand the relationship between a density function and its 
cumulative probability function. 

Cumulative probability can be expressed in four ways: 

P(X<=x)  probability that UQ X is 
less than or equal to x 

inclusive left -tail 

P(X<x)  probability that UQ X is 
strictly less than x 

exclusive left -tail 

P(X>=x)  probability that UQ X is 
greater than or equal to x 

inclusive right -tail 

P(X>x)  probability that UQ X is 
strictly greater than x 

exclusive right -tail 

For continuous UQs the cumulative probability is the same for inclusive and exclusive. 

P(X<=x) is the most common type. 
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Figure 2 is the cumulative probability function corresponding to the uniform density 
function shown in Figure 1. 

What is the probability that sales will be between 3,500 and 4,000 units? 

P(3500<=X<=4000) = 0.125 

P(3500<=X<=4000) = P(X<=4000) – P(X<=3500) = 0.750 – 0.625 = 0.125 

Mathematical observation:  The uniform density function is a constant; the corresponding 
cumulative function (the integral of the constant function) is linear. 

Case B: Ramp Density 
The number of units of a new product that will be sold is an uncertain quantity. 

 What is the minimum quantity? “1000 units” 

 What is the maximum quantity? “5000 units” 

 Are any values in the range between 1000 and 5000 more likely than others? 

 “Yes, values close to 5000 are much more likely than values close to 1000.” 

Represent the uncertainty using a ramp density function. 

The area of a triangle is Base * Height / 2, and the area under the ramp density function 
in Figure 3 must equal 1.  So, Height = 2 / Base.  Here, the Base is 5000 – 1000 = 4000 
units.  Therefore, Height = 2 / 4000 = 0.0005. 
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Figure 7.3 Figure 3 

Ramp Density Function
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Figure 7.4 Figure 4 

Cumulative Probability for Ramp Density
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An important observation is that flatter portions of a cumulative probability function 
correspond to ranges with low probability. Steeper portions of a cumulative probability 
function correspond to ranges with high probability. 

What is the probability that sales will be between 3,500 and 4,000 units? 

P(3500<=X<=4000) = 0.171875 

P(3500<=X<=4000) = P(X<=4000) – P(X<=3500) = 0.562500 – 0.390625 = 0.171875 

The ramp density may not be appropriate for describing uncertainty in many situations, 
but it is an important building block for the extremely useful triangular density function. 

Mathematical observation:  The ramp density function is linear; the corresponding 
cumulative function (the integral of the linear function) is quadratic. 

Case C: Triangular Density 
The number of units of a new product that will be sold is an uncertain quantity. 

 What is the minimum quantity? “1000 units” 

 What is the maximum quantity? “5000 units” 

 Are any values in the range between 1000 and 5000 more likely than others? 

 “Yes, values close to 4000 are more likely.” 

Represent the uncertainty using a triangular density function. 

The area of a triangle is Base * Height / 2, and the area under the triangular density 
function in Figure 5 must equal 1.  So, Height = 2 / Base.  Here, the Base is 5000 – 1000 
= 4000 units.  Thus, Height = 2 / 4000 = 0.0005. 
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Figure 7.5 Figure 5 

Triangular Density Function
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Figure 7.6 Figure 6 

Cumulative Probability for Triangular Density
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Again, an important observation is that flatter portions of a cumulative probability 
function correspond to ranges with low probability (the range close to 1000 and the range 
close to 5000 in Figure 6). Steeper portions of a cumulative probability function 
correspond to ranges with high probability (the range close to 4000). 

What is the probability that sales will be between 3,500 and 4,000 units? 

P(3500<=X<=4000) = 0.229167 

P(3500<=X<=4000) = P(X<=4000) – P(X<=3500) = 0.750000 – 0.520833 = 0.229167 

The triangular density function is extremely useful for describing uncertainty in many 
situations. It requires only three inputs:  minimum, mode (most likely value), and 
maximum. 

Mathematical observation:  The triangular density function has two linear segments, i.e., 
piecewise linear; the corresponding cumulative function (the integral of each linear 
function) is two quadratic segments, i.e., piecewise quadratic. 

 



 

Simulation Without 
Add-Ins  8 
 

8.1 SIMULATION USING EXCEL FUNCTIONS 

Figure 8.1 Display 

1
2
3
4
5
6
7
8
9

A B C D E F G
Software Decision Analysis

RAND()
Unit Price $29
Units Sold 661 0.3502 Normal Mean = 700, StDev = 100
Unit Variable Cost $10.92 0.9832 Uniform Min = $6, Max = $11
Fixed Costs $12,000 0.7364 Discrete Value Probability Cumulative

$10,000 0.25 0.25
Net Cash Flow -$47 $12,000 0.50 0.75

$15,000 0.25 1.00  

Figure 8.2 Formulas 

1
2
3
4
5
6
7
8
9

A B C D E F G
Software Decision Analysis

RAND()
Unit Price 29
Units Sold =INT(NORMINV(C4,700,100)) =RAND() Normal Mean = 700, StDev = 100
Unit Variable Cost =6+5*C5 =RAND() Uniform Min = $6, Max = $11
Fixed Costs =IF(C6<0.25,10000,IF(C6<0.75,12000,15000)) =RAND() Discrete Value Probability Cumulative

10000 0.25 0.25
Net Cash Flow =B4*(B3-B5)-B6 12000 0.5 0.75

15000 0.25 1  
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Multiperiod What-If 
Modeling  9 
 

9.1 APARTMENT BUILDING PURCHASE PROBLEM 
You are considering the purchase of an apartment building in northern California. The 
building contains 25 units and is listed for $2,000,000. You plan to keep the building for 
three years and then sell it. 

You know that the annual taxes on the property are currently $20,000 and will increase to 
$25,000 after closing. You estimate that these taxes will grow at a rate of 2 percent per 
year. You estimate that it will cost about $1,000 per unit per year to maintain the 
apartments, and these maintenance costs are expected to grow at a 15 percent per year 
rate. 

You have not decided on the rent to charge. Currently, the rent is $875 per unit per 
month, but there is substantial turnover, and the occupancy is only 75 percent. That is, on 
average, 75 percent of the units are rented at any time. You estimate that if you lowered 
the rent to $675 per unit per month, you would have 100 percent occupancy. You think 
that intermediate rental charges would produce intermediate occupancy percentages; for 
example, a $775 rental charge would have 87.5 percent occupancy. 

You will decide on the monthly rental charge for the first year, and you think the rental 
market is such that you will be able to increase it 7 percent per year for the second and 
third years. Furthermore, whatever occupancy percentage occurs in the first year will 
hold for the second and third years. For example, if you decide on the $675 monthly 
rental charge for the first year, the occupancy will be 100 percent all three years. 

At the end of three years, you will sell the apartment building. The realtors in your area 
usually estimate the selling price of a rental property as a multiple of its annual rental 
income (before expenses). You estimate that this multiple will be 9. That is, if the rental 
income in the third year is $200,000, then the sale price will be $1,800,000. 

Your objective is to achieve the highest total accumulated cash at the end of the three 
year period. If rental income exceeds expenses in the first or second years, you will invest 
the excess in one-year certificates of deposits (CDs) yielding 5 percent. Thus, total 
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accumulated cash will include net cash flow (income minus expense) in each of the three 
years, interest from CDs received at the end of the second and third years, and cash from 
the sale of the property at the end of the third year. 

In your initial analysis you have decided to ignore depreciation and other issues related to 
income taxes. 

Instead of purchasing the apartment building, you could invest the entire $2,000,000 in 
certificates of deposits yielding 5 percent per year. 
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Figure 9.1 Base Case Model Display 
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A B C D E F
Apartment Building Purchase Monthly Rent Occupancy

$675 100
Controllable Factors $775 87.5
Unit monthly rent $775 $875 75
Uncertain Factors
Annual unit maintenance $1,000 slope -0.125
Annual maint. increase 15% intercept 184.375
Annual tax increase 2.0%
Gross rent multiplier 9.00
Other Assumptions
First year property taxes $25,000
Annual rent increase 7%
CD annual yield 5%
Intermediate variable
Occupancy percentage 87.50%
Performance measure
Final cash value $2,610,848

One Two Three
Unit monthly rent $775 $829 $887
Annual rental income $203,438 $217,678 $232,916

Annual maintenance cost $25,000 $28,750 $33,063
Annual property tax $25,000 $25,500 $26,010
Total annual expenses $50,000 $54,250 $59,073

Operating cash flow $153,438 $163,428 $173,843

CD investment $153,438 $324,538
Year-end CD interest $7,672 $16,227

Sale receipt $2,096,240

Final Cash Value $2,610,848

CD investment $2,000,000 $2,100,000 $2,205,000
Year-end CD interest $100,000 $105,000 $110,250
Final Cash Value $2,315,250  
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Figure 9.2 Base Case Model Formulas 
1
2
3
4
5
6
7
8
9

10
11
12
13
14
15
16
17
18
19
20
21
22
23
24
25
26
27
28
29
30
31
32
33
34
35
36
37
38

A B C D E F
Apartment Building Purchase Monthly Rent Occupancy

675 100
Controllable Factors 775 87.5
Unit monthly rent 775 875 75
Uncertain Factors
Annual unit maintenance 1000 slope =SLOPE(F2:F4,E2:E4)
Annual maint. increase 0.15 intercept =INTERCEPT(F2:F4,E2:E4)
Annual tax increase 0.02
Gross rent multiplier 9
Other Assumptions
First year property taxes 25000
Annual rent increase 0.07
CD annual yield 0.05
Intermediate variable
Occupancy percentage =(F7+F6*B4)/100
Performance measure
Final cash value =D34

One Two Three
Unit monthly rent =B4 =B20*(1+$B$12) =C20*(1+$B$12)
Annual rental income =B20*25*$B$15*12 =C20*25*$B$15*12 =D20*25*$B$15*12

Annual maintenance cost =B6*25 =(1+$B$7)*B23 =(1+$B$7)*C23
Annual property tax =B11 =(1+$B$8)*B24 =(1+$B$8)*C24
Total annual expenses =SUM(B23:B24) =SUM(C23:C24) =SUM(D23:D24)

Operating cash flow =B21-B25 =C21-C25 =D21-D25

CD investment =B27 =C27+C29+C30
Year-end CD interest =B13*C29 =B13*D29

Sale receipt =D21*B9

Final Cash Value =SUM(D27:D32)

CD investment 2000000 =B36+B37 =C36+C37
Year-end CD interest =B13*B36 =B13*C36 =B13*D36
Final Cash Value =D36+D37  

Figure 9.3 Ranges based on decision maker’s or expert’s judgment 

Uncertain Factors Low Base High
Annual unit maintenance $700 $1,000 $2,000
Annual maint. increase 10% 15% 30%
Annual tax increase 2.0% 2.0% 3.0%
Gross rent multiplier 7.00 9.00 10.00  

Apartment Building Analysis Notes 
Influence Diagram (for single period) 

Modeling effect of rent on occupancy rate 

 Linear fit: algebra (slope and intercept) 

   XY Scatter chart;  Insert Trendline 

 Quadratic fit: if $775 yields 82.5% occupancy instead of 87.5% 
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Base Case model 

 Use Solver to find optimum rent to maximize final cash value 

 Use Sensit.xla Plot of final cash value depending on rent;  relatively insensitive 

 Use Sensit.xla Spider 

Sensitivity Cases 

 Ranges based on decision maker’s or expert’s judgment 

 Sensit.xla Tornado chart:  identify critical variables 

Monte Carlo simulation 

 RiskSim.xla 

 Triangular distributions for critical variables 

 What is probability that final cash will be less than $2,315,250? 

9.2 PRODUCT LAUNCH FINANCIAL MODEL 

Figure 9.4 Original Model Display 
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A B C D E F G H I J K L 
 FINANCE   The @RISK Demonstration Model : 
Product Launch Risk Analysis  2001-2010  

2001 2002 2003 2004 2005 2006 2007 2008 2009 2010 
======== ======== ======== ======== ======== ======== ======== ======== ======== ======== 

Price No Entry $70.00 $88.20 $119.00 $112.70 $99.40 $94.50 $91.70 $90.30 
Price With Entry $53.00 $67.31 $79.50 $63.60 $60.95 $55.65 $54.59 $51.94 
Volume No Entry 3500 4340 6580 5565 5180 5180 4970 4935 
Volume With Entry 

   3300 4158 3564 3399 3300 3300 3432 3696 
Competitor Entry: 1 
Design Costs $50,000.00 
Capital Investment $100,000.00
Operating Expense Factor 0.15 0.15 0.15 0.15 0.15 0.15 0.15 0.15 
Sales Price $53.00 $67.31 $79.50 $63.60 $60.95 $55.65 $54.59 $51.94 
Sales Volume 3300 4158 3564 3399 3300 3300 3432 3696 
Sales Revenue $174,900 $279,875 $283,338 $216,176 $201,135 $183,645 $187,353 $191,970 
Unit Production Cost $23.33 $24.26 $25.23 $26.24 $27.29 $28.38 $29.52 $30.70 
Overhead $3,300 $6,944 $10,528 $8,904 $8,288 $8,288 $7,952 $7,896 
Cost of Goods Sold $80,289 $107,830 $100,461 $98,104 $98,354 $101,957 $109,264 $121,366 
Gross Margin $94,611 $172,045 $182,877 $118,072 $102,781 $81,688 $78,089 $70,604 
Operating Expense $12,043 $16,175 $15,069 $14,716 $14,753 $15,294 $16,390 $18,205 
Net Before Tax ($50,000) $0 $82,568 $155,870 $167,808 $103,357 $88,028 $66,395 $61,699 $52,400 
Depreciation $20,000 $20,000 $20,000 $20,000 $20,000
Tax ($23,000) ($9,200) $28,781 $62,500 $67,992 $38,344 $40,493 $30,542 $28,382 $24,104 
Taxes Owed $0 $0 $0 $59,081 $67,992 $38,344 $40,493 $30,542 $28,382 $24,104 
Net After Tax ($50,000) $0 $82,568 $96,789 $99,816 $65,013 $47,535 $35,853 $33,317 $28,296 

======== ======== ======== ======== ======== ======== ======== ======== ======== ======== 
Net Cash Flow ($50,000) ($100,000) $82,568 $96,789 $99,816 $65,013 $47,535 $35,853 $33,317 $28,296 
NPV 10% $164,877 
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Figure 9.5 Input Assumptions 
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A B C D E F G H I J K L

 FINANCE   The @RISK Demonstration Model :
Product Launch Risk Analysis  2001-2010 

2001 2002 2003 2004 2005 2006 2007 2008 2009 2010
======== ======== ======== ======== ======== ======== ======== ======== ======== ========

Price No Entry $70.00 $88.20 $119.00 $112.70 $99.40 $94.50 $91.70 $90.30
Price With Entry $53.00 $67.31 $79.50 $63.60 $60.95 $55.65 $54.59 $51.94
Volume No Entry 3500 4340 6580 5565 5180 5180 4970 4935
Volume With Entry   3300 4158 3564 3399 3300 3300 3432 3696
Competitor Entry: 1

Design Costs $50,000.00
Capital Investment $100,000.00
Operating Expense Factor 0.15 0.15 0.15 0.15 0.15 0.15 0.15 0.15

Sales Price $53.00 $67.31 $79.50 $63.60 $60.95 $55.65 $54.59 $51.94
Sales Volume 3300 4158 3564 3399 3300 3300 3432 3696
Sales Revenue $174,900 $279,875 $283,338 $216,176 $201,135 $183,645 $187,353 $191,970
Unit Production Cost $23.33 $24.26 $25.23 $26.24 $27.29 $28.38 $29.52 $30.70
Overhead $3,300 $6,944 $10,528 $8,904 $8,288 $8,288 $7,952 $7,896
Cost of Goods Sold $80,289 $107,830 $100,461 $98,104 $98,354 $101,957 $109,264 $121,366
Gross Margin $94,611 $172,045 $182,877 $118,072 $102,781 $81,688 $78,089 $70,604
Operating Expense $12,043 $16,175 $15,069 $14,716 $14,753 $15,294 $16,390 $18,205
Net Before Tax ($50,000) $0 $82,568 $155,870 $167,808 $103,357 $88,028 $66,395 $61,699 $52,400
Depreciation $20,000 $20,000 $20,000 $20,000 $20,000
Tax ($23,000) ($9,200) $28,781 $62,500 $67,992 $38,344 $40,493 $30,542 $28,382 $24,104
Taxes Owed $0 $0 $0 $59,081 $67,992 $38,344 $40,493 $30,542 $28,382 $24,104
Net After Tax ($50,000) $0 $82,568 $96,789 $99,816 $65,013 $47,535 $35,853 $33,317 $28,296

======== ======== ======== ======== ======== ======== ======== ======== ======== ========
Net Cash Flow ($50,000) ($100,000) $82,568 $96,789 $99,816 $65,013 $47,535 $35,853 $33,317 $28,296
NPV 10% $164,877
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A B C D E F G H I J K L
Inputs

Price w/ o Entry $70.00
Price w/  Entry $53.00
Volume No Entry 3,500
Volume w/  Entry 3,300
Competitor Entry 1
Design Costs $50,000
Capital Investment $100,000
Operating Expense Factor 15.0%
Unit Production Costs 23.33
Overhead $3,300

 FINANCE   The @RISK Demonstration Model :
Product Launch Risk Analysis  2001-2010 

2001 2002 2003 2004 2005 2006 2007 2008 2009 2010
======== ======== ======== ======== ======== ======== ======== ======== ======== ========

Price No Entry $70.00 $88.20 $119.00 $112.70 $99.40 $94.50 $91.70 $90.30
Price With Entry $53.00 $67.31 $79.50 $63.60 $60.95 $55.65 $54.59 $51.94
Volume No Entry 3500 4340 6580 5565 5180 5180 4970 4935
Volume With Entry   3300 4158 3564 3399 3300 3300 3432 3696
Competitor Entry: 1

Design Costs $50,000.00
Capital Investment $100,000.00
Operating Expense Factor 0.15 0.15 0.15 0.15 0.15 0.15 0.15 0.15

Sales Price $53.00 $67.31 $79.50 $63.60 $60.95 $55.65 $54.59 $51.94
Sales Volume 3300 4158 3564 3399 3300 3300 3432 3696
Sales Revenue $174,900 $279,875 $283,338 $216,176 $201,135 $183,645 $187,353 $191,970
Unit Production Cost $23.33 $24.26 $25.23 $26.24 $27.29 $28.38 $29.52 $30.70
Overhead $3,300 $6,944 $10,528 $8,904 $8,288 $8,288 $7,952 $7,896
Cost of Goods Sold $80,289 $107,830 $100,461 $98,104 $98,354 $101,957 $109,264 $121,366
Gross Margin $94,611 $172,045 $182,877 $118,072 $102,781 $81,688 $78,089 $70,604
Operating Expense $12,043 $16,175 $15,069 $14,716 $14,753 $15,294 $16,390 $18,205
Net Before Tax ($50,000) $0 $82,568 $155,870 $167,808 $103,357 $88,028 $66,395 $61,699 $52,400
Depreciation $20,000 $20,000 $20,000 $20,000 $20,000
Tax ($23,000) ($9,200) $28,781 $62,500 $67,992 $38,344 $40,493 $30,542 $28,382 $24,104
Taxes Owed $0 $0 $0 $59,081 $67,992 $38,344 $40,493 $30,542 $28,382 $24,104
Net After Tax ($50,000) $0 $82,568 $96,789 $99,816 $65,013 $47,535 $35,853 $33,317 $28,296

======== ======== ======== ======== ======== ======== ======== ======== ======== ========
Net Cash Flow ($50,000) ($100,000) $82,568 $96,789 $99,816 $65,013 $47,535 $35,853 $33,317 $28,296
NPV 10% $164,877
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Figure 9.7 Modifications for SensIt Formulas 

1
2
3
4
5
6
7
8
9

10
11
12
13
14
15
16
17
18
19
20
21
22
23
24
25
26
27
28
29
30
31
32
33
34
35

A B C D E F
Inputs

Price w/ o Entry 70
Price w/  Entry 53
Volume No Entry 3500
Volume w/  Entry 3300
Competitor Entry 1
Design Costs 50000
Capital Investment 100000
Operating Expense Factor 0.15
Unit Production Costs 23.33
Overhead 3300

 FINANCE   The @RISK Demonstratio
Product Launch Risk Analysis  2001-20

2001 2002 2003 2004
======== ======== ======== ========

Price No Entry =C2 =1.26*E20
Price With Entry =C3 =1.27*E21
Volume No Entry =C4 =1.24*E22
Volume With Entry  =C5 =1.26*E23
Competitor Entry: =C6

Design Costs =C7
Capital Investment =C8
Operating Expense Factor =C9 =$E$28

Sales Price =IF($C$24=0,E20,E21) =IF($C$24=0,F20,F21)
Sales Volume =IF($C$24=0,E22,E23) =IF($C$24=0,F22,F23)
Sales Revenue =(E30*E31) =(F30*F31)
Unit Production Cost =C10 =1.04*E33
Overhead =C11 6944
Cost of Goods Sold =(E31*E33)+E34 =(F31*F33)+F34  

Figure 9.8 Data for Competitor Entry as Base Case 

1
2
3
4
5
6
7
8
9

10
11

A B C D E F G
Inputs Low Base High

Price w/ o Entry $70.00 $50.00 $70.00 $90.00
Price w/  Entry $53.00 $40.00 $53.00 $68.00
Volume No Entry 3,500 3,100 3,500 3,900
Volume w/  Entry 3,300 2,800 3,300 3,800
Competitor Entry 0 0 1 1
Design Costs $50,000 $37,000 $50,000 $63,000
Capital Investment $100,000 $60,000 $100,000 $140,000
Operating Expense Factor 15.0% 6.5% 15.0% 23.0%
Unit Production Costs 23.33 15.50 23.33 32.00
Overhead $3,300 $2,800 $3,300 $4,000  
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Figure 9.9 Tornado Chart for Competitor Entry as Base Case 

Sensit  -  Sensitivity Analysis  -  Tornado

3,100 

$50.00

$2,800 

$37,000 

6.5%

$60,000 

2,800 

15.50

$40.00

0

3,900 

$90.00

$4,000 

$63,000 

23.0%

$140,000 

3,800 

32.00

$68.00

1

$0 $100,000 $200,000 $300,000 $400,000 $500,000 $600,000 $700,000

Competitor Entry

Price w/ Entry

Unit Production Costs

Volume w/ Entry

Capital Investment

Operating Expense Factor

Design Costs

Overhead

Price w/o Entry

Volume No Entry 

NPV 10%

 

Figure 9.10 Data for No Competitor Entry as Base Case 

1
2
3
4
5
6
7
8
9

10
11

A B C D E F G
Inputs Low Base High

Price w/ o Entry $70.00 $50.00 $70.00 $90.00
Price w/  Entry $53.00 $40.00 $53.00 $68.00
Volume No Entry 3,500 3,100 3,500 3,900
Volume w/  Entry 3,300 2,800 3,300 3,800
Competitor Entry 0 0 0 1
Design Costs $50,000 $37,000 $50,000 $63,000
Capital Investment $100,000 $60,000 $100,000 $140,000
Operating Expense Factor 15.0% 6.5% 15.0% 23.0%
Unit Production Costs 23.33 15.50 23.33 32.00
Overhead $3,300 $2,800 $3,300 $4,000  
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Figure 9.11 Tornado Chart for No Competitor Entry as Base Case 

Sensit  -  Sensitivity Analysis  -  Tornado
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$90.00

$100,000 $200,000 $300,000 $400,000 $500,000 $600,000 $700,000 $800,000 $900,000 $1,000,00
0
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0
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Unit Production Costs

Volume No Entry 
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9.3 MACHINE SIMULATION MODEL 
Clemen's AJS Problem 
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Figure 9.12 Process 1 Display and Formulas 

1
2
3
4
5
6
7
8
9

10
11
12
13
14
15
16
17
18
19
20
21
22
23
24
25
26
27
28
29
30
31
32
33
34

A B C D E F G
Process 1

Zero One Two
Demand D P(D) D P(D) D P(D)

11,000 0.2 8,000 0.2 4,000 0.1
16,000 0.6 19,000 0.4 21,000 0.5
21,000 0.2 27,000 0.4 37,000 0.4

Var Cost Mean StDev
Normal $4.00 $0.40

Machine Mean
Failure 4
Poisson

Equipment $0
Unit Price $8
Failure Cost $8,000
Fixed Cost $12,000
Discount Rate 10%

Year Initial Zero One Two
Demand 16,000 19,000 21,000 Mode
Var Cost $4.00 $4.00 $4.00 Mean
Failures 4 4 4 Mean
Cash Flow $0 $20,000 $32,000 $40,000

NPV $74,681

Formula in B25: =-B15

Formula in C25: =C22*($B16-C23)-C24*$B17-$B18
Copy to D25:E25

Formula in B27: =B25+NPV(B19,C25:E25)  
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Figure 9.13 Process 2 Display 

1
2
3
4
5
6
7
8
9

10
11
12
13
14
15
16
17
18
19
20
21
22
23
24
25
26
27

A B C D E F G
Process 2

Zero One Two
Demand D P(D) D P(D) D P(D)

14,000 0.3 12,000 0.36 9,000 0.4
19,000 0.4 23,000 0.36 26,000 0.1
24,000 0.3 31,000 0.28 42,000 0.5

Var Cost Mean StDev
Normal $3.50 $1.00

Machine Mean
Failure 3
Poisson

Equipment $60,000
Unit Price $8
Failure Cost $6,000
Fixed Cost $12,000
Discount Rate 10%

Year Initial Zero One Two
Demand 19,000 23,000 26,000 Mode
Var Cost $3.50 $3.50 $3.50 Mean
Failures 3 3 3 Mean
Cash Flow -$60,000 $55,500 $73,500 $87,000

NPV $116,563  

Figure 9.14 RiskSim Functions for Process 1 and Process 2 
20
21
22
23
24
25
26
27

A B C D E

Year Initial Zero One Two
Demand =randdiscrete(B4:C6) =randdiscrete(D4:E6) =randdiscrete(F4:G6)
Var Cost =randnormal($B$9,$C$9) =randnormal($B$9,$C$9) =randnormal($B$9,$C$9)
Failures =randpoisson($B$12) =randpoisson($B$12) =randpoisson($B$12)
Cash Flow =-B15 =C22*($B16-C23)-C24*$B17-$B18 =D22*($B16-D23)-D24*$B17-$B18 =E22*($B16-E23)-E24*$B17-$B18

NPV =B25+NPV(B19,C25:E25)  
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Figure 9.15 RiskSim Output for Process 1 
RiskSim - One Output - Summary Mean $90,526
Date 9-Apr-01 St. Dev. $47,290
Time 7:07 PM Mean St. Error $1,495
Workbook AJS_WhatIf.xls Minimum -$59,664
Worksheet Process 1 Probability First Quartile $58,050
Output Cell $B$27 Median $91,460
Output Label NPV Third Quartile $124,435
Seed 0.5 Maximum $234,703
Trials 1,000 Skewness -0.1034

RiskSim Histogram, 09-Apr-01, 07:07 PM
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Figure 9.16 RiskSim Output for Process 2 
RiskSim - One Output - Summary Mean $116,159
Date 9-Apr-01 St. Dev. $73,675
Time 7:08 PM Mean St. Error $2,330
Workbook AJS_WhatIf.xls Minimum -$70,685
Worksheet Process 2 Probability First Quartile $60,199
Output Cell $B$27 Median $114,335
Output Label NPV Third Quartile $168,191
Seed 0.5 Maximum $347,514
Trials 1,000 Skewness 0.1390

RiskSim Histogram, 09-Apr-01, 07:08 PM
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Follow these instructions to show two or more risk profiles on the same chart. 

Use RiskSim to obtain the sorted values, cumulative probabilities, and XY charts for 
strategy A and strategy B. 

To add the data for strategy B to the existing plot for strategy A, select the sorted values 
and cumulative probabilities for strategy B (without including the text labels in row 1), 
and choose Edit | Copy. 

Click just inside the outer border of the strategy A chart to select it. From the main menu, 
choose Edit | Paste Special. In the Paste Special dialog box, select "Add cells as New 
series," select "Values (Y) in Columns," check the box for "Categories (X Values) in 
First Column," and click OK. 

Use the same method to add data for other strategies to the strategy A chart. 

To change the lines and markers of a data series, click a data point on the chart to select 
the data series, and choose Format | Selected Data Series | Patterns. 

If the X values are quite different for the various strategies, it may be necessary to adjust 
the minimum and maximum values on the Scale tab of the Format Axis dialog box. 
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Figure 9.17 Comparison of Process1 and Process 2 
Process 1 Process 2

Mean $90,526 Mean $116,159
St. Dev. $47,290 St. Dev. $73,675
Mean St. Error $1,495 Mean St. Error $2,330
Minimum -$59,664 Minimum -$70,685
First Quartile $58,050 First Quartile $60,199
Median $91,460 Median $114,335
Third Quartile $124,435 Third Quartile $168,191
Maximum $234,703 Maximum $347,514
Skewness -0.1034 Skewness 0.1390

RiskSim Cumulative Chart
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Modeling Waiting Lines  10 
 

10.1 QUEUE SIMULATION 
A warehouse has one dock used to unload railroad freight cars.  Incoming freight cars are 
delivered to the warehouse during the night.  It takes exactly half a day to unload a car.  If 
more than two cars are waiting to be unloaded on a given day, the unloading of some of 
the cars is postponed until the following day.  The cost is $100 per day for each car 
delayed. 

Past experience has indicated that the number of cars arriving during the night have the 
frequencies shown in the table below.  Furthermore, there is no apparent pattern, so that 
the number arriving on any night is independent of the number arriving on any other 
night. 

Figure 10.1 Arrival Frequency 
Number of cars 

arriving 
Relative 

frequency 
0 0.23 
1 0.30 
2 0.30 
3 0.10 
4 0.05 
5 0.02 

6 or more 0.00 
 1.00 

Concepts for Queuing (waiting-line) Models 

Arrival pattern 

Service time 

Number of servers 

Queue discipline 



156     Chapter 10 Modeling Waiting Lines 

Performance measures 

 Equilibrium 

 Average waiting time 

 Average number of customers in line 

System utilization, rho = mean arrival rate / mean service rate 

Stable system:  rho < 1 

Figure 10.2 Influence Chart for Simulation Model 
Total
Cost

Cost of
Delays

Number Number Number
Delayed Delayed Delayed

Number Actually Number Actually Number Actually
To Unload Unloaded To Unload Unloaded To Unload Unloaded

Number of Number of Number of
Arrivals Arrivals Arrivals

Day 1 Day 2 Day N

Unloading Capacity
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Figure 10.3 Simulation Model Spreadsheet Model Display 

1
2
3
4
5
6
7
8
9

10
11
12
13
14
44
45
46
47
48
49
50
51
52
53
54
55
56
57
58

A B C D E F G H I
Unloading Capacity 2 Daily Delay Cost 100$              

Random Number of Number Actually Number Annual Delay Cost 16,500$         
Day Number Arrivals To Unload Unloaded Delayed

1 0.812 3 3 2 1
2 0.524 2 3 2 1
3 0.671 2 3 2 1
4 0.250 1 2 2 0
5 0.940 3 3 2 1
6 0.771 2 3 2 1
7 0.026 0 1 1 0
8 0.178 0 0 0 0
9 0.683 2 2 2 0

10 0.727 2 2 2 0
40 0.082 0 0 0 0
41 0.425 1 1 1 0
42 0.826 3 3 2 1
43 0.855 3 4 2 2
44 0.971 3 5 2 3
45 0.429 1 4 2 2
46 0.592 2 4 2 2
47 0.085 0 2 2 0
48 0.018 0 0 0 0
49 0.678 2 2 2 0
50 0.510 2 2 2 0

Total 86 33

Daily Average 1.72 0.66  

Figure 10.4 Simulation Model Spreadsheet Model Formulas 

1
2
3
4
5
6
7
8
9

10
11
12
13
14
44
45
46
47
48
49
50
51
52
53
54
55
56
57
58

A B C D E F G H I
Unloading Capacity 2 Daily Delay Cost 100

Random Number of Number Actually Number Annual Delay Cost =250*F58*I1
Day Number Arrivals To Unload Unloaded Delayed

1 =RAND() =IF(B5<0.2,0,IF(B5<0.5,1,IF(B5<0.8,2,3))) =C5 =MIN(D5,$C$1) =D5-E5
2 =RAND() =IF(B6<0.2,0,IF(B6<0.5,1,IF(B6<0.8,2,3))) =F5+C6 =MIN(D6,$C$1) =D6-E6
3 =RAND() =IF(B7<0.2,0,IF(B7<0.5,1,IF(B7<0.8,2,3))) =F6+C7 =MIN(D7,$C$1) =D7-E7
4 =RAND() =IF(B8<0.2,0,IF(B8<0.5,1,IF(B8<0.8,2,3))) =F7+C8 =MIN(D8,$C$1) =D8-E8
5 =RAND() =IF(B9<0.2,0,IF(B9<0.5,1,IF(B9<0.8,2,3))) =F8+C9 =MIN(D9,$C$1) =D9-E9
6 =RAND() =IF(B10<0.2,0,IF(B10<0.5,1,IF(B10<0.8,2,3))) =F9+C10 =MIN(D10,$C$1) =D10-E10
7 =RAND() =IF(B11<0.2,0,IF(B11<0.5,1,IF(B11<0.8,2,3))) =F10+C11 =MIN(D11,$C$1) =D11-E11
8 =RAND() =IF(B12<0.2,0,IF(B12<0.5,1,IF(B12<0.8,2,3))) =F11+C12 =MIN(D12,$C$1) =D12-E12
9 =RAND() =IF(B13<0.2,0,IF(B13<0.5,1,IF(B13<0.8,2,3))) =F12+C13 =MIN(D13,$C$1) =D13-E13
10 =RAND() =IF(B14<0.2,0,IF(B14<0.5,1,IF(B14<0.8,2,3))) =F13+C14 =MIN(D14,$C$1) =D14-E14
40 =RAND() =IF(B44<0.2,0,IF(B44<0.5,1,IF(B44<0.8,2,3))) =F43+C44 =MIN(D44,$C$1) =D44-E44
41 =RAND() =IF(B45<0.2,0,IF(B45<0.5,1,IF(B45<0.8,2,3))) =F44+C45 =MIN(D45,$C$1) =D45-E45
42 =RAND() =IF(B46<0.2,0,IF(B46<0.5,1,IF(B46<0.8,2,3))) =F45+C46 =MIN(D46,$C$1) =D46-E46
43 =RAND() =IF(B47<0.2,0,IF(B47<0.5,1,IF(B47<0.8,2,3))) =F46+C47 =MIN(D47,$C$1) =D47-E47
44 =RAND() =IF(B48<0.2,0,IF(B48<0.5,1,IF(B48<0.8,2,3))) =F47+C48 =MIN(D48,$C$1) =D48-E48
45 =RAND() =IF(B49<0.2,0,IF(B49<0.5,1,IF(B49<0.8,2,3))) =F48+C49 =MIN(D49,$C$1) =D49-E49
46 =RAND() =IF(B50<0.2,0,IF(B50<0.5,1,IF(B50<0.8,2,3))) =F49+C50 =MIN(D50,$C$1) =D50-E50
47 =RAND() =IF(B51<0.2,0,IF(B51<0.5,1,IF(B51<0.8,2,3))) =F50+C51 =MIN(D51,$C$1) =D51-E51
48 =RAND() =IF(B52<0.2,0,IF(B52<0.5,1,IF(B52<0.8,2,3))) =F51+C52 =MIN(D52,$C$1) =D52-E52
49 =RAND() =IF(B53<0.2,0,IF(B53<0.5,1,IF(B53<0.8,2,3))) =F52+C53 =MIN(D53,$C$1) =D53-E53
50 =RAND() =IF(B54<0.2,0,IF(B54<0.5,1,IF(B54<0.8,2,3))) =F53+C54 =MIN(D54,$C$1) =D54-E54

Total =SUM(C5:C54) =SUM(F5:F54)

Daily Average =C56/50 =F56/50  
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Figure 10.5 Simulation Model Dynamic Histogram Display 
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41
42
43
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K L M N O P Q R S T U V
50-Day Trial 17,000$  Minimum 1,500$   Interval Max Frequency

1 12,500$  Maximum 58,000$ 5000 11
2 28,000$  10000 39
3 2,500$    Mean 12,845$ 15000 24
4 16,000$  20000 10
5 6,000$    StDev 9,016$   25000 8
6 9,500$    30000 3
7 10,500$  35000 2
8 13,500$  40000 2
9 7,000$    45000 0

10 15,500$  50000 0
11 21,500$  55000 0
12 16,000$  60000 1
13 9,000$    65000 0
14 4,500$    70000 0
15 8,500$    75000 0
16 8,500$    80000 0
17 15,000$  85000 0
18 9,000$    90000 0
19 2,000$    95000 0
20 10,500$  100000 0
21 16,500$  More 0
22 18,500$  
23 8,500$    
24 5,500$    
25 13,500$  
26 5,000$    
27 23,500$  
28 58,000$  
29 11,500$  
30 7,000$    
31 7,000$    
32 6,000$    
33 7,500$    
34 9,500$    
35 7,500$    
36 12,500$  
37 8,500$    
38 14,000$  
39 7,000$    
40 31,000$  
41 22,000$  
42 40,000$  
43 10,500$  
44 8,500$    
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Figure 10.6 Simulation Model Dynamic Histogram Formulas 

1
2
3
4
5
6
7
8
9

10
11
12
13
14
15
16
17
18
19
20
21
22
23
24
25
26

L M N O P Q R S
50-Day Trial =I3 Minimum =MIN(M2:M101) Interval Max Frequency

1 =TABLE(,K1) Maximum =MAX(M2:M101) 5000 =FREQUENCY(M2:M101,R2:R21)
2 =TABLE(,K1) 10000 =FREQUENCY(M2:M101,R2:R21)
3 =TABLE(,K1) Mean =AVERAGE(M2:M101) 15000 =FREQUENCY(M2:M101,R2:R21)
4 =TABLE(,K1) 20000 =FREQUENCY(M2:M101,R2:R21)
5 =TABLE(,K1) StDev =STDEV(M2:M101) 25000 =FREQUENCY(M2:M101,R2:R21)
6 =TABLE(,K1) 30000 =FREQUENCY(M2:M101,R2:R21)
7 =TABLE(,K1) 35000 =FREQUENCY(M2:M101,R2:R21)
8 =TABLE(,K1) 40000 =FREQUENCY(M2:M101,R2:R21)
9 =TABLE(,K1) 45000 =FREQUENCY(M2:M101,R2:R21)
10 =TABLE(,K1) 50000 =FREQUENCY(M2:M101,R2:R21)
11 =TABLE(,K1) 55000 =FREQUENCY(M2:M101,R2:R21)
12 =TABLE(,K1) 60000 =FREQUENCY(M2:M101,R2:R21)
13 =TABLE(,K1) 65000 =FREQUENCY(M2:M101,R2:R21)
14 =TABLE(,K1) 70000 =FREQUENCY(M2:M101,R2:R21)
15 =TABLE(,K1) 75000 =FREQUENCY(M2:M101,R2:R21)
16 =TABLE(,K1) 80000 =FREQUENCY(M2:M101,R2:R21)
17 =TABLE(,K1) 85000 =FREQUENCY(M2:M101,R2:R21)
18 =TABLE(,K1) 90000 =FREQUENCY(M2:M101,R2:R21)
19 =TABLE(,K1) 95000 =FREQUENCY(M2:M101,R2:R21)
20 =TABLE(,K1) 100000 =FREQUENCY(M2:M101,R2:R21)
21 =TABLE(,K1) More =FREQUENCY(M2:M101,R2:R21)
22 =TABLE(,K1)
23 =TABLE(,K1)
24 =TABLE(,K1)
25 =TABLE(,K1)  
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Introduction to 
Data Analysis  11 
 

object of analysis: person, thing, business entity, etc. 

characteristic of interest: weight, hair color, diameter, sales, etc. 

measurement of the characteristic: pounds, blond/brunette/red/etc., inches, dollars, etc. 

11.1 LEVELS OF MEASUREMENT 
called measurement scales by some authors 

important distinctions because analysis and summary methods are very different 

two general levels of measurement, each with two specific levels 

Categorical Measure 
also called qualitative measure 

assign a category level to each object of analysis 

Nominal Measure: simple classification, "assign a name" 

Ordinal Measure: ranked categories, "assign an ordered classification" 

Numerical Measure 
also called quantitative measure 

assign a numerical value to each object of analysis 

Interval Measure:, rankings and numerical differences are meaningful 

Ratio Measure: natural zero and numerical ratios are meaningful 
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11.2 DESCRIBING CATEGORICAL DATA 
List each categorical level with frequencies (counts) or relative frequencies (percentages). 

Use an Excel pivot table to obtain frequencies. 

Use an Excel bar chart, column chart, or pie chart. 

To display the relationship between two categorical measures, use a two-way 
classification table. 

For nominal data, the appropriate summary measure is the mode (most frequently 
occurring level) 

For ordinal data, the appropriate summary measures are the mode and median (the 
middle-ranked category level with approximately 50% of the counts below and 
approximately 50% above). 

Do not assign meaningless numerical values to the categorical levels. 

Do not use the mean and standard deviation. 

11.3 DESCRIBING NUMERICAL DATA 

Frequency Distribution and Histogram 
Determine the range (maximum minus minimum), generally use between 5 and 15 
equally-spaced intervals, and pick "nice" numbers for the upper limit of each interval 
(Excel "bins"). 

Use Excel's Histogram analysis tool, or use Excel's FREQUENCY array-entered 
worksheet function with an Excel Column chart (vertical bars). 

Numerical Summary Measures 
Appropriate summary measures for central tendency ("What's a typical value?") include 
mean (average, most appropriate for mound-shaped data), median, and mode. 

Appropriate summary measures for dispersion ("How typical is the typical value?") 
include range, standard deviation (most appropriate for mound-shaped distributions), and 
fractiles (first quartile, or 25th percentile, is a value with approximately 25% of the 
values below it and approximately 75% of the values above). 

Appropriate summary measures for shape are Excel's SKEW worksheet function and 
Pearson's coefficient of skewness. 
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Distribution Shapes 

Figure 11.1 Positively Skewed Distribution (Skewed to the Right) 
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In a distribution with positive skew, the mean is greater than the median. 

Figure 11.2 Negatively Skewed Distribution (Skewed to the Left) 
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In a distribution with negative skew, the mean is less than the median. 
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Figure 11.3 Mound-Shaped Distribution (Symmetric) 
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In a symmetric distribution, the mean and median are equal. 

Figure 11.4 Bimodal Distribution 

Value

Fr
eq

ue
nc

y

 

In a bimodal distribution, there is often a distinguishing characteristic for the two groups 
of data that have been combined into a single distribution. 

 



 

Regression Models for 
Cross-Sectional Data  12 
 

12.1 CROSS-SECTIONAL REGRESSION CHECKLIST 

Plot Y versus each X 
 1 Verify that the relationship agrees with your prior judgment, e.g., positive vs 

negative relationship, linear vs nonlinear, strong vs weak 

 2 Identify outliers or unusual observations and decide whether to exclude 

 3 Determine whether the relationship is linear; if not, consider using a nonlinear 
form, e.g., quadratic (include X and X^2 in the model) 

Examine the correlation matrix 
 4 Identify potential multicollinearity problems, i.e., high correlation between a 

pair of X variables; if so, consider using only one X of the pair in the model 

Calculate the regression model with diagnostics 
 5 Verify that the sign of each regression coefficient agrees with your prior 

judgment, i.e., positive vs negative relationship; otherwise, consider excluding 
that X and rerun the regression 

 6 Examine each plot of residuals vs X; if there is a non-random pattern (e.g., U-
shape or upside-down-U-shape), use a nonlinear form for that X in a new model 

 7 Identify key X variables by comparing standardized regression coefficients, 
usually computed by multiplying an X coefficient by the standard deviation of  
that X and dividing by the standard deviation of Y. This dimensionless 
standardized regression coefficient measures how much Y (in standard deviation 
units) is affected by a change in X (in standard deviation units). 
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 8 If a goal is to find a model with small standard error of estimate (approx. 
standard deviation of residuals), use the t-stat screening method. Disregard the t-
stat for the intercept. If there are X variables with a t-stat between -1 and +1, 
remove the single X variable whose t-stat is closest to zero, and rerun the 
regression. Remove only one X variable at a time. 

 9 Before using the final model, examine each plot of residuals vs X to verify that 
the random scatter is the same for all values of X. If there is more scatter for 
higher values of X, consider using a log transformation of X in the model 
(instead of using X itself). If the scatter is not uniform with respect to X, the 
standard error of estimate may not be a useful measure of uncertainty because it 
overstates the uncertainty for some values of X and understates the uncertainty 
for other values of X. 

Use the model 
 10 If the purpose is to identify unusual observations, examine the residuals directly 

for large negative or large positive values, or examine the standardized residuals 
(each residual divided by the standard deviation of residuals) for values more 
extreme than +2 or -2 or for values more extreme than +3 or -3. 

 11 If the purpose is to make predictions, use the X values for a new observation to 
compute a predicted Y. Use the standard error of estimate to provide an interval 
estimate, e.g., an approximate 95% prediction interval that ranges from two 
standard errors below to two standard errors above the predicted Y. Avoid 
extrapolation, i.e., do not make predictions using X values outside the range of 
the original data. 

 



 

Time Series Data 
and Forecasts  13 
 

13.1 TIME SERIES PATTERNS 
Meandering time series pattern: Small changes from period to period, possible larger 
changes over a longer period of time 

Use an autoregressive model 

Figure 13.1 Typical Meandering Time Series Pattern 
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Figure 13.2 Typical Long-Term Trend Time Series Patterns 
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Figure 13.3 Typical Quarterly Seasonal Time Series with Linear Trend 
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Figure 13.4 Quarterly Seasonal Pattern with Nonlinear Trend 
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Strong seasonal pattern, no trend during first 12 quarters, positive trend during middle 12 
quarters, no trend during last 12 quarters 



170     Chapter 13 Time Series Data and Forecasts 

This page is intentionally mostly blank. 

 



 

Regression Models 
for Time Series Data  14 
 

14.1 TIME SERIES REGRESSION CHECKLIST 
Relevant explanatory variables (X) for time series data related to business activity (Y), 
e.g., sales over time, include several general types: 

 a Internal business activity, like advertising, promotion, research and development 

 b Competitor business activity, like competitor sales and competitor advertising 

 c Industry activity, like number of competitors and market size 

 d General economic activity, like personal disposable income 

Plot Y versus time 
 1 Identify any systematic pattern to help determine an appropriate model 

Plot Y versus each X 
 2 Verify that the relationship agrees with your prior judgment, e.g., positive vs 

negative relationship, linear vs nonlinear, strong vs weak 

 3 Identify outliers or unusual observations and decide whether to exclude 

 4 Determine whether the relationship is linear; if not, consider using a nonlinear 
form, e.g., quadratic (include X and X^2 in the model) 

Examine the correlation matrix 
 5 Include a time period variable in the correlation matrix. For example, if there are 

n equally-spaced time periods, include a variable in your data set with values 
1,2,...,n. 

 6 Identify potential multicollinearity problems, i.e., high correlation between a 
pair of X variables; if so, consider using only one X of the pair in the model 
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Calculate the regression model with diagnostics 
 7 Verify that the sign of each regression coefficient agrees with your prior 

judgment, i.e., positive vs negative relationship; otherwise, consider excluding 
that X and rerun the regression 

 8 Examine each plot of residuals vs X; if there is a non-random pattern (e.g., U-
shape or upside-down-U-shape), use a nonlinear form for that X in a new model 

 9 In addition to the residual plots generated automatically by Excel's Regression 
tool, prepare and examine a plot of residuals vs time. If there is a snake-like 
pattern of residuals, consider adding lag Y as an explanatory variable. 
Optionally, compute the Durbin-Watson statistic to detect autocorrelation of 
residuals. 

 10 Identify key X variables by comparing standardized regression coefficients, 
usually computed by multiplying an X coefficient by the standard deviation of 
that X and dividing by the standard deviation of Y. This dimensionless 
standardized regression coefficient measures how much Y (in standard deviation 
units) is affected by a change in X (in standard deviation units). 

 11 If a goal is to find a model with small standard error of estimate (approx. 
standard deviation of residuals), use the t-stat screening method. Disregard the t-
stat for the intercept. If there are X variables with a t-stat between -1 and +1, 
remove the single X variable whose t-stat is closest to zero, and rerun the 
regression. Remove only one X variable at a time. 

 12 Before using the final model, examine each plot of residuals vs X to verify that 
the random scatter is the same for all values of X. If there is more scatter for 
higher values of X, consider using a log transformation of X in the model 
(instead of using X itself). If the scatter is not uniform with respect to X, the 
standard error of estimate may not be a useful measure of uncertainty because it 
overstates the uncertainty for some values of X and understates the uncertainty 
for other values of X. 

Use the model 
 13 If the purpose is to identify unusual observations, examine the residuals directly 

for large negative or large positive values, or examine the standardized residuals 
(each residual divided by the standard deviation of residuals) for values more 
extreme than +2 or -2 or for values more extreme than +3 or -3. 

 14 If the purpose is to make predictions, use the X values for a new observation to 
compute a predicted Y. Use the standard error of estimate to provide an interval 
estimate, e.g., an approximate 95% prediction interval that ranges from two 
standard errors below to two standard errors above the predicted Y. Note that a 
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time series forecast usually extrapolates beyond the original range of data, so the 
standard error of estimate is a minimum indication of the uncertainty 
surrounding a forecast. 

14.2 AUTOCORRELATION OF RESIDUALS 

Figure 14.1 Undesirable Extreme Negative Autocorrelation 
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Figure 14.2 Undesirable Extreme Positive Autocorrelation 
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Figure 14.3 Desirable Zero Autocorrelation 
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Sensitivity Analysis 
for Decision Trees  15 
 

15.1 ONE-VARIABLE SENSITIVITY ANALYSIS 
One-Variable Sensitivity Analysis using an Excel data table 

 1. Construct a decision tree model or financial planning model. 

 2. Identify the model input cell (H1) and model output cell (A10). 

 3. Modify the model so that probabilities will always sum to one. (That is, enter the 
formula =1-H1 in cell H6.) 

Figure 15.1 Display for One-Variable Sensitivity Analysis 
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0.6

High sales
+$300

Introduce product +$600 +$300

-$300 +$100 0.4
Low sales

-$200
1 +$100 -$200

+$100

Don't introduce
$0

$0 $0

Model Input Cell

Model 
Output 
Cell

=1-H1

 

 4. Enter a list of input values in a column (N3:N13). 

 5. Enter a formula for determining output values at the top of an empty column on 
the right of the input values (=A10 in cell O2). 

 6. Select the data table range (N2:O13). 
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 7. From the Data menu choose the Table command. 

Figure 15.2  
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 8. In the Data Table dialog box, select the Column Input Cell edit box. Type the 
model input cell (H1), or point to the model input cell (in which case the edit 
box displays $H$1). Click OK. 

Figure 15.3  

 

 9. The Data Table command substitutes each input value into the model input cell, 
recalculates the worksheet, and displays the corresponding model output value 
in the table. 

 10. Optional: Change the formula in cell O2 to 
=CHOOSE(B9,”Introduce”,”Don’t”). 
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Figure 15.4  
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M N O P
P(High Sales) Exp. Value

0.00 0
0.10 0
0.20 0
0.30 0
0.40 0
0.50 50
0.60 100
0.70 150
0.80 200
0.90 250
1.00 300

 

15.2 TWO-VARIABLE SENSITIVITY ANALYSIS 
Two-Variable Sensitivity Analysis using an Excel data table 

Figure 15.5 Decision Tree for Strategy Region Table 
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Optional: Activate the Base Case worksheet. From the Edit menu, choose Move Or Copy 
Sheet. In the Move Or Copy dialog box, check the box for Create A Copy, and click OK. 
Double-click the new worksheet tab and enter Strategy Region Table. 

Setup for Data Table 
Select cell P11, and enter the formula =1–P6. Select cell P21, and enter the formula =1–
P16. 

In cell U3 enter P(Elec OK). In cell V3 enter 1, and in cell V4 enter 0.9. Select cells 
V3:V4. In the lower right corner of cell V4, click the fill handle and drag down to cell 
V13. With cells V3:V13 still selected, click the Increase Decimal button once so that all 
values are displayed with one decimal place. 

Select columns V:AG. (Select column V. Click and drag the horizontal scroll bar until 
column AG is visible. Hold down the Shift key and click column AG.) From the Format 
menu choose Column | Width. In the Column Width edit box type 5 and click OK. 

In cell W1 enter P(Mag OK). In cell W2 enter 0 (zero), and in cell X2 enter 0.1. Select 
cells W2:X2. In the lower right corner of cell X2, click the fill handle and drag right to 
cell AG2. With cells W2: AG2 still selected, click the Increase Decimal button once so 
that all values are displayed with one decimal place. 

Select cell V2 and enter the formula =CHOOSE(J11,"Mech","Elec","Mag"). With the 
base case assumptions the formula shows Elec. 

Figure 15.6  
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U V W X Y Z AA AB AC AD AE AF AG
P(Mag OK)

Elec 0.0 0.1 0.2 0.3 0.4 0.5 0.6 0.7 0.8 0.9 1.0
P(Elec OK) 1.0

0.9
0.8
0.7
0.6
0.5
0.4
0.3
0.2
0.1
0.0  

Obtaining Results Using Data Table Command 
Select the entire data table, cells V2:AG13. 
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From the Data menu, choose Table. In the Table dialog box, type P16 in the Row Input 
Cell edit box, type P6 in the Column Input Cell edit box, and click OK. 

With cells V2:AG13 still selected, click the Align Right button. 

Figure 15.7  
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U V W X Y Z AA AB AC AD AE AF AG
P(Mag OK)

Elec 0.0 0.1 0.2 0.3 0.4 0.5 0.6 0.7 0.8 0.9 1.0
P(Elec OK) 1.0 Elec Elec Elec Elec Elec Elec Elec Elec Elec Elec Elec

0.9 Elec Elec Elec Elec Elec Elec Elec Elec Elec Elec Elec
0.8 Elec Elec Elec Elec Elec Elec Elec Elec Elec Elec Elec
0.7 Elec Elec Elec Elec Elec Elec Elec Elec Elec Elec Mag
0.6 Elec Elec Elec Elec Elec Elec Elec Elec Elec Mag Mag
0.5 Elec Elec Elec Elec Elec Elec Elec Elec Mag Mag Mag
0.4 Mech Mech Mech Mech Mech Mech Mech Mag Mag Mag Mag
0.3 Mech Mech Mech Mech Mech Mech Mech Mag Mag Mag Mag
0.2 Mech Mech Mech Mech Mech Mech Mech Mag Mag Mag Mag
0.1 Mech Mech Mech Mech Mech Mech Mech Mag Mag Mag Mag
0.0 Mech Mech Mech Mech Mech Mech Mech Mag Mag Mag Mag  

Embellishments 
Select cells U1:AG13, and click the Copy button. Select cell AI1, right-click, and from 
the shortcut menu choose Paste Special. In the Paste Special dialog box, click the Values 
option button, and click OK. Right-click again, choose Paste Special, click the Formats 
option button, and click OK. 

Select columns AJ:AU. Choose Format | Cells | Width, type 5, and click OK. 

Select cell AJ2, right-click, and from the shortcut menu choose Clear Contents. Select 
cells AK2:AU2, move the cursor near the border of the selection until it becomes an 
arrow, click and drag the selection down to cells AK14:AU14. Similarly, select cell AK1 
and move its contents down to cell AP15. Also, move the contents of cell AI3 to cell AI8. 
Select cell AN1, and enter Strategy Region Table. 
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Figure 15.8  

1
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AI AJ AK AL AM AN AO AP AQ AR AS AT AU
Strategy Region Table

1.0 Elec Elec Elec Elec Elec Elec Elec Elec Elec Elec Elec
0.9 Elec Elec Elec Elec Elec Elec Elec Elec Elec Elec Elec
0.8 Elec Elec Elec Elec Elec Elec Elec Elec Elec Elec Elec
0.7 Elec Elec Elec Elec Elec Elec Elec Elec Elec Elec Mag
0.6 Elec Elec Elec Elec Elec Elec Elec Elec Elec Mag Mag

P(Elec OK) 0.5 Elec Elec Elec Elec Elec Elec Elec Elec Mag Mag Mag
0.4 Mech Mech Mech Mech Mech Mech Mech Mag Mag Mag Mag
0.3 Mech Mech Mech Mech Mech Mech Mech Mag Mag Mag Mag
0.2 Mech Mech Mech Mech Mech Mech Mech Mag Mag Mag Mag
0.1 Mech Mech Mech Mech Mech Mech Mech Mag Mag Mag Mag
0.0 Mech Mech Mech Mech Mech Mech Mech Mag Mag Mag Mag

0.0 0.1 0.2 0.3 0.4 0.5 0.6 0.7 0.8 0.9 1.0
P(Mag OK)  

Apply borders to appropriate ranges and cells to show the strategy regions. Apply 
shading to cell AR8 to show the base case strategy. 

Figure 15.9  
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0.6 Elec Elec Elec Elec Elec Elec Elec Elec Elec Mag Mag
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0.0 Mech Mech Mech Mech Mech Mech Mech Mag Mag Mag Mag

0.0 0.1 0.2 0.3 0.4 0.5 0.6 0.7 0.8 0.9 1.0
P(Mag OK)  

15.3 MULTIPLE-OUTCOME SENSITIVITY ANALYSIS 
Sensitivity Analysis for Multiple-Outcome Event Probabilities 

Choose one of the outcome probabilities that will be explicitly changed. 

For example, focus on P(Low Sales). 
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Keep same relative likelihood (base case) for the other probabilities. 

Figure 15.10  
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Base -> 0.30 Intro

0.3 0.20 Intro
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Figure 15.11  
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182     Chapter 15 Sensitivity Analysis for Decision Trees 

15.4 ROBIN PINELLI'S SENSITIVITY ANALYSIS 

Figure 15.12 Decision Tree and Multi-Attribute Utility (Robin Pinelli) 
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44
45
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A B C D E F G H I J K L M N O P Q R S T U V
Robin Pinelli, Clemen2, pp. 150-151 Individual Utility Weight Ratio Input

Overall Mag/Snow 1.50
Non-TreePlan Formulas Utility Income Snowfall Magazine Mag/Income 3.00
V6 =V8/V3 0.15
V7 =V8/V2 Snowfall 100 cm Weights
V8 =1/(1/V2+1/V3+1) 48.83 75 25 56 Income 0.167
O6 =$V$6*Q6+$V$7*R6+$V$8*S6 Snowfall 0.333
Select O6:O10; click and drag Magazine 0.500
fill handle to O51. 0.60 0.70

Disp. Income $1500 Snowfall 200 cm
57.17 75 50 56

0.15
Snowfall 400 cm

73.83 75 100 56
Madison Publishing

55.08 0.15
Snowfall 100 cm

40.50 25 25 56

0.40 0.70
Disp. Income $1300 Snowfall 200 cm

48.83 25 50 56

0.15
Snowfall 400 cm

65.50 25 100 56

1 0.15
Snowfall 150 cm

29.17 100 37.5 0

0.70
MPR Manufacturing Snowfall 230 cm

35.83 100 57.5 0
35.96

0.15
Snowfall 320 cm

43.33 100 80 0

Pandemonium Pizza
50.00 0 0 100

50.00  
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Figure 15.13 Sensitivity Analysis of Weight-Ratio Input Assumptions 
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35

X Y Z AA AB AC AD AE AF AG AH
Sensitivity Analysis

Mag/Income Weight Ratio
1.0 1.5 2.0 2.5 3.0 3.5 4.0 4.5 5.0

Mag/Snow 1.00 Madison Madison Madison Madison Madison Madison Madison Madison Madison
Weight 1.25 Madison Madison Madison Madison Madison Madison Madison Madison Madison

Ratio 1.50 Madison Madison Madison Madison Madison Madison Madison Madison Madison
1.75 Madison Madison Madison Madison Madison Madison Madison Pizza Pizza
2.00 Madison Madison Madison Madison Madison Pizza Pizza Pizza Pizza
2.25 Madison Madison Madison Madison Pizza Pizza Pizza Pizza Pizza
2.50 Madison Madison Madison Pizza Pizza Pizza Pizza Pizza Pizza
2.75 Madison Madison Madison Pizza Pizza Pizza Pizza Pizza Pizza
3.00 Madison Madison Madison Pizza Pizza Pizza Pizza Pizza Pizza

Mag/Income Weight Ratio
0.25 0.50 0.75 1.00 1.50 2.00 2.50 3.00 3.50

Mag/Snow 0.25 MPR MPR MPR MPR Madison Madison Madison Madison Madison
Weight 0.50 MPR MPR MPR Madison Madison Madison Madison Madison Madison

Ratio 0.75 MPR MPR MPR Madison Madison Madison Madison Madison Madison
1.00 MPR MPR MPR Madison Madison Madison Madison Madison Madison
1.25 MPR MPR MPR Madison Madison Madison Madison Madison Madison
1.50 MPR MPR MPR Madison Madison Madison Madison Madison Madison
1.75 MPR MPR MPR Madison Madison Madison Madison Madison Madison
2.00 MPR MPR MPR Madison Madison Madison Madison Madison Pizza
2.25 MPR MPR MPR Madison Madison Madison Madison Pizza Pizza

Formulas
Y3 =CHOOSE(B34,"Madison","MPR", "Pizza")
Y17 =CHOOSE(B34,"Madison","MPR", "Pizza")

Data Tables Y3:AH11 and Y17:AH26
V3 Row Input Cell
V2 Column Input Cell  
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Value of Information 
in Decision Trees  16 
 

16.1 VALUE OF INFORMATION 
Useful concept for 

 Evaluation potential information-gathering activities 

 Comparing importance of multiple uncertainties 

 

16.2 EXPECTED VALUE OF PERFECT INFORMATION 
Several computational methods 

  Flipping tree, moving an event set of branches, appropriate for any decision tree 

  Payoff table, most appropriate only for single-stage tree (one set of uncertain 
outcomes with no subsequent decisions)  

  Expected improvement 

All three methods start by determining Expected Value Under Uncertainty, EVUU, 
which is the expected value of the optimal strategy without any additional information. 
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Figure 16.1 Basic Probability Decision Tree 
High Sales

Introduce Product

Low Sales
Success Prediction
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Introduce Product

Low Sales
Failure Prediction

Don't Introduce

High Sales

Introduce Product

Low Sales
Don't Survey

Don't Introduce
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Figure 16.2 DriveTek EVPI Magnetic Success/Failure 

Use mechanical method
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Electronic success
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0.5 Try electronic method +$150,000
Awarded contract

2 +$90,000 0.5
+$90,000 Electronic failure

+$30,000
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0.7
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16.3 DRIVETEK POST-CONTRACT-AWARD PROBLEM 
DriveTek decided to prepare the proposal, and it turned out that they were awarded the 
contract. The $50,000 cost and $250,000 up-front payment are in the past. The current 
decision is to determine which method to use to satisfy the contract. 

The following decision trees show costs as negative cash flows, so the decision criterion 
is to maximize expected cash flow. An alternative formulation (not shown here) would 
show all costs as positive values and would minimize expected cost.  

Figure 16.3 EVUU 
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Figure 16.4 EVPP Elec 

Use mechanical
-120000

-120000 -120000

1
Electronic success

-50000
0.5 Try electronic 0 -50000

"Electronic success"
2 -50000 -50000 0

0 -50000 Electronic failure
-170000

-120000 -170000

0.7
Magnetic success

-80000
Try magnetic 0 -80000

-80000 -116000 0.3
Magnetic failure

-200000
-83000 -120000 -200000

Use mechanical
-120000

-120000 -120000

0
Electronic success

-50000
0.5 Try electronic 0 -50000

"Electronic failure"
3 -50000 -170000 1

0 -116000 Electronic failure
-170000

-120000 -170000

0.7
Magnetic success

-80000
Try magnetic 0 -80000

-80000 -116000 0.3
Magnetic failure

-200000
-120000 -200000  



190     Chapter 16 Value of Information in Decision Trees 

Figure 16.5 EVPP Mag 
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Figure 16.6 EVPP Both 
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16.4 SENSITIVITY ANALYSIS VS EVPI 
Working Paper Title: Do Sensitivity Analyses Really Capture Problem Sensitivity? An 
Empirical Analysis Based on Information Value  

Authors: James C. Felli, Naval Postgraduate School and Gordon B. Hazen, Northwestern 
University 

Date: March 1998 

The most common methods of sensitivity analysis (SA) in decision-analytic modeling are 
based either on proximity in parameter-space to decision thresholds or on the range of 
payoffs that accompany parameter variation. As an alternative, we propose the use of the 
expected value of perfect information (EVPI) as a sensitivity measure and argue from 
first principles that it is the proper measure of decision sensitivity. EVPI has significant 
advantages over conventional SA, especially in the multiparametric case, where graphical 
SA breaks down. In realistically sized problems, simple one- and two-way SAs may not 
fully capture parameter interactions, raising the disturbing possibility that many 
published decision analyses might be overconfident in their policy recommendations. To 
investigate the extent of this potential problem, we re-examined 25 decision analyses 
drawn from the published literature and calculated EVPI values for parameters on which 
sensitivity analyses had been performed, as well as the entire set of problem parameters. 
While we expected EVPI values to indicate greater problem sensitivity than conventional 
SA due to revealed parameter interaction, we in fact found the opposite: compared to 
EVPI, the one- and two-parameter SAs accompanying these problems dramatically 
overestimated problem sensitivity to input parameters. This phenomenon can be 
explained by invoking the flat maxima principle enunciated by von Winterfeldt and 
Edwards. 

http://www.mccombs.utexas.edu/faculty/jim.dyer/DA_WP/WP980019.pdf 
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17.1 TECHNOMETRICS PROBLEM 

Prior Problem 
Technometrics, Inc., a large producer of electronic components, is having some problems 
with the manufacturing process for a particular component.  Under its current production 
process, 25 percent of the units are defective.  The profit contribution of this component 
is $40 per unit.  Under the contract the company has with its customers, Technometrics 
refunds $60 for each component that the customer finds to be defective;  the customers 
then repair the component to make it usable in their applications.  Before shipping the 
components to customers, Technometrics could spend an additional $30 per component 
to rework any components thought to be defective (regardless of whether the part is really 
defective).  The reworked components can be sold at the regular price and will definitely 
not be defective in the customers' applications.  Unfortunately, Technometrics cannot tell 
ahead of time which components will fail to work in their customers' applications.  The 
following payoff table shows Technometrics' net cash flow per component. 

Figure 17.1 Payoff Table 
 Component  Technometrics' Choice   
 Condition  Ship as is  Rework first 
 Good  +$40  +$10 
 Defective  -$20  +$10 
 

What should Technometrics do? 

How much should Technometrics be willing to pay for a  test that could evaluate the 
condition of the component before making the decision to ship as is or rework first? 
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Imperfect Information 
An engineer at Technometrics has developed a simple test device to evaluate the 
component before shipping.  For each component, the test device registers positive, 
inconclusive, or negative.  The test is not perfect, but it is consistent for a particular 
component;  that is, the test yields the same result for a given component regardless of 
how many times it is tested.  To calibrate the test device, it was run on a batch of known 
good components and on a batch of know defective components.  The results in the table 
below, based on relative frequencies, show the probability of a test device result, 
conditional on the true condition of the component. 

Figure 17.2 Likelihoods 
   Component Condition   
 Test Result  Good  Defective 
 Positive  0.70  0.10 
 Inconclusive  0.20  0.30 
 Negative  0.10  0.60 
 

For example, of the known defective components tested, sixty percent had a negative test 
result. 

An analyst at Technometrics suggested using Bayesian revision of probabilities to 
combine the assessments about the reliability of the test device (shown above) with the 
original assessment of the components' condition (25 percent defectives). 

Technometrics uses expected monetary value for making decisions under uncertainty.  
What is the maximum (per component) the company should be willing to pay for using 
the test device? 
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Figure 17.3 Decision Tree Model 
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Revision of Probability 

Figure 17.4 Display 

1
2
3
4
5
6
7
8
9
10
11
12
13
14
15

U V W X Y
Prior 0.75 0.25  = P(Main)
Likelihood Good Bad
Positive 0.7 0.1  = P(Info | Main)
Inconclusive 0.2 0.3
Negative 0.1 0.6

Joint Good Bad Preposterior
Positive 0.525 0.025 0.550  = P(Info)
Inconclusive 0.150 0.075 0.225
Negative 0.075 0.150 0.225

Posterior Good Bad
Positive 0.9545 0.0455  = P(Main | Info)
Inconclusive 0.6667 0.3333
Negative 0.3333 0.6667  

Figure 17.5 Formulas 

1
2
3
4
5
6
7
8
9
10
11
12
13
14
15

U V W X Y
Prior 0.75 0.25  = P(Main)
Likelihood Good Bad
Positive 0.7 0.1  = P(Info | Main)
Inconclusive 0.2 0.3
Negative 0.1 0.6

Joint Good Bad Preposterior
Positive =V$1*V3 =W$1*W3 =SUM(V8:W8)  = P(Info)
Inconclusive =V$1*V4 =W$1*W4 =SUM(V9:W9)
Negative =V$1*V5 =W$1*W5 =SUM(V10:W10)

Posterior Good Bad
Positive =V8/$X8 =W8/$X8  = P(Main | Info)
Inconclusive =V9/$X9 =W9/$X9
Negative =V10/$X10 =W10/$X10  
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18.1 RISK UTILITY FUNCTION 
A certainty equivalent is a certain payoff value which is equivalent, for the decision 
maker, to a particular payoff distribution. If the decision maker can determine his or her 
certainty equivalent for the payoff distribution of each strategy in a decision problem, 
then the optimal strategy is the one with the highest certainty equivalent. 

The certainty equivalent, i.e., the minimum selling price for a payoff distribution, 
depends on the decision maker's personal attitude toward risk. A decision maker may be 
risk preferring, risk neutral, or risk avoiding. 

If the terminal values are not regarded as extreme relative to the decision maker's total 
assets, if the decision maker will encounter other decision problems with similar payoffs, 
and if the decision maker has the attitude that he or she will "win some and lose some," 
then the decision maker's attitude toward risk may be described as risk neutral. 

If the decision maker is risk neutral, the certainty equivalent of a payoff distribution is 
equal to its expected value. The expected value of a payoff distribution is calculated by 
multiplying each terminal value by its probability and summing the products. 

If the terminal values in a decision situation are extreme or if the situation is "one-of-a-
kind" so that the outcome has major implications for the decision maker, an expected 
value analysis may not be appropriate. Such situations may require explicit consideration 
of risk. 

Unfortunately, it can be difficult to determine one's certainty equivalent for a complex 
payoff distribution. We can aid the decision maker by first determining his or her 
certainty equivalent for a simple payoff distribution and then using that information to 
infer the certainty equivalent for more complex payoff distributions. 

A utility function, U(x), can be used to represent a decision maker's attitude toward risk. 
The values or certainty equivalents, x, are plotted on the horizontal axis; utilities or 
expected utilities, u or U(x), are on the vertical axis. You can use the plot of the function 
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by finding a value on the horizontal axis, scanning up to the plotted curve, and looking 
left to the vertical axis to determine the utility. 

A typical risk utility function might have the general shape shown below if you draw a 
smooth curve approximately through the points.  

Figure 18.1 Typical Risk Utility Function 
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Since more value generally means more utility, the utility function is monotonically non-
decreasing, and its inverse is well-defined. On the plot of the utility function, you locate a 
utility on the vertical axis, scan right to the plotted curve, and look down to read the 
corresponding value. 

The concept of a payoff distribution, risk profile, gamble, or lottery is important for 
discussing utility functions. A payoff distribution is a set of payoffs, e.g., x1, x2, and x3, 
with corresponding probabilities, P(X=x1), P(X=x2), and P(X=x3). For example, a 
payoff distribution may be represented in decision tree form as shown below. 
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Figure 18.2 Figure 2  Payoff Distribution Probability Tree 

P(X=x1)
x1

P(X=x2)
x2

P(X=x3)
x3

 

 

The fundamental property of a utility function is that the utility of the certainty equivalent 
CE of a payoff distribution is equal to the expected utility of the payoffs, i.e,  

 U(CE)   =   P(X=x1)*U(x1) + P(X=x2)*U(x2) + P(X=x3)*U(x3). 

It follows that if you compute the expected utility (EU) of a lottery,  

 EU   =   P(X=x1)*U(x1) + P(X=x2)*U(x2) + P(X=x3)*U(x3),  

the certainty equivalent of the payoff distribution can be determined using the inverse of 
the utility function. That is, you locate the expected utility on the vertical axis, scan right 
to the plotted curve, and look down to read the corresponding certainty equivalent. 

If a utility function has been determined, you can use this fundamental property to 
determine the certainty equivalent of any payoff distribution. Calculations for the 
Magnetic strategy in the DriveTek problem are shown below. First, using a plot of the 
utility function, locate each payoff x on the horizontal axis and determine the 
corresponding utility U(x) on the vertical axis. Second, compute the expected utility EU 
of the lottery by multiplying each utility by its probability and summing the products. 
Third, locate the expected utility on the vertical axis and determine the corresponding 
certainty equivalent CE on the horizontal axis. 

Figure 18.3 Calculations Using Risk Utility Function 
P(X=x) x U(x) P(X=x)*U(x)  

0.50 -$50,000 0.00 0.0000  
0.15 $0 0.45 0.0675  
0.35 $120,000 0.95 0.3325  

   0.4000 EU 
     
   -$8,000 CE 
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18.2 EXPONENTIAL RISK UTILITY 
Instead of using a plot of a utility function, an exponential function may be used to 
represent risk attitude. The general form of the exponential utility function is  

 U(x)   =   A – B*EXP(–x/RT). 

The risk tolerance parameter RT determines the curvature of the utility function reflecting 
the decision maker’s attitude toward risk. Subsequent sections cover three methods for 
determining RT.  

EXP is Excel's standard exponential function, i.e., EXP(z) represents the value e raised to 
the power of z, where e is the base of the natural logarithms. 

The parameters A and B determine scaling. After RT is determined, if you want to plot a 
utility function so that U(High) = 1.0 and U(Low) = 0.0, you can use the following 
formulas to determine the scaling parameters A and B. 

 A   =   EXP (–Low/RT) / [EXP (–Low/RT) – EXP (–High/RT)] 

 B   =   1 / [EXP (–Low/RT) – EXP (–High/RT)] 

The inverse function for finding the certainty equivalent CE corresponding to an expected 
utility EU is 

 CE   =   –RT*LN[(A–EU)/B],  

where LN(y) represents the natural logarithm of y. 

After the parameters A, B, and RT have been determined, the exponential utility function 
and its inverse can be used to determine the certainty equivalent for any lottery. 

Calculations for the Magnetic strategy in the DriveTek problem are shown in Figure 4. 
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Figure 18.4 Exponential Risk Utility Results 

 

Computed values are displayed with four decimal places, but Excel's 15-digit precision is 
used in all calculations. For a decision maker with a risk tolerance parameter of 
$100,000, the payoff distribution for the Magnetic strategy has a certainty equivalent of 
-$7,676. That is, if the decision maker is facing the payoff distribution shown in A9:B12 
in Figure 4, he or she would be willing to pay $7,676 to be relieved of the obligation. 

Formulas are shown in Figure 5. To construct the worksheet, enter the text in column A 
and the monetary values in column B. To define names, select A2:B4, and choose Insert | 
Name | Create. Similarly, select A6:B7, and choose Insert | Name | Create. Then enter the 
formulas in B6:B7. Enter formulas in C10 and D10, and copy down. Finally, enter the 
EU formula in D13 and the CE formula in D15. The defined names are absolute 
references by default. 
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Figure 18.5 Exponential Risk Utility Formulas 

 

Figure 6 shows results for the same payoff distribution using a simplified form of the 
exponential risk utility function with A = 1 and B = 1. This function could be represented 
as U(x) = 1–EXP(–x/RT) with inverse CE = –RT*LN(1–EU). The utility and expected 
utility calculations are different, but the certainty equivalent is the same. 

Figure 18.6 Simplified Exponential Risk Utility Results 
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18.3 APPROXIMATE RISK TOLERANCE 
The value of the risk tolerance parameter RT is approximately equal to the maximum 
value of Y for which the decision maker is willing to accept a payoff distribution with 
equally-likely payoffs of $Y and −$Y/2 instead of accepting $0 for certain. 

Figure 18.7 Approximate Risk Tolerance 
0.5
Heads

+$Y
Play

0.5
Tails

-$Y/2

Don't
$0  

For example, in a personal decision, you may be willing to play the game shown in 
Figure 7 with equally-likely payoffs of $100 and –$50, but you might not play with 
payoffs of $100,000 and –$50,000. As the better payoff increases from $100 to $100,000 
(and the corresponding worse payoff increases from –$50 to –$50,000), you reach a value 
where you are indifferent between playing the game and receiving $0 for certain. At that 
point, the value of the better payoff is an approximation of RT for an exponential risk 
utility function describing your risk attitude. 

In a business decision for a small company, the company may be willing to play the game 
with payoffs of $200,000 and –$100,000 but not with payoffs of $20,000,000 and 
-$10,000,000. Somewhere between a better payoff of $200,000 and $20,000,000, the 
company would be indifferent between playing the game and not playing, thereby 
determining the approximate RT for their business decision. 

18.4 EXACT RISK TOLERANCE USING EXCEL 
A simple payoff distribution, called a risk attitude assessment lottery, may be used to 
determine the decision maker's attitude toward risk. This lottery has equal probability of 
obtaining each of the two payoffs. It is good practice to use a better payoff at least as 
large as the highest payoff in the decision problem and a worse payoff as small as or 
smaller than the lowest payoff. In any case, the payoffs should be far enough apart that 
the decision maker perceives a definite difference in the two outcomes. Three values 
must be specified for the fifty-fifty lottery: the Better payoff, the Worse payoff, and the 
Certainty Equivalent, as shown in Figure 8. 
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Figure 18.8 Risk Attitude Assessment Lottery 
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According to the fundamental property of a risk utility function, the utility of the 
certainty equivalent equals the expected utility of the lottery, so the three values are 
related as follows. 

 U(CertEquiv)   =   0.5*U(BetterPayoff) + 0.5*U(WorsePayoff) 

If you use the general form for an exponential utility function with parameters A, B, and 
RT, and if you simplify terms, it follows that RT must satisfy the following equation. 

Exp(–CertEquiv/RT)   =   0.5*Exp(–BetterPayoff/RT) + 0.5*Exp(–WorsePayoff/RT) 

Given the values for CE, Better, and Worse, you could use trial-and-error to find the 
value of RT that exactly satisfies the equation. In Excel you can use Goal Seek or Solver 
by creating a worksheet like Figure 9. 

Enter the text in column A. Enter the assessment lottery values in B2:B4. Enter a 
tentative RT value in B6. Select A2:B4, and use Insert | Name | Create; repeat for A6:B6 
and A8:B9. Note that the parentheses symbol is not allowed in a defined name, so Excel 
changes U(CE) to U_CE and EU(Lottery) to EU_Lottery.  
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Figure 18.9 Formulas for Risk Tolerance Search 

 

Figure 18.10 Tentative Values for Risk Tolerance Search 

 

Figure 10 shows tentative values for the search. From the Tools menu, choose Goal Seek. 
In the Goal Seek dialog box, enter B11, 0, and B6. If you point to cells, the reference 
appears in the edit box as an absolute reference, as shown in Figure 11. Click OK. 
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Figure 18.11 Goal Seek Dialog Box 

 

The Goal Seek Status dialog box shows that a solution has been found. Click OK. The 
worksheet appears as shown in Figure 12. 

Figure 18.12 Results of Goal Seek Search 

 

The difference between U(CE) and EU(Lottery) is not exactly zero. If you start at 
$250,000, the Goal Seek converges to a difference of –6.2E–05 or 0.000062, which is 
closer to zero, resulting in a RT of $243,041.  

If extra precision is needed, use Solver. With Solver's default settings, the difference is 
2.39E–08 with RT equal to $243,261. If you change the precision from 0.000001 to 
0.00000001 or an even smaller value in Solver's Options, the difference will be even 
closer to zero.  
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18.5 EXACT RISK TOLERANCE USING RISKTOL.XLA 
The Goal Seek and Solver methods for determining the risk tolerance parameter RT yield 
static results. For a dynamic result, use the risktol.xla add-in function. A major advantage 
of risktol.xla is that it facilitates sensitivity analysis. Whenever an input to the function 
changes, the result is recalculated. The function syntax is 

 RISKTOL(WorsePayoff,CertEquiv,BetterPayoff,BetterProb). 

When you open the risktol.xla file, the function is added to the Math & Trig function 
category list. 

The function returns a very precise value of the risk tolerance parameter for an 
exponential utility function. The result is consistent with CertEquiv as the decision 
maker’s certainty equivalent for a two-payoff assessment lottery with payoffs 
WorsePayoff and BetterPayoff, with probability BetterProb of obtaining BetterPayoff and 
probability 1 − BetterProb of obtaining WorsePayoff. 

In case of an error, the RISKTOL function returns: 

  #N/A if there are too few or too many arguments. The first three arguments 
(WorsePayoff, CertEquiv, and BetterPayoff) are required; the fourth argument 
(BetterProb) is optional, with default value 0.5. 

  #VALUE! if WorsePayoff >= CertEquiv, or CertEquiv >= Better Payoff, or 
BetterProb (if specified) <= 0 or >= 1. 

  #NUM! if the search procedure fails to converge. 

In Figure 13, the text in cells A2:A4 has been used as defined names for cells B2:B4, and 
the text in cell A6 is the defined name for cell B6, as shown in the name box. After 
opening the risktol.xla file, enter the function name and arguments, as shown in the 
formula bar. If one of the three inputs change, the result in cell B6 is recalculated. 

Figure 18.13 Exact Risk Tolerance Using RiskTol.xla 
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18.6 EXPONENTIAL UTILITY AND TREEPLAN 
TreePlan's default is to rollback the tree using expected values. If you choose to use 
exponential utilities in TreePlan's Options dialog box, TreePlan will redraw the decision 
tree diagram with formulas for computing the utility and certainty equivalent at each 
node. For the Maximize option, the rollback formulas are U = A–B*EXP(–X/RT) and 
CE = -LN((A-EU)/B)*RT, where X and EU are cell references. For the Minimize option, 
the formulas are U = A-B*EXP(X/RT) and CE = LN((A-EU)/B)*RT. 

TreePlan uses the name RT to represent the risk tolerance parameter of the exponential 
utility function. The names A and B determine scaling. If the names A, B, and RT don't 
exist on the worksheet when you choose to use exponential utility, they are initially 
defined as A=1, B=1, and RT=999999999999. You can redefine the names using the 
Insert | Name | Define or Insert | Name | Create commands.  

To plot the utility curve, enter a list of X values in a column on the left, and enter the 
formula =A−B*EXP(−X/RT) in a column on the right, where X is a reference to the 
corresponding cell on the left. Select the values in both columns, and use the 
ChartWizard to develop an XY (Scatter) chart. 

If RT is specified using approximate risk tolerance values, you can perform sensitivity 
analysis by (1) using the defined name RT for a cell, (2) constructing a data table with a 
list of possible RT values and an appropriate output formula (usually a choice indicator at 
a decision node or a certainty equivalent), and (3) specifying the RT cell as the input cell 
in the Data Table dialog box. 

18.7 EXPONENTIAL UTILITY AND RISKSIM 
After using RiskSim to obtain model output results, select the column containing the 
Sorted Data, copy to the clipboard, select a new sheet, and paste. Alternatively, you can 
use the unsorted values, and you can also do the following calculations on the original 
sheet containing the model results. This example uses only ten iterations; 500 or 1,000 
iterations are more appropriate. 

Use one of the methods described previously to specify values of RT, A, and B. Since the 
model output values shown in Figures 14 and 15 range from approximately $14,000 to 
$176,000, the utility function is defined for a range from worse payoff $0 to better payoff 
$200,000. RT was determined using risktol.xla with a risk-seeking certainty equivalent of 
$110,000. 

To obtain the utility of each model output value in cells A2:A11, select cell B2, and enter 
the formula =A−B*EXP(−A2/RT). Select cell B2, click the fill handle in the lower right 
corner of the cell and drag down to cell B11. Enter the formulas in cells A13:C13 and the 
labels in row 14. 
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Figure 18.14 Risk Utility Formulas for RiskSim 
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A B C
Sorted Data Utility

14229.56 =A-B*EXP(-A2/RT)
32091.92 =A-B*EXP(-A3/RT)
51091.48 =A-B*EXP(-A4/RT)
66383.79 =A-B*EXP(-A5/RT)
69433.32 =A-B*EXP(-A6/RT)
87322.23 =A-B*EXP(-A7/RT)
95920.93 =A-B*EXP(-A8/RT)
135730.71 =A-B*EXP(-A9/RT)
154089.36 =A-B*EXP(-A10/RT)
175708.87 =A-B*EXP(-A11/RT)

=AVERAGE(A2:A11) =AVERAGE(B2:B11) =-LN((A-B13)/B)*RT
Exp. Value Exp.Util. CE  

Figure 18.15 Risk Utility Results for RiskSim 
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A B C
Sorted Data Utility

14,230$     0.05862
32,092$     0.13462
51,091$     0.21851
66,384$     0.28841
69,433$     0.30260
87,322$     0.38767
95,921$     0.42966

135,731$   0.63382
154,089$   0.73363
175,709$   0.85600

88,200$     0.40435  90,757$ 
Exp. Value Exp.Util. CE  
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18.8 RISK SENSITIVITY FOR MACHINE PROBLEM 

Figure 18.16  
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24
25
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27
28
29
30
31
32
33
34
35
36
37
38
39
40

A B C D E F G H I J K L
Process 1 NPV Utility Process 2 NPV Utility RT AJS, Clemen2

$107,733 0.102133 $86,161 0.082554 $1,000,000 pp. 428-430
$39,389 0.038623 $58,417 0.056744

$125,210 0.117689 $171,058 0.157228 Process 1 Process 2
$66,032 0.063899 $263,843 0.231906
$32,504 0.031982 $37,180 0.036498 ExpUtility 0.085527 0.107258

$138,132 0.129016 $254,027 0.224329
$83,000 0.079649 $118,988 0.112181 CertEquiv $89,407 $113,458
$48,178 0.047036 $133,862 0.125289
$20,130 0.019928 $26,597 0.026247 ExpValue $90,526 $116,159
$31,445 0.030956 $187,063 0.170608
$19,739 0.019546 $88,060 0.084294

$4,641 0.00463 $114,837 0.108489
$92,368 0.08823 $130,638 0.122465 Goal Seek

$102,585 0.097498 $138,882 0.12967
$106,411 0.100945 $226,909 0.203006 CE2 - CE1 $24,050
$110,528 0.104639 $156,102 0.144528
$171,524 0.15762 $193,209 0.17569
$87,698 0.083963 $92,004 0.087898

$123,907 0.116538 $163,780 0.151071 NPV values from RiskSim Summary
$69,783 0.067404 $22,176 0.021932 Cell I2 has defined name RT

$144,052 0.134157 $135,190 0.12645 Formulas
$131,461 0.123187 $61,013 0.059189 C2 =1-EXP(-B2/RT)
$34,938 0.034335 $184,907 0.168819 Copy down to C1001
$75,551 0.072768 $70,967 0.068507 G2 =1-EXP(-F2/RT)
$32,144 0.031633 -$10,251 -0.010304 Copy down to G1001
$61,719 0.059853 $89,645 0.085744 J6 =AVERAGE(C2:C1001)

$139,568 0.130266 $119,405 0.112551 K6 =AVERAGE(G2:G1001)
$89,107 0.085252 $96,670 0.092144 J8 =-RT*LN(1-J6)
$94,158 0.089861 $114,124 0.107853 K8 =-RT*LN(1-K6)
$81,459 0.07823 $208,778 0.188425 J10 =AVERAGE(B2:B1001)

$139,258 0.129997 $24,580 0.02428 K10 =AVERAGE(F2:F1001)
$58,190 0.056529 $155,958 0.144405 J16 =K8-J8

-$13,104 -0.01319 $198,519 0.180056
$36,529 0.035869 $167,568 0.154281
$91,239 0.0872 $36,676 0.036011

$147,155 0.13684 $225,777 0.202104
$154,168 0.142872 $195,738 0.177773
$180,770 0.165372 $53,467 0.052063
$112,313 0.106235 $213,920 0.192587  
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Figure 18.17  
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$70,000 $74,363 $80,791
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Formulas
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I2 Column Input Cell
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Concepts 
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Figure 18.18 Utility Function 
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Fundamental Property of Utility Function 
The utility of the CE of a lottery equals the expected utility of the lottery's payoffs. 

U(CE) = EU = p1*U(x1) + p2*U(x2) + p3*U(x3) 

Using a Utility Function To Find the CE of a Lottery 
 1. U(x): Locate each payoff on the horizontal axis and determine the corresponding 

utility on the vertical axis. 

 2. EU: Compute the expected utility of the lottery by multiplying each utility by its 
probability and summing the products. 

 3. CE: Locate the expected utility on the vertical axis and determine the 
corresponding certainty equivalent on the horizontal axis. 

Exponential Utility Function 
General form: U(x) = A − B*EXP(−x/RT) 

Parameters A and B affect scaling. 

Parameter RT (RiskTolerance) depends on risk attitude and affects curvature. 

Inverse: CE = −RT*LN[(A−EU)/B] 

TreePlan's Simple Form of Exponential Utility 
Set A and B equal to 1. 

U(x) = 1 − EXP(−x/RT) 

CE = −RT*LN(1−EU) 

Approximate Assessment of RiskTolerance 
Refer to the Clemen textbook, Figure 13.12, on page 478. 
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Figure 18.19 Assessing ApproximateRisk Tolerance 
Risk tolerance parameter for an exponential utility function is approximately
equal to the maximum amount Y for which the decision maker will play.

0.5
Heads

+$Y +$10 +$100 +$1,000 +$10,000 +$100,000 +$200,000 +$300,000
Play

0.5
Tails

-$Y/2 -$5 -$50 -$500 -$5,000 -$50,000 -$100,000 -$150,000

Don't
$0 $0 $0 $0 $0 $0 $0 $0

more less
risk risk
aversion aversion  

Exact Assessment of RiskTolerance 
The RISKTOL.XLA Excel add-in file adds the following function to the Math & Trig 
function category list: 

   RISKTOL(WorsePayoff,CertEquiv,BetterPayoff,BetterProb) 

The first three arguments are required, and the last argument is optional with default 
value 0.5. WorsePayoff and BetterPayoff are payoffs of an assessment lottery, and 
CertEquiv is the decision maker's certainty equivalent for the lottery.  

RISKTOL returns #N/A if there are too few or too many arguments, #VALUE! if 
WorsePayoff >= CertEquiv, or CertEquiv >= Better Payoff, or BetterProb (if specified) 
<= 0 or >= 1, and #NUM! if the search procedure fails to converge. 

For example, consider a 50-50 lottery with payoffs of $100,000 and $0. A decision maker 
has decided that the certainty equivalent is $43,000. If you open the RISKTOL.XLA file 
and type =RISKTOL(0,43000,100000) in a cell, the result is 176226. Thus, the value of 
the RiskTolerance parameter in an exponential utility function for this decision maker 
should be 176226. 

Using Exponential Utility for TreePlan Rollback Values 
 1. Select a cell, and enter a value for the RiskTolerance parameter. 

 2. With the cell selected, choose Insert Name | Define, and enter RT. 

 3. From TreePlan's Options dialog box, select Use Exponential Utility. The new 
decision tree diagram includes the EXP and LN functions for determining U(x) 
and the inverse.  
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Using Exponential Utility for a Payoff Distribution 
Enter the exponential utility function directly, using the appropriate value for 
RiskTolerance. If the payoff values are equally-likely, use the AVERAGE function to 
determine the expected utility; otherwise, use SUMPRODUCT. Enter the inverse 
function directly to obtain the certainty equivalent. 
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19.1 ALLOCATING ADVERTISING EXPENDITURES 

Figure 19.1 Quick Tour 
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Quick Tour of Microsoft Excel Solver
Month Q1 Q2 Q3 Q4 Total
Seasonality 0.9 1.1 0.8 1.2

Units Sold 3,592 4,390 3,192 4,789 15,962

Sales Revenue $143,662 $175,587 $127,700 $191,549 $638,498
Cost of Sales 89,789 109,742 79,812 119,718 399,061
Gross Margin 53,873 65,845 47,887 71,831 239,437

Salesforce 8,000 8,000 9,000 9,000 34,000
Advertising 10,000 10,000 10,000 10,000 40,000
Corp Overhead 21,549 26,338 19,155 28,732 95,775

Total Costs 39,549 44,338 38,155 47,732 169,775

Prod. Profit $14,324 $21,507 $9,732 $24,099 $69,662
Profit Margin 10% 12% 8% 13% 11%

Product Price $40.00
Product Cost $25.00

The following examples show you how to work with the model above to solve for one value or several
values to maximize or minimize another value, enter and change constraints, and save a problem model.
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Row Contains Explanation
3 Fixed values Seasonality factor:  sales are higher in quarters 2 and 4,

and lower in quarters 1 and 3.

5 =35*B3*(B11+3000)^ 0.5 Forecast for units sold each quarter:  row 3 contains
the seasonality factor; row 11 contains the cost of
advertising.

6 =B5*$B$18 Sales revenue:  forecast for units sold (row 5) t imes
price (cell B18).

7 =B5*$B$19 Cost of sales:  forecast for units sold (row 5) t imes
product cost (cell B19).

8 =B6-B7 Gross margin:  sales revenues (row 6) minus cost of
sales (row 7).

10 Fixed values Sales personnel expenses.

11 Fixed values Advertising budget (about 6.3% of sales).

12 =0.15*B6 Corporate overhead expenses:  sales revenues (row 6)
times 15%.
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13 =SUM(B10:B12) Total costs:  sales personnel expenses (row 10) plus

advertising (row 11) plus overhead (row 12).

15 =B8-B13 Product profit:  gross margin (row 8) minus total costs
(row 13).

16 =B15/ B6 Profit margin:  profit (row 15) divided by sales revenue
(row 6).

18 Fixed values Product price.

19 Fixed values Product cost.

This is a typical marketing model that shows sales rising from a base figure (perhaps due to the sales
personnel) along with increases in advert ising, but with diminishing returns.  For example, the first
$5,000 of advertising in Q1 yields about 1,092 incremental units sold, but the next $5,000 yields only
about 775 units more.

You can use Solver to find out whether the advertising budget is too low, and whether advertising 
should be allocated differently over t ime to take advantage of the changing seasonality factor.

Solving for a Value to Maximize Another Value
One way you can use Solver is to determine the maximum value of a cell by changing another cell.  The
two cells must be related through the formulas on the worksheet.  If they are not, changing the value in
one cell will not change the value in the other cell.

For example, in the sample worksheet, you want to know how much you need to spend on advertising
to generate the maximum profit for the first quarter.  You are interested in maximizing profit by changing
advertising expenditures.

■ On the Tools menu, click Solver.  In the Set target cell box, type b15 or 
select cell B15 (first-quarter profits) on the worksheet.  Select the Max option.
In the By changing cells box, type b11 or select cell B11 (first-quarter advertising)
on the worksheet.  Click Solve.

You will see messages in the status bar as the problem is set up and Solver starts working.  After a
moment, you'll see a message that Solver has found a solut ion.  Solver finds that Q1 advertising of
$17,093 yields the maximum profit $15,093.

■ After you examine the results, select Restore original values and click OK to
discard the results and return cell B11 to its former value.

Resetting the Solver Options

If you want to return the options in the Solver Parameters dialog box to their original settings so that
you can start a new problem, you can click Reset All.
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Solving for a Value by Changing Several Values

You can also use Solver to solve for several values at once to maximize or minimize another value.  For
example, you can solve for the advert ising budget for each quarter that will result in the best profits for
the entire year.  Because the seasonality factor in row 3 enters into the calculation of unit sales in row 5
as a mult iplier, it  seems logical that you should spend more of your advert ising budget in Q4 when the 
sales response is highest, and less in Q3 when the sales response is lowest.  Use Solver to determine
the best quarterly allocation.

■ On the Tools menu, click Solver.  In the Set target cell box, type f15 or select
cell F15 (total profits for the year) on the worksheet.  Make sure the Max option is
selected.  In the By changing cells box, type b11:e11 or select cells B11:E11
(the advertising budget for each of the four quarters) on the worksheet.  Click Solve.

■ After you examine the results, click Restore original values and click OK to
discard the results and return all cells to their former values.

You've just asked Solver to solve a moderately complex nonlinear optimization problem; that is, to find
values for the four unknowns in cells B11 through E11 that will maximize profits.  (This is a nonlinear
problem because of the exponentiation that occurs in the formulas in row 5).  The results of this
unconstrained optimization show that you can increase profits for the year to $79,706 if you spend
$89,706 in advert ising for the full year.

However, most realistic modeling problems have limiting factors that you will want to apply to certain
values.  These constraints may be applied to the target cell, the changing cells, or any other value that
is related to the formulas in these cells.

Adding a Constraint

So far, the budget recovers the advertising cost and generates addit ional profit, but you're reaching a
point of diminishing returns.  Because you can never be sure that your model of sales response to
advertising will be valid next year (especially at greatly increased spending levels), it  doesn't seem
prudent to allow unrestricted spending on advert ising.

Suppose you want to maintain your original advertising budget of $40,000.  Add the constraint to the 
problem that limits the sum of advert ising during the four quarters to $40,000.

■ On the Tools menu, click Solver, and then click Add.  The Add Constraint 
dialog box appears.  In the Cell reference box, type f11 or select cell F11
(advertising total) on the worksheet.  Cell F11 must be less than or equal to $40,000.
The relationship in the Constraint box is <=  (less than or equal to) by default, so 
you don't have to change it .  In the box next to the relationship, type 40000. Click
OK, and then click Solve.

■ After you examine the results, click Restore original values and then click OK
to discard the results and return the cells to their former values.
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The solution found by Solver allocates amounts ranging from $5,117 in Q3 to $15,263 in Q4.  Total 
Profit has increased from $69,662 in the original budget to $71,447, without any increase in the
advertising budget.

Changing a Constraint

When you use Microsoft Excel Solver, you can experiment with slightly different parameters to decide
the best solution to a problem.  For example, you can change a constraint to see whether the results
are better or worse than before.  In the sample worksheet, try changing the constraint on advertising
dollars to $50,000 to see what that does to total profits.

■ On the Tools menu, click Solver.  The constraint, $F$11<=40000, should 
already be selected in the Subject to the constraints box.  Click Change.  In
the Constraint box, change 40000 to 50000.  Click OK, and then click Solve.
Click Keep solver solution and then click OK to keep the results that are 
displayed on the worksheet.

Solver finds an optimal solution that yields a total profit  of $74,817.  That's an improvement of $3,370
over the last figure of $71,447.  In most firms, it 's not too difficult to justify an incremental investment of
$10,000 that yields an additional $3,370 in profit, or a 33.7% return on investment.  This solution also
results in profits of $4,889 less than the unconstrained result, but you spend $39,706 less to get there.

Saving a Problem Model

When you click Save on the File menu, the last select ions you made in the Solver Parameters 
dialog box are attached to the worksheet and retained when you save the workbook.  However, you
can define more than one problem for a worksheet by saving them individually using Save Model in 
the Solver Options dialog box.  Each problem model consists of cells and constraints that you 
entered in the Solver Parameters dialog box.

When you click Save Model, the Save Model dialog box appears with a default selection, based 
on the active cell, as the area for saving the model.  The suggested range includes a cell for each 
constraint plus three additional cells.  Make sure that this cell range is an empty range on the 
worksheet.

■ On the Tools menu, click Solver, and then click Options.  Click Save Model.
In the Select model area box, type h15:h18 or select cells H15:H18 on the
worksheet.  Click OK.

Note  You can also enter a reference to a single cell in the Select model area box.  Solver will use
this reference as the upper-left corner of the range into which it  will copy the problem specifications.

To load these problem specifications later, click Load Model on the Solver Options dialog box,
type h15:h18 in the Model area box or select cells H15:H18 on the sample worksheet, and then
click OK.  Solver displays a message asking if you want to reset the current Solver option sett ings with
the settings for the model you are loading.  Click OK to proceed.  
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Figure 19.2 Quick Tour Influence Chart 
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20.1 DIMINISHING PROFIT MARGIN 

Figure 20.1 Product Mix Problem 
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Example 1:  Product mix problem with diminishing profit margin.
Your company manufactures TVs, stereos and speakers, using a common parts inventory
of power supplies, speaker cones, etc.  Parts are in limited supply and you must determine
the most profitable mix of products to build. But your profit per unit built  decreases with
volume because extra price incentives are needed to load the distribution channel.

TV set Stereo Speaker
Number to Build-> 100 100 100

Part Name Inventory No. Used
Chassis 450 200 1 1 0
Picture Tube 250 100 1 0 0 Diminishing
Speaker Cone 800 500 2 2 1 Returns
Power Supply 450 200 1 1 0 Exponent:
Electronics 600 400 2 1 1 0.9

Profits:
By Product $4,732 $3,155 $2,208

Total $10,095

This model provides data for several products using common parts, each with a different profit margin
per unit.  Parts are limited, so your problem is to determine the number of each product to build from the
inventory on hand in order to maximize profits.
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Problem Specifications

Target Cell D18 Goal is to maximize profit.

Changing cells D9:F9 Units of each product to build.

Constraints C11:C15<=B11:B15 Number of parts used must be less than or 
equal to the number of parts in inventory.

D9:F9>=0 Number to build value must be greater than or
equal to 0.

The formulas for profit  per product in cells D17:F17 include the factor ^ H15 to show that profit per unit
diminishes with volume.  H15 contains 0.9, which makes the problem nonlinear.  If you change H15 to
1.0 to indicate that profit per unit remains constant with volume, and then click Solve again, the
optimal solution will change.  This change also makes the problem linear.  
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21.1 TRANSPORTATION PROBLEM 
 

Figure 21.1 Transportation Problem 
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Example 2:  Transportation Problem.
Minimize the costs of shipping goods from production plants to warehouses near metropolitan demand
centers, while not exceeding the supply available from each plant and meeting the demand from each
metropolitan area.

Number to ship from plant x to warehouse y (at intersection):
Plants: Total San Fran Denver Chicago Dallas New York
S. Carolina 5 1 1 1 1 1
Tennessee 5 1 1 1 1 1
Arizona 5 1 1 1 1 1

--- --- --- --- ---
Totals: 3 3 3 3 3

Demands by Whse --> 180 80 200 160 220
Plants: Supply Shipping costs from plant x to warehouse y (at intersection):
S. Carolina 310 10 8 6 5 4
Tennessee 260 6 5 4 3 6
Arizona 280 3 4 5 5 9

Shipping: $83 $19 $17 $15 $13 $19

The problem presented in this model involves the shipment of goods from three plants to five regional
warehouses.  Goods can be shipped from any plant to any warehouse, but it obviously costs more to
ship goods over long distances than over short distances.  The problem is to determine the amounts
to ship from each plant to each warehouse at minimum shipping cost in order to meet the regional
demand, while not exceeding the plant supplies.

 



224     Chapter 21 Integer-Valued Optimization Models 

27
28
29
30
31
32
33
34
35
36
37
38
39
40
41
42
43
44
45
46

Problem Specifications

Target cell B20 Goal is to minimize total shipping cost.

Changing cells C8:G10 Amount to ship from each plant to each 
warehouse.

Constraints B8:B10<=B16:B18 Total shipped must be less than or equal to 
supply at plant.

C12:G12>=C14:G14 Totals shipped to warehouses must be greater
than or equal to demand at warehouses.

C8:G10>=0 Number to ship must be greater than or equal 
to 0.

You can solve this problem faster by selecting the Assume linear model check box in the Solver 
Options dialog box before clicking Solve.  A problem of this type has an optimum solution at which
amounts to ship are integers, if all of the supply and demand constraints are integers.  

21.2 MODIFIED TRANSPORTATION PROBLEM 

Figure 21.2 Display 
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Modified Example 2:  Transportation Problem.

Minimize the costs of shipping goods from production plants to warehouses near metropolitan demand
centers, while not exceeding the supply available from each plant and meeting the demand from each
metropolitan area.

Number to ship from plant to warehouse
Warehouse Shipped Plant

Plant San Fran Denver Chicago Dallas New York from plant supply
S. Carolina 1 1 1 1 1 5 310
Tennessee 1 1 1 1 1 5 260
Arizona 1 1 1 1 1 5 280
Shipped to warehouse 3 3 3 3 3
Warehouse demand 180 80 200 160 220

Shipping cost from plant to warehouse
Warehouse

Plant San Fran Denver Chicago Dallas New York
S. Carolina $10 $8 $6 $5 $4
Tennessee $6 $5 $4 $3 $6
Arizona $3 $4 $5 $5 $9

Total shipping cost $83  



21.2 Modified Transportation Problem     225 

Figure 21.3 Formulas 

1
2
3
4
5
6
7
8
9

10
11
12
13
14
15
16
17
18
19
20
21
22
23

A B C D E F G H I
Modified Example 2:  Transportation Problem.

Minimize the costs of shipping goods from production plants to warehouses near metropolitan demand
centers, while not exceeding the supply available from each plant and meeting the demand from each
metropolitan area.

Number to ship from plant to warehouse
Warehouse Shipped Plant

Plant San Fran Denver Chicago Dallas New York from plant supply
S. Carolina 1 1 1 1 1 =SUM(C10:G10) 310
Tennessee 1 1 1 1 1 =SUM(C11:G11) 260
Arizona 1 1 1 1 1 =SUM(C12:G12) 280
Shipped to warehouse =SUM(C10:C12) =SUM(D10:D12) =SUM(E10:E12) =SUM(F10:F12) =SUM(G10:G12)
Warehouse demand 180 80 200 160 220

Shipping cost from plant to warehouse
Warehouse

Plant San Fran Denver Chicago Dallas New York
S. Carolina $10 $8 $6 $5 $4
Tennessee $6 $5 $4 $3 $6
Arizona $3 $4 $5 $5 $9

Total shipping cost =SUMPRODUCT(C10:G12,C19:G21)  
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21.3 SCHEDULING PROBLEM 

Figure 21.4 Personnel Scheduling 
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Example 3:  Personnel scheduling for an Amusement Park.
For employees working five consecutive days with two days off, find the schedule that meets demand
from attendance levels while minimizing payroll costs.

Sch.    Days off Employees Sun Mon Tue Wed Thu Fri Sat
  A Sunday, Monday 0 0 0 1 1 1 1 1
  B Monday, Tuesday 8 1 0 0 1 1 1 1
  C Tuesday, Wed. 0 1 1 0 0 1 1 1
  D Wed., Thursday 10 1 1 1 0 0 1 1
  E Thursday, Friday 0 1 1 1 1 0 0 1
  F Friday, Saturday 7 1 1 1 1 1 0 1
  G Saturday, Sunday 0 0 1 1 1 1 1 0

Schedule Totals: 25 25 17 17 15 15 18 25

Total Demand: 22 17 13 14 15 18 24

Pay/Employee/Day: $40
Payroll/Week: $1,000

The goal for this model is to schedule employees so that you have sufficient staff at the lowest cost.  In
this example, all employees are paid at the same rate, so by minimizing the number of employees working
each day, you also minimize costs.  Each employee works five consecutive days, followed by two days
off.

Problem Specifications

Target cell D20 Goal is to minimize payroll cost.

Changing cells D7:D13 Employees on each schedule.

Constraints D7:D13>=0 Number of employees must be greater than or equal
to 0.

D7:D13=Integer Number of employees must be an integer.

F15:L15>=F17:L17 Employees working each day must be greater than or
equal to the demand.

Possible schedules Rows 7-13 1 means employee on that schedule works that day.

In this example, you use an integer constraint so that your solut ions do not result  in fractional numbers of
employees on each schedule.  Select ing the Assume linear model check box in the Solver Options 
dialog box before you click Solve will greatly speed up the solution process.  
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Figure 21.5 Personnel Scheduling with Corrections 
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Example 3:  Personnel scheduling for an Amusement Park. (with corrections)
For employees working five consecutive days with two days off, find the schedule that meets demand
from attendance levels while minimizing payroll costs.

Sch.    Days off Employees Sun Mon Tue Wed Thu Fri Sat
  A Sunday, Monday 0 0 0 1 1 1 1 1
  B Monday, Tuesday 8 1 0 0 1 1 1 1
  C Tuesday, Wed. 0 1 1 0 0 1 1 1
  D Wed., Thursday 10 1 1 1 0 0 1 1
  E Thursday, Friday 0 1 1 1 1 0 0 1
  F Friday, Saturday 7 1 1 1 1 1 0 0
  G Saturday, Sunday 0 0 1 1 1 1 1 0

Schedule Totals: 25 25 17 17 15 15 18 18

Total Demand: 22 17 13 14 15 18 24

Pay/Employee/Day: $40
Payroll/Week: $5,000

The goal for this model is to schedule employees so that you have sufficient staff at the lowest cost.  In
this example, all employees are paid at the same rate, so by minimizing the number of employees working
each day, you also minimize costs.  Each employee works five consecutive days, followed by two days
off.

Problem Specifications

Target cell D20 Goal is to minimize payroll cost.

Changing cells D7:D13 Employees on each schedule.

Constraints D7:D13>=0 Number of employees must be greater than or equal
to 0.

D7:D13=Integer Number of employees must be an integer.

F15:L15>=F17:L17 Employees working each day must be greater than or
equal to the demand.

Possible schedules Rows 7-13 1 means employee on that schedule works that day.

In this example, you use an integer constraint so that your solutions do not result in fractional numbers of
employees on each schedule.  Selecting the Assume linear model check box in the Solver Options 
dialog box before you click Solve will greatly speed up the solution process.  
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22.1 WORKING CAPITAL MANAGEMENT PROBLEM 

Figure 22.1 Working Capital Management 
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Example 4:  Working Capital Management.
Determine how to invest excess cash in 1-month, 3-month and 6-month CDs so as to
maximize interest income while meeting company cash requirements (plus safety margin).

Yield Term Purchase CDs in months:
1-mo CDs: 1.0% 1 1, 2, 3, 4, 5 and 6 Interest
3-mo CDs: 4.0% 3 1 and 4  Earned:
6-mo CDs: 9.0% 6 1 Total $7,700

Month: Month 1 Month 2 Month 3 Month 4 Month 5 Month 6 End
Init Cash: $400,000 $205,000 $216,000 $237,000 $158,400 $109,400 $125,400
Matur CDs: 100,000 100,000 110,000 100,000 100,000 120,000
Interest: 1,000 1,000 1,400 1,000 1,000 2,300
1-mo CDs: 100,000 100,000 100,000 100,000 100,000 100,000
3-mo CDs: 10,000 10,000
6-mo CDs: 10,000
Cash Uses: 75,000 (10,000) (20,000) 80,000 50,000 (15,000) 60,000
End Cash: $205,000 $216,000 $237,000 $158,400 $109,400 $125,400 $187,700

-290000

If you're a financial officer or a manager, one of your tasks is to manage cash and short-term investments in a
way that maximizes interest income, while keeping funds available to meet expenditures.  You must trade off
the higher interest rates available from longer-term investments against the flexibility provided by keeping funds
in short-term investments.

This model calculates ending cash based on init ial cash (from the previous month), inflows from maturing
certificates of deposit (CDs), outflows for new CDs, and cash needed for company operations for each month.

You have a total of nine decisions to make:  the amounts to invest in one-month CDs in months 1 through 6;
the amounts to invest in three-month CDs in months 1 and 4; and the amount to invest in six-month CDs in
month 1.
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Problem Specifications

Target cell H8 Goal is to maximize interest earned.

Changing cells B14:G14 Dollars invested in each type of CD.
B15, E15, B16

Constraints B14:G14>=0 Investment in each type of CD must be greater than
B15:B16>=0 or equal to 0.
E15>=0

B18:H18>=100000 Ending cash must be greater than or equal to
$100,000.

The optimal solution determined by Solver earns a total interest income of $16,531 by investing as much as
possible in six-month and three-month CDs, and then turns to one-month CDs.  This solution satisfies all of the
constraints.

Suppose, however, that you want to guarantee that you have enough cash in month 5 for an equipment
payment.  Add a constraint that the average maturity of the investments held in month 1 should not be more
than four months.

The formula in cell B20 computes a total of the amounts invested in month 1 (B14, B15, and B16), weighted
by the maturit ies (1, 3, and 6 months), and then it  subtracts from this amount the total investment, weighted by
4.  If this quantity is zero or less, the average maturity will not exceed four months.  To add this constraint,
restore the original values and then click Solver on the Tools menu.  Click Add.  Type b20 in the Cell 
Reference box, type 0 in the Constraint box, and then click OK.  To solve the problem, click Solve.

To satisfy the four-month maturity constraint, Solver shifts funds from six-month CDs to three-month CDs.  The
shifted funds now mature in month 4 and, according to the present plan, are reinvested in new three-month 
CDs.  If you need the funds, however, you can keep the cash instead of reinvesting.  The $56,896 turning
over in month 4 is more than sufficient for the equipment payment in month 5.  You've traded about $460 in
interest income to gain this flexibility.  
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22.2 WORK CAP ALTERNATE FORMULATIONS 

Figure 22.2 Working Capital Management Horizontal Time 
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Figure 22.3 Working Capital Management Vertical Time 
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22.3 STOCK PORTFOLIO PROBLEM 

Figure 22.4 Efficient Stock Portfolio 
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Example 5:  Efficient stock portfolio.
Find the weightings of stocks in an efficient portfolio that maximizes the portfolio rate of
return for a given level of risk.  This worksheet uses the Sharpe single-index model; you
can also use the Markowitz method if you have covariance terms available.

Risk-free rate 6.0% Market variance 3.0%
Market rate 15.0% Maximum weight 100.0%

Beta ResVar Weight *Beta *Var.
Stock A 0.80 0.04 20.0% 0.160 0.002
Stock B 1.00 0.20 20.0% 0.200 0.008
Stock C 1.80 0.12 20.0% 0.360 0.005
Stock D 2.20 0.40 20.0% 0.440 0.016
T-bills 0.00 0.00 20.0% 0.000 0.000

Total 100.0% 1.160 0.030
Return Variance

Portfolio Totals:  16.4% 7.1%

Maximize Return: A21:A29 Minimize Risk: D21:D29
0.1644 0.07077

5 5
TRUE TRUE
TRUE TRUE
TRUE TRUE
TRUE TRUE
TRUE TRUE
TRUE TRUE
TRUE TRUE

One of the basic principles of investment management is diversification.  By holding a portfolio of several
stocks, for example, you can earn a rate of return that represents the average of the returns from the
individual stocks, while reducing your risk that any one stock will perform poorly.

Using this model, you can use Solver to find the allocation of funds to stocks that minimizes the portfolio
risk for a given rate of return, or that maximizes the rate of return for a given level of risk.

This worksheet contains figures for beta (market-related risk) and residual variance for four stocks.  In
addition, your portfolio includes investments in Treasury bills (T-bills), assumed to have a risk-free rate of
return and a variance of zero.  Init ially equal amounts (20 percent of the portfolio) are invested in each
security.

Use Solver to try different allocations of funds to stocks and T-bills to either maximize the portfolio rate of
return for a specified level of risk or minimize the risk for a given rate of return.  With the init ial allocation
of 20 percent across the board, the portfolio return is 16.4 percent and the variance is 7.1 percent.
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Problem Specifications

Target cell E18 Goal is to maximize portfolio return.

Changing cells E10:E14 Weight of each stock.

Constraints E10:E14>=0 Weights must be greater than or equal to 0.

E16=1 Weights must equal 1.

G18<=0.071 Variance must be less than or equal to 0.071.

Beta for each stock B10:B13

Variance for each stock C10:C13

Cells D21:D29 contain the problem specifications to minimize risk for a required rate of return of 16.4
percent.  To load these problem specifications into Solver, click Solver on the Tools menu, click 
Options, click Load Model, select cells D21:D29 on the worksheet, and then click OK until the
Solver Parameters dialog box is displayed.  Click Solve.  As you can see, Solver finds portfolio
allocations in both cases that surpass the rule of 20 percent across the board.

You can earn a higher rate of return (17.1 percent) for the same risk, or you can reduce your risk without
giving up any return.  These two allocations both represent efficient portfolios.

Cells A21:A29 contain the original problem model.  To reload this problem, click Solver on the Tools 
menu, click Options, click Load Model, select cells A21:A29 on the worksheet, and then click OK.  

Solver displays a message asking if you want to reset the current Solver option settings with the settings
for the model you are loading.  Click OK to proceed.  
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22.4 MONEYCO PROBLEM 

Figure 22.5 Display 
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Return on investments

CD rate = 0.06
A B C D E CD1 CD2 CD3

Time 1 -1.00 -1.00 -1.00 -1.00
Time 2 1.15 -1.00 1.06 -1.00
Time 3 1.28 -1.00 1.06 -1.00
Time 4 1.40 1.15 1.32 1.06

Max to invest $500 $500 $500 $500 $500 $1,000,000 $1,000,000 $1,000,000

Amount Invested $100 $100 $100 $100 $100 $100 $100 $100 Feasible

Cash flows from investments Cash in Cash out
Time 1 -$100 -$100 -$100 $0 $0 -$100 $0 $0 $1,000 $600
Time 2 $0 $115 $0 $0 -$100 $106 -$100 $0 $0 $21
Time 3 $0 $0 $128 -$100 $0 $0 $106 -$100 $0 $34
Time 4 $140 $0 $0 $115 $132 $0 $0 $106 $493 Final balance

Legend

data cells input assumptions, uncontrollable, constraints Defined Names
Amount_Invested = $B$11:$I$11

changing cells decision variables, controllable Cash_out = $K$14:$K$17
Final_balance = $K$17

computed cells intermediate and output variables, target Max_to_invest = $B$9:$I$9

 

Figure 22.6 Formulas 
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Return on investments

CD rate = 0.06
A B C D E CD1 CD2 CD3

Time 1 -1.00 -1.00 -1.00 -1.00
Time 2 1.15 -1.00 =1+$B$2 -1.00
Time 3 1.28 -1.00 =1+$B$2 -1.00
Time 4 1.40 1.15 1.32 =1+$B$2

Max to invest $500 $500 $500 $500 $500 $1,000,000 $1,000,000 $1,000,000

Amount Invested $100 $100 $100 $100 $100 $100 $100 $100 =IF(AND(Amount_Invested<

Cash flows from investments Cash in Cash out
Time 1 =B4*B$11 =C4*C$11 =D4*D$11 =E4*E$11 =F4*F$11 =G4*G$11 =H4*H$11 =I4*I$11 $1,000 =SUM(B14:J14)
Time 2 =B5*B$11 =C5*C$11 =D5*D$11 =E5*E$11 =F5*F$11 =G5*G$11 =H5*H$11 =I5*I$11 $0 =SUM(B15:J15)
Time 3 =B6*B$11 =C6*C$11 =D6*D$11 =E6*E$11 =F6*F$11 =G6*G$11 =H6*H$11 =I6*I$11 $0 =SUM(B16:J16)
Time 4 =B7*B$11 =C7*C$11 =D7*D$11 =E7*E$11 =F7*F$11 =G7*G$11 =H7*H$11 =I7*I$11 =SUM(B17:J17) Final balanc

Array-entered (Control+Shift+Enter) formula in K11: =IF(AND(Amount_Invested<=Max_to_invest,Cash_out>=0),"Feasible","Not Feasible")
Enter =B4*B$11 in cell B14 and copy to cells B14:I17
Enter =SUM(B14:J14) in cell K14 and copy to K14:K17  
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Figure 22.7 Solver Dialog Box 
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